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Předmluva

Vážení čtenáři,
držíte v rukou knihu, která je první svého druhu o 3ds Max a jejíž kořeny leží v České republice. 
Její napsání byl pro mne nezvykle motivující, ale také náročný a zodpovědný úkol. Setkávám 
se s řadou začínajících grafiků, kteří mají zájem a obrovskou chuť ponořit se do okouzlují-
cích 3D světů, ba co více – vytvořit si svůj vlastní. Je to nádherná představa. Realizovat své 
vize, fantazie, virtuální světy, prostě vše, na co si vzpomenete. Vytvořit pár sekund animace 
a pochlubit se nejprve svým přátelům anebo se také zúčastnit některé soutěže v animovaném 
filmu. To vám současná vyspělá úroveň 3D aplikací umožní. Nároky na pochopení a aktivní 
ovládání takového vyspělého 3D nástroje jsou vysoké a bohužel mnozí ze začínajících grafiků 
také rychle skončí. Chybí jim vytrvalost, opravdová chuť něčeho dosáhnout, a také je odradila 
spousta chvil strávených nad nevyřešeným problémem, nad tím, jak dosáhnout požadovaného 
výsledku. To je realita. Na takové vyspělé úrovni, abyste vytvořili krásný 3D svět plný doko-
nalého pohybu lidí a zvířat, fascinujícího světla a ohromující atmosféry v několika okamžicích 
díky automatizovaným funkcím, software prostě ještě není.
Vracím se k zodpovědnosti zmíněné v úvodní větě. Tou myslím závazek, aby se po přečtení této 
knihy většina z vás pro 3D tvorbu skutečně nadchla a nevzdala ten neustálý boj. Snad vás uklid-
ním, když vám řeknu, že i profesionální světoví grafici pracující na celovečerních animovaných 
filmech nebo hraných filmech s vizuálními efekty se pořád učí něčemu novému. Stále odhalují 
nové možnosti, cesty a směry, kterými lze výsledku v té či oné aplikaci dosáhnout. Tvůrci sou-
časných 3D aplikací nám předávají softwarové nástroje a ingredience, pomocí nichž si můžeme 
umíchat nejrůznější druhy 3D koktejlů. Krása takové tvorby spočívá v tom, že existuje velmi 
mnoho způsobů dosažení cíle. 
3D grafika vás také naučí vnímat reálný svět mnohem citlivěji. Vnímáte běžně typy stínů, jejich 
velikost a „měkkost“, když je oblačno nebo jasno a jdete v poklidu po chodníku? Sledujete 
pohyby lidí, zvířat kolem vás nebo kapek deště? Toto všechno budete muset kvůli dosažení 
reálné úrovně animace a renderování vnímat. Naučit se základní fyzikální principy a reálné 
chování a fungování předmětů kolem vás. Pokud se budete chtít věnovat animaci postav, 
naučte se základy anatomie. Pro architektonické vizualizace musíte znát perspektivu a základy 
stavebního inženýrství. Když se budete věnovat produktovému designu, je potřeba vnímat 
moderní trendy v návrhářství. Takových srovnání bychom našli samozřejmě mnoho. Důležité 
je ale mít na paměti jedno: Skutečnými profesionály se stanete ve chvíli, kdy budete vnímat 
dění kolem sebe, kdy si začnete všímat běžných věcí a začleníte je do své práce. Pevně věřím, 
že tato publikace vám ukáže směr, probudí ve vás skutečnou touhu po poznání 3D tvorby a že 
se vaše předsevzetí nevytratí.
Co tedy v knize najdete? Knihu můžete brát nejen jako detailní referenční příručku pokrýva-
jící všechny nezbytné funkce aplikace pro rutinní práci v 3ds Max. Názvy kapitol jsou orien-
továny na problémové situace, takže v nich můžete velmi rychle najít svá řešení. Požadavky 
na čtenářovy znalosti jsou minimální. Ovládání operačního systému Windows, běžná práce 
s PC a adresářovou a souborovou strukturou (obrázky a video jako vstupy do scény). Kniha je 
rozdělena na šestnáct kapitol rozdělených podle tematického zaměření. Na tomto místě musím 
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poděkovat své ženě, bez jejíž tolerance a poskytnutého časového prostoru by kniha nevznikla. 
Současně bych rád poděkoval kolegovi Janu Melicharovi za čtrnáctou kapitolou o kompozici a 
patnáctou kapitolu o skriptování v jazyce MAXScript, pomocí něhož můžete rozšířit schopnos-
ti 3ds Max dle svého přání. Také děkuji společnosti Sitewell za poskytnutí cenného přístupu k 
dalším Autodesk technologiím.
Budu rád za vaše podněty a připomínky, kterými se pokusím vylepšovat a rozšiřovat témata 
o 3D grafice určená pro vás, tvůrce 3D světů. Své nápady zasílejte na můj email jan.kriz@
mayamax3d.net. 

Autor, v Praze 20. srpna

Požadavky na software
Autodesk 3ds Max 2010 poběží na následujících operačních systémech (32bitových i 64bito-
vých):

Microsoft Windows XP Professional (Service Pack 2 a vyšší)
Microsoft Windows Vista (Business, Premium a Ultimate)
Microsoft Windows XP Professional x64
Microsoft Windows Vista 64 bit (Business, Premium a Ultimate)

Dále pro správnou funkčnost grafiky je třeba ovladač:
DirectX 9.0c (požadováno), OpenGL (volitelné).

Některé funkce 3ds Max 2010 jsou dostupné, pouze pokud vaše grafická karta podporuje 
Shader model 3.0 (Pixel Shader a Vertex Shader). Ujistěte se, že to vaše karta umožňuje, abyste 
se nepřipravili o specifické funkce u materiálů. 

Požadavky na hardware
3ds Max 2010 ve 32bitové verzi vyžaduje:

Intel Pentium 4 nebo vyšší řadu, AMD Athlon 64 nebo vyšší řadu, případně AMD 
Opteron
1 GB RAM paměti (doporučeno 2 GB)
1 GB swapovacího prostoru na disku (doporučeno 2 GB)
Direct3D 10, Direct3D 9 nebo OpenGL kompatibilní grafická karta se 128 MB paměti
Třítlačítková myš
2 GB místa na pevném disku

3ds Max 2010 ve 64bitové verzi vyžaduje:
Procesor Intel EM64T, AMD Athlon 64 nebo vyšší, popřípadě AMD Opteron 
1 GB RAM (doporučeno 4 GB)
1 GB swapovacího prostoru na disku (doporučeno 2 GB)
Direct3D 10, Direct3D 9 nebo OpenGL kompatibilní grafická karta se 128 MB 
Třítlačítková myš
2 GB místa na pevném disku
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Tyto požadavky jsou skutečně minimální. Pro 3ds Max 2010 platí jako pro málokterý software, 
že čím rychlejší procesor a větší RAM paměť, tím lépe. Jako minimum bych i vzhledem k níz-
kým cenám hardwaru doporučil 3 GB RAM paměti pro 32bitový systém a 4 GB pro 64bitovou 
verzi. 

Cvičné soubory
K obrázkům jsem ve většině případů přiložil na DVD cvičné scény, na kterých si budete moci 
vyzkoušet popisovaný postup. Většinou jde o připravený výsledek, který vidíte na obrázku. 
Základní úlohy můžete volně kombinovat a vytvářet tak komplexnější scény a výtvory. Cílem 
není zahltit vás obrovskou scénou, ve které byste se na začátku „utopili“, ale připravit vás na to, 
abyste si takovou scénu mohli vytvořit sami. Cvičné soubory jsou pojmenované podle názvu 
obrázků. Například obrázek 8.122 má na disku ve složce Kapitola08_Modelovani\Max souvi-
sející zdrojový soubor 8.122 Metaballs.max.

Softwarové aktualizace
Podívejte se také na stránky společnosti Autodesk, kde najdete poslední záplaty a servisní 
balíčky k 3ds Max 2010. Ze stránky http://www.autodesk.com/products se navigujte dále na 
Autodesk 3ds Max → Support → Data & Downloads → Updates & Service Packs a tady si 
vyberte příslušnou verzi. Aktualizujte si svou verzi posledními opravnými balíčky.

PŘEDMLUVA
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Úvod do 3D 

grafiky v 3ds Max 

Obor 3D grafiky 
a Autodesk 3ds Max
3D grafika zažívá v současnosti skutečný zlom. Ztvárnění 
virtuálních světů se stává čím dál tím více reálné a smazávají 
se hranice mezi virtualitou a realitou. S příchodem každé nové 
verze grafických aplikací máme možnost vstřebávat široké 
spektrum nových funkcí, které usnadňují a urychlují tvorbu 
vašich 3D představ v každodenní produkci. Trend je zřejmý. 
Rychlejší a snazší tvorba 3D světů.
Tento celosvětový trend má ale i svá „negativa“, pokud si 
dovolím to takto nazvat. Čím dál tím více specializovanějších 
dílčích aplikací řeší podmnožinu úloh, s nimiž si „velké“ 3D 
aplikace jako je 3ds Max, Maya nebo SoftImage, dokážou 
poradit jen stěží či neohrabaně. Mám na mysli například 
tvorbu textur a povrchových struktur, míchání 3D animace 
se 2D video elementy, speciální vizuální efekty, simulaci teku-
tin, detailní digitální sochařství 3D modelů nebo animace 
postav. Všechny tyto oblasti pokrývá široké spektrum aplikací 
dostupných na trhu s grafickým softwarem. To samozřejmě 
klade nároky na vaše znalosti, je třeba pokrýt mnohem širší 
záběr funkcionality, než tomu bylo v minulosti. 
Tato publikace se zaměřuje na aplikaci 3ds Max od společnos-
ti Autodesk v její poslední verzi 2010. V době začátku psaní je 
na trhu verze 2009, ale všechny nové funkce verze 2010 jsou 
zde též detailně rozebrány. Tento animační software pokrývá 
celý produkční tok od modelování objektů, aplikování textur 
a vizuálních struktur na povrchy modelů, přípravu osvětlení 
a simulaci reálného denního světla, přes animaci, tedy rozpo-
hybování nejen modelů i postav, změny jejich vzhledu v čase 
až po renderování, tedy vytvoření digitálního výstupu, napří-
klad sekvenčních obrazových souborů, které si poskládáte 
do jednoho MOV nebo AVI souboru. Autodesk 3ds Max je 
zřejmě nejpoužívanější 3D nástroj na světě, který se používá 

Témata kapitoly:

Obor 3D grafika a Autodesk 

3ds Max

Základní pojmy, pracovní 

postup a 3D prostor
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30 KAPITOLA 1   �   ÚVOD DO 3D GRAFIKY V 3DS MAX

v herních studiích, architektonických kancelářích, filmových studiích a samozřejmě četnou 
základnou samostatných tvůrců. 
Možná jste zaznamenali uvedení aplikace 3ds Max 2010 Design. Jedná o téměř totožnou 
aplikaci s 3ds Max 2010, avšak zaměřenou spíše na trh vizualizací, u nichž se dbá zejména na 
reálné osvětlení podle normy LEEDS. Balík 3ds Max 2010 navíc oproti verzi „Design“ obsahuje 
SDK – Software Development Kit, sadu nástrojů určenou pro vývoj dalších doplňků pro 3ds 
Max, což nachází své uplatnění zejména pro zábavní a herní průmysl. To jsou základní, pro 
většinu uživatelů zanedbatelné rozdíly. Významným přínosem obou variant je ale dostupnost 
64bitových verzí. V čem spočívá přínos ve srovnání s 32bitovou instalační sadou? Především 
možnost práce s velkými datovými soubory, tedy velkým objemem 3D modelů v jedné scéně. 
Zadruhé je to mnohem rychlejší interaktivita v manipulaci s detailními objekty. Můžete tak 
svižně modelovat pomocí kreslení štětců po povrchu vysokopolygonálních modelů.
Pro Maxe je na trhu mnoho zajímavých zásuvných modulů, které rozšiřují jeho schopnosti 
a funkcionalitu. Pokud Max nenabízí takovéto integrované vlastnosti (např. simulaci tekutin), 
porozhlédněte se po tzv. plug-inech, které jsou pro Maxe dostupné v hojné míře – komerčně 
i zdarma. Druhá možnost rozšíření je hledat či vytvořit si tzv. skripty. Ty představují kusy pro-
gramového kódu, které když spustíte, tak se vám spustí uvnitř 3ds Max požadovaná miniapli-
kace. Ty mohou být různě specializované od tvorby objektů s možností jejich parametrizace až 
po nástroje usnadňující animaci. Samozřejmě jsou ke stažení knihovny 3D modelů, takže stačí 
věnovat pár set korun na koupi takové knihovny, anemusíte si modely pracně vytvářet. Tlak na 
produkci v krátkém čase je vysoký, proto tyto možnosti určitě využívejte. 
Externí aplikace, s nimiž by se měl samostatný 3D grafik seznámit, jsou například Adobe 
Photoshop, Autodesk Mudbox, Adobe Premiere, Autodesk Combustion nebo Adobe After 
Effects a Motion Builder. Jak je vidno, je jich více a záběr pokryté problematiky je široký. 
Aplikaci Adobe Photoshop zná zřejmě nejvíce uživatelů v oblasti 2D grafiky. Známá aplikace 
pro tvorbu a zpracování obrázků, přípravy textur a bitmap pro jejich začlenění v 3ds Max. 
Pokud se chcete stát digitálním sochařem, bude se vám líbit aplikace Autodesk Mudbox, v níž 
můžete díky vestavěným štětcům malovat po povrchu modelu a dávat mu detailní 3D podobu. 
I když Max nabízí hodně nástrojů pro 3D modelování, na Mudbox si rychle zvyknete a naučíte 
se v něm pracovat a přenášet modely mezi 3ds Max a Mudbox. Je určený pro modelování těch 
nejjemnějších detailů na modelech s vysokým počtem polygonů (vrásky, svaly a podobně).
S Adobe Premiere budete schopni stříhat animované klipy, míchat je, prolínat, provádět korekci 
barev nebo synchronizovat se zvukem. Combustion také pracuje přímo s animacemi. Je ekviva-
lentem pro činnost nazvanou kompozice a postprodukce. Jakmile dokončíte animaci, můžete 
ji zkombinovat s dalšími vizuálními prvky a efekty (dokonce s 3D objekty, které můžete rafi-
novaně skrývat za objekty v animaci). After Effects, jak název napovídá, dodává do již hotové 
animace různorodé efekty. Mohou jimi být napodobení třesu kamery, vlnění a distorze obrazu 
(pára, horký vlnící se vzduch, rozmlžení obrazu a podobně), přidání světel a kamer nebo 
můžete po snímcích animace malovat. Poslední ze jmenovaných aplikací – Motion Builder 
– nabízí výkonné nástroje pro animaci postav.
Pokud to myslíte s 3D tvorbou vážně a rádi byste vytvořili kratší animaci, měli byste si s těmito 
aplikacemi „umět povídat“. 
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Základní pojmy, pracovní postup 
a 3D prostor
Než se začneme věnovat vlastnímu studiu v Maxovi, podívejme se ještě na to, jak budete při své 
práci postupovat. Po spuštění Maxe uvidíte čtyři pracovní výřezy (pohledy), v nichž budete své 
modely vytvářet. Všechny modely, i ty nejsložitější, na které si jen vzpomenete (včetně postav 
a dalších organických objektů), vytváříte ze základních, primitivních parametrických objektů, 
jakými jsou krabice (Box), koule, válec a podobně. Dílčími úpravami a posunováním či otáče-
ním vrcholů a hran geometrického primitiva dosáhnete přibližného hrubého vzhledu finálního 
modelu. Pomocí aplikování dalších funkcí můžete získat zaoblené hrany, tedy hladký zaoblený 
model, který odpovídá finálnímu vzhledu.
Co s takovým modelem? Můžete (ale nemusíte) ho přenést do aplikace Autodesk Mudbox, 
kde modelu dodáte velmi jemné detaily kreslením různě strukturovanými štětci po jeho povr-
chu. Takových detailů byste v Maxovi dosáhli jen velmi pracně. Zpět s modelem v Maxovi na 
něj vyzkoušíte osvětlení. Nastavíte mu parametry, které odpovídají reálnému osvětlení, takže 
dosáhnete věrného řešení světla prostřednictvím přímého i nepřímého světla. V této fázi 
necháte světlo „malovat“ po povrchu modelu, čímž získá skutečnou prostorovou hloubku. 3D 
model získá své osobité místo ve 3D prostoru.
Jste zvědaví, co bude dál?
Čeká vás umělecká část tvorby textur. 3ds Max nabízí procedurální mapy, které můžete přesně 
definovat a nastavovat jim parametry a poté je aplikovat na model. Můžete také na povrch čer-
stvě zrozeného modelu aplikovat vámi vytvořenou fotografii, naskenovaný obrázek a podobně. 
Přidáte tomuto materiálu lesk, hrubost a další charakteristiky, které jsou typické pro vybranou 
materiálovou strukturu. U složitějších modelů aplikujete materiály po jednodušeji zvládnu-
telných segmentech. Nyní model stojí, světlo svítí, povrch je pokrytý vybranou strukturou. 
Můžete se pustit do 3D animace.
Ať už se jedná o postavu nebo jednoduchý objekt, principy animace zůstávají stejné už od svých 
prvopočátků. Změnit polohu, otočení nebo velikost objektu v čase. Čas v animaci je udávaný ve 
snímcích. Například evropská norma PAL představuje 25 snímků za sekundu. Jedna sekunda 
animace tedy trvá 25 pohybových snímků, z nichž každý se liší o hodnoty zmíněné polohy, 
otočení nebo změny velikosti animovaného objektu. Stačí vám vytvořit jen několik klíčových 
snímků, 3ds Max se postará o všechny mezisnímky.
To je hlavní benefit 3ds Max, pomocníka v animaci. Nemusíte se starat o každý snímek, Max 
zajistí přechod mezi snímky tzv. interpolací. Jakmile dokončíte animaci, přichází fáze rendero-
vání – 3ds Max v této části snímá obraz a vytváří výsledné obrázky. Tuto fázi si skutečně oblíbí-
te. Vy budete odpočívat a Max pracovat s plným využitím všech procesorů. Snímek po snímku 
se bude generovat obraz se všemi definovanými atributy – světlem, materiály i animací.
Nejnáročnější na renderování jsou výpočty odrazů světla, průchody světelných paprsků sklem, 
lomy světla ve skleněných nádobách s tekutinami a podobně. Vyrenderování jednoho snímku 
může trvat celé hodiny či dny i na nejvýkonnějších počítačích. Vynásobte si tuto dobu číslem 
25 a dostanete dobu trvání vyrenderování jedné sekundy animace. Celou tuto dobu nemusíte 
u počítače vůbec být. 3ds Max pracuje za vás. Po dokončení této časově nejnáročnější fáze 
můžete vygenerované snímky upravit v některém kompozičním nebo postprodukčním progra-
mu, přidat hudební stopu a nechat si sestavit výsledné video.

ZÁKLADNÍ POJMY, PRACOVNÍ POSTUP A 3D PROSTOR
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Klasická práce ve 3D prostoru spočívá v tzv. transformacích. Jedná se o posun, otočení a změnu 
měřítka (anglicky Move, Rotate, Scale). Tyto příkazy budete používat v každodenní produkci 
nejspíše nejvíc ze všech příkazů. Orientace ve 3D prostoru spočívá v transformacích v osách X, 
Y a Z. Osy X a Y definují spodní rovinu, na kterých jakoby objekty stojí. Představte si je jako 
zemi. Osa Z pak určuje výšku objektů, směřuje tedy vertikálně. Všechny tři osy pak dohroma-
dy v 3ds Max tvoří světový souřadnicový systém. Průniky těchto os tvoří počátek 3D prostoru 
a označujeme ho uspořádanou trojicí hodnot (x,y,z) = (0,0,0). Tato filozofie vychází z Kartezi-
ánského souřadnicového systému. Více se dozvíte v kapitole o navigaci ve 3D prostoru. Teď už 
nám nezbývá nic jiného, než se pustit do práce. V následující kapitole se podíváme na detailní 
přehled prvků uživatelského rozhraní. Spusťte Maxe!

Obrázek 1.1. 3ds Max se načítá – otevírá se svět filmových možností
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Uživatelské 

rozhraní, základní 

příkazy 

Rozdělení pracovního 
prostředí 3ds Max
Mnoho začínajících uživatelů odradí komplexní uživatelské 
rozhraní, spousta funkcí, tlačítek, která navíc po stisknutí, 
nic nedělají. Nemusíte se obávat. Jakmile pochopíte základní 
principy, jak postupovat, bude se vám práce s Maxem zdát 
stejně intuitivní a samozřejmá jako chůze. Jdete a nepřemýš-
líte o tom. 

Když spustíte 3ds Max, standardně se zobrazí uživatelské roz-
hraní rozdělené na dvě funkční oblasti:

Pracovní část složená ze čtyř výřezů, kde vytváříte 3D 
modely a všechny objekty virtuálního světa.
Nabídková a příkazová část (převážně na okrajích), 
která se nachází kolem pracovních výřezů ve formě 
hlavní nabídky nebo dalších příkazů na pravé straně 
a v dolní části uživatelského rozhraní.

Obrázek 2.1 ukazuje rozdělení hlavního rozhraní na logické 
podčásti, které jsou věnované konkrétní činnosti v rámci 
práce s programem. V této kapitole se budeme věnovat 
práci se soubory a technikám, s nimiž budete moci začít 
velmi rychle pracovat. Další komponenty rozhraní jsou blíže 
popsány v příslušných kapitolách (například vzhled a nasta-
vení pracovních výřezů nebo navigace ve 3D prostoru ve třetí 
kapitole).
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Témata kapitoly:

Rozdělení pracovního 

prostředí 3ds Max

Práce se soubory a scénou

Často opakované operace 

v 3ds Max

Kategorie objektů v 3ds 

Max

Přehrávání animace 

a animační stopa 

Navigace v pracovních 

výřezech

Přizpůsobení uživatelského 

rozhraní
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Abyste si mohli zkoušet některé příkazy probírané v této kapitole, měli byste znát alespoň 

základní způsob tvorby některých geometrických primitiv včetně jejich transformací. Až to bude 

třeba, zmíním v této souvislosti způsob tvorby základních objektů.

Práce se soubory a scénou
Založení nové scény
Efektivní práce se soubory je základní předpoklad každého uživatele 3ds Max. Abyste mohli 
pracovat se soubory od svých kolegů, z Internetu a různě je kombinovat, využijete hlavní apli-
kační nabídku. Tady najdete většinu příkazů pro práci se soubory. 

Ve verzi 3ds Max 2010 došlo k výraznější změně uživatelského rozhraní. Z toho důvodu možná 

nenajdete určité příkazy tam, kde byste je hledali ve verzi 2009. Například hlavní nabídka File je 

schovaná pod symbolem Maxe úplně vlevo nahoře, kde jsou jednotlivé příkazy seskupeny tema-

ticky pod nadřazené názvy (např. položka Save obsahuje Save As, Save Copy As, Save Selected 

a Archive). Hlavní nabídka začíná ve verzi 2010 položkou Edit. Položku hlavní nabídky File byste 

hledali marně. Můžete si ji ale do hlavní nabídky přidat (viz dále úprava rozhraní). Prozatím počítej-

te s tím, že nabídka File je skryta pod rozbalovacím symbolem Maxe vlevo nahoře. V dalším textu 

se budeme na tuto nabídku odvolávat jako na „hlavní aplikační nabídku“.

POZNÁMKAPOZNÁMKA

POZNÁMKAPOZNÁMKA

Obrázek 2.1. Rozhraní 3ds Max po spuštění v celé své kráse. Uvnitř tohoto editoru můžete vytvo-
řit svůj 3D animovaný film. Zpočátku lehce frustrující pohled na prázdné výřezy – vše musíte 
vytvořit zcela od základu.

Hlavní nástrojový panel

Příkazový 
panel

Navigační 
ovládací 
prvky

Přehrávání a záznam animaceStavový panel Časová stopa

Hlavní nabídka
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Když si chcete vyčistit aktuální obsah otevřené scény pro práci na nové, avšak chcete si pone-
chat aktivní všechna systémová nastavení (rozložení pracovních výřezů, přichytávání, nasta-
vení editoru materiálů atp.), použijte příkaz New. Při stisknutí tohoto příkazu máte na výběr 
mezi ponecháním všech objektů a hierarchických vztahů mezi nimi (vztah rodič-potomek, viz 
dále v animaci) s odstraněním animace (Keep Objects and Hierarchy), odstraněním hierarchií 
i animace s ponecháním objektů (Keep Objects), nebo odstraníte vše (New All).
Kompletní vyčištění scény od objektů, hierarchií a animace včetně nastavení výřezů provedete 
příkazem Reset. Efekt je stejný jako vypnutí a znovuspuštění Maxe. Využívejte jej, pokud chcete 
začít pracovat na zcela nové scéně, bez ohledu na tu aktuálně opouštěnou. Pokud chcete načí-
tat po každém vyvolání příkazu Reset stejné nastavení (výřezy, objekty, jednotky,…), uložte si 
takovou scénu pod názvem maxstart.max do aktuální projektové složky scenes (viz příkaz File 
→ Set Project Folder nebo v nové verzi 2010 schovaná pod položkou Manage v hlavní aplikační 
nabídce). 

Otevření scény
K otevření vybrané scény použijte příkazy Open a Open Recent (soubory s koncovkou MAX, CHR 
nebo DRF – formát pro VIZ Render, dostupný například v aplikaci AutoCAD Architecture). 

Obrázek 2.2. Hlavní nabídka File pro práci se souborovými formá-
ty. Pokud otevíráte scénu, importujete získané 3D modely nebo 
předáváte scénu v rámci produkčního toku, určitě zde najdete 
příkaz, který vám to umožní. Ve starších verzích najdete nabídku 
File standardně mezi ostatními položkami n, ve verzi 2010 jsou 
příkazy pro práci se soubory umístěny pod symbol 3ds Max vlevo 
nahoře (aplikační rozbalovací nabídka).n

o
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Pro většinu uživatelů je samozřejmě klíčový formát MAX. Open Recent zobrazuje naposledy 
otevřené soubory scén, což bývá rychlejší způsob, než dohledávat scénu na disku. Nastavení 
počtu takto zobrazených naposledy otevřených scén provádíte v hlavní nabídce Customize → 
Preferences → karta Files → řádek Recent Files in File Menu.

V 3ds Max platí, že neotevřete soubor MAX uložený v nejnovější verzi (například 2010) v některé 

starší (2009, 2008,…). Opačným způsobem to samozřejmě není problém. Jediným způsobem, 

jak toho docílit, je exportovat scénu do společného formátu nezávislého na verzi (například 3DS, 

OBJ a další podle potřeby).

Na obrázku 2.3 vidíte frekventovaný dotaz při otevření scény, jejíž nastavení měrných jednotek 
se liší od těch v aktuálně otevřené scéně. V horní části vás dialog informuje, v čem tkví neshoda 
jednotek (File Unit Scale = jednotky v otevíraném souboru, System Unit Scale = aktuálně nastave-
né systémové jednotky). V dolní části máte možnost vybrat si mezi:

Změnou jednotek v souboru podle aktuálních systémových jednotek (Rescale the File 
Objects to the System Unit Scale)
Přijetím nastavených jednotek v otevíraném souboru a tedy přepsání těch systémových 
(Adopt the File´s Unit Scale)

Ukládání scény
Různé způsoby uložení scény najdete v hlavní aplikační nabídce pod klíčovým pojmem Save. 
Tento příkaz byste si měli osvojit, protože nic jiného vás tolik nevyvede z míry jako pád sys-
tému bez uložení scény po několikahodinové práci. Ukládat, ukládat a zase ukládat. Nejlépe 
přírůstkově, což znamená, že si nepřepisujete jednu scénu neustále dokola, ale vytváříte si jejich 
přírůstkové kopie (např. Interier15_2_01, Interier15_2_02,…). Někdy se totiž může stát, že 
při pádu systému se současně naruší aktuálně otevřená scéna, kterou při znovuspuštění Maxe 
už neotevřete. Příkaz Save přepíše aktuálně otevřenou scénu, Save As vám nabídne možnost 
pojmenování scény pod jiným názvem, tedy umožní vytvořit kopii (nebo ale také přepsat 
tu stávající), Save Copy As dovolí vytvořit kopii scény pod zadaným názvem, ale pokračujete 
v práci na původní scéně. Kopie jakoby odsouváte někam na bezpečné místo do archivu, ale 

�

�

POZNÁMKAPOZNÁMKA

Obrázek 2.3. Po otevření souboru se scénou s odlišně nastaveným systémem 
měrných jednotek, než jak je máte nastavené v aktuální scéně, se objeví dialo-
gové okno s dotazem, jaké jednotky považujete za prioritní.
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pracujete na scéně s původním názvem. Poslední příkaz Save Selected je vynikající pomůckou, 
jak uložit pouze aktuálně vybrané objekty. Neukládáte celou scénu, ale jen požadované modely, 
které můžete poslat kolegovi. 

Založení nového projektu
Měli byste pracovat systematicky a k tomu dobře poslouží založení celé struktury projektu. 
Příkazem Set Project Folder zavedete adresářovou strukturu nově zakládaného projektu. Najdete 
ho v hlavní aplikační nabídce pod položkou Manage (spravovat). Při otevírání a ukládání scény 
se bude brát jako primární právě tato cesta. Před vytvořením projektu je pouze třeba zvolit 
cílový adresář, kde se struktura vytvoří.

Využití externích scén a modelů mimo vaši scénu
Tento přístup je vhodným způsobem organizace a sdílení projektových souborů. Příklad může 
být tento. Řekněme, že váš kolega pracuje na vizualizaci jedné budovy. Vy máte na starost 
celou ulici, kde stojí i tato budova. Stačí vám „ukázat“ na ni ve vaší scéně do souboru kolegy 
a nemusíte se o nic starat. Ideální způsob týmové práce. V 3ds Max 2010 najdete následující 
příkazy v hlavní aplikační nabídce klepnutím na symbol 3ds Max vlevo nahoře a výběrem 
položky References.
XRef Objects a XRef Scenes jsou tzv. externě odkazované objekty či scény. Tyto příkazy využijete 
v produkčním prostředí, uvnitř pracovního týmu. Do své otevřené scény si tímto načítáte 
odkazy na objekty nebo celé scény z jiných souborů, na kterých mohou v daném okamžiku pra-
covat vaši kolegové. Neznamená to import, ale pouze načtení jakéhosi zrcadla objektu z jiného 
souboru. Práce s tímto objektem je značně omezená a nemůžete ho upravovat obvyklým způ-
sobem. Nelze z něj klasickou cestou ani vytvořit kopii. Změny prováděné na daném modelu 
vašimi kolegy se projevují ve vaší scéně. Pro plnohodnotnou práci s objektem si ho můžete ze 
zdrojové scény od kolegy načíst ikonou Merge in Scene, která je dostupná v dialogu XRef Objects 
(horní řada ikon). 

Obrázek 2.4. Struktura projektové složky. Před zahájením každého komplex-
nějšího projektu je dobré vytvořit si tento adresář, kam se budou ukládat všech-
ny související komponenty scény (max soubory, textury, renderované snímky, 
exporty, archivy, zálohy, předdefinovaná nastavení renderování a podobně).

PRÁCE SE SOUBORY A SCÉNOU
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Obdobně funguje i příkaz XRef Scenes a platí pro celé scény – MAX soubory. Abyste scénu 
mohli transformovat, musíte ji v dialogu XRef Scenes připojit k libovolnému rodičovskému 
objektu funkcí Bind. Objekty scény typu XRef nemohou být vybrány ani nijak modifikovány. To 
je také rozdíl mezi XRef Objects a XRef Scenes.

Připojení CAD výkresů
Nástroj File Link Manager je ideálním nástrojem pro vás, pokud pracujete nebo využíváte sou-
bory i z jiných aplikací, jako je AutoCAD nebo Revit. Najdete ho v hlavní aplikační nabídce → 
References. Jeho využití je obdobné příkazům XRef, tedy dodržení jednoho centrálního místa 
s výkresem, který si jen do aktuální scény připojíte a pracujete nad ním. Soubory DWG a DXF 
do scény připojíte klepnutím na tlačítko File na kartě Attach dialogu File Link Manager. Tlačítkem 
Reload aktualizujete obsah DWG souboru. Je to vynikající způsob práce, pokud je vaším pra-
covním vstupem práce projektantů.

Vložení obsahu jiného MAX souboru do aktuální scény
Pokud chcete přidat scénu v souborovém formátu MAX do vaší aktuální scény, využijte pří-
kaz Merge. Najdete ho v hlavní aplikační nabídce pod položkou Import. To neplatí pro jiné 
typy souborů, pro které využívejte spíše funkce importu (viz dále). Po stisku příkazu Merge 
můžete v dialogu Merge File vybrat soubor, z něhož chcete do aktuální scény vložit některé 
jeho objekty. 

Obrázek 2.5. Externě odkazovaným objektem je v této scéně obraz. Práce s ním je odkázaná na 
externí soubor. V aktuální scéně s ním můžete provádět pouze běžné transformace a měnit jeho 
vzhled pomocí tzv. modifikátorů.
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Hromadné nahrazení objektů ve scéně jinými
Řekněme, že jste v aktuální scéně vytvořili několik zástupných objektů, které nyní potřebu-
jete nahradit detailním síťovým modelem, který má stejný název jako zástupné objekty. Pak 
použijete příkaz Replace, který nahradí ve scéně všechny objekty se stejným názvem.

Správa animací
Vytvořené animace si můžete ukládat do samostatných souborů s příponou XAF. Vezměte si 
příklad, kdy jste vytvořili pěknou animaci pohybujícího se objektu. Pokud tu samou animaci 
budete chtít namapovat na další objekt, musíte si nejprve: 

Uložit XAF animaci objektu (v dřívějších verzích před 2010 v nabídce File → Save 
Animation; ve verzi 2010 v hlavní nabídce Animation → Save Animation). 
Poté si vytvořte nový objekt, vyberte ho a načtěte na něj svou animaci (File → Load 
Animation, resp. Animation → Load Animation. 
Objeví se dialog XML Animation, který vás informuje o chybějícím namapování animač-
ních stop mezi oběma objekty a současně vám nabídne vytvoření takového souboru 
informací. 

1.

2.

3.

Obrázek 2.6. Dialog pro výběr externě odkazované scény. Objekty v ní obsažené nelze vybírat ani 
modifikovat. Jste odkázáni na záměry tvůrce scény.

PRÁCE SE SOUBORY A SCÉNOU

Přidání další scény

Synchronizace se zdrojem

Ovládací prvek 
pro transformaci scény
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Jakmile provedete přiřazení ovladačů (vyberte stejné ovladače vlevo a vpravo) a potvr-
díte šipkou mezi prostředním a pravým sloupcem ukazující doleva, máte vytvořeno 
mapování. Pak jen stačí klepnout na tlačítko Save Mapping a aktivuje se tlačítko Load 
Animation. Klepněte na něj a animace se načte na cílový objekt.

Více možností o tomto přístupu najdete samozřejmě v kapitole věnované animaci.

Importy a exporty souborů externích aplikací
Příkazy Import / Export představují základní způsob načítání modelů z /do jiných aplikací. 
Můžete načítat z následujících aplikací/souborových formátů:

Autodesk (FBX)
3D Studio Mesh (3DS, PRJ)
Adobe Illustrator (AI)
LandXML /DEM /DDF (DEM, XML, DDF)
AutoCAD Drawing (DWG)
Motion Analysis HTR (HTR)
IGES (IGE, IGS, IGES)

4.

�

�

�

�

�

�

�

Obrázek 2.7. Dialog Map Animation se objeví v případě, že potřebujete načíst animaci z jednoho 
objektu na jiný, k čemuž je nutné vzájemně přiřadit (namapovat) animační stopy či ovladače jed-
notlivých transformací. Max bude vědět, že pozice zdrojového souboru (INCOMING) bude přiřaze-
na ke správně stopě – pozici aktuálního nového objektu (CURRENT).
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Autodesk Inventor (IPT, IAM)
Lightscape (LS, VW, LP)
gw::OBJ-Importer (OBJ)
3D Studio Shape (SHP)
Stereolitho (STL)
Motion Analysis TRC File (TRC)
VRML (WRL, WRZ)

Nejznámější a jistě nejpoužívanější pro použití v 3ds Max jsou soubory 3DS, DWG, FBX, 
OBJ, popřípadě výstupy ze strojařského softwaru Autodesk Inventor (IPT a IAM). Pokud na 
Internetu najdete dostupné 3D modely pro 3ds Max, budou nejspíše ve formátu 3DS, MAX 
nebo OBJ (výstupní formát například z Autodesk Maya). Každý souborový formát má svá spe-
cifika, většinou však stačí přijmout implicitní hodnoty nabízené průvodcem importu. Exportní 
formáty jsou velmi podobné. Uvedu zde dva zajímavé, ne zcela běžné exportní formáty:

JSR-184 (M3G)
VRML97

První z nich je určen pro výstup na mobilní zařízení. Tím můžete připravovat 3D hry podporo-
vané na nejznámějších mobilních telefonech. Formát JSR-184 je založen na jazyku Java. VRML 
je standardní souborový formát pro reprezentaci 3D interaktivní vektorové grafiky navržený 
pro web. Jeho nástupcem se stal formát X3D.
Příkaz Export Selected umožní exportovat do zvoleného formátu pouze aktuálně vybraný objekt 
ve scéně 3ds Max.

Export do prezentačního formátu nezávislého na 3ds Max
Pokud potřebujete předat kolegovi ukázku své práce, ale nemáte čas renderovat průlet scénou 
a kolega navíc nemá 3ds Max, kde by si váš výstup prohlédl, můžete scénu exportovat do for-
mátu DWF. Ten si dotyčný může prohlédnout v bezplatné aplikaci Autodesk Design Review 
a libovolně se scénou procházet a otáčet. Možný výstup vidíte na obrázku 2.8, kde je scéna 
interiéru exportována do DWF. V aplikaci Design Review máte k dispozici celý 3D model, 
tedy nejen z pohledu aktuálně nastavené kamery. Výstup není plnohodnotný co do světel 
a reflexních materiálů jako v případě plnohodnotného renderu, avšak zůstane zachován celý 
model se základními materiály. V tom je rozdíl v porovnání s panoramatickými výstupy, které 
renderujete pouze z jednoho pohledu.

Centrální správa digitálních aktiv
Až budete pracovat s kolegy na velkém projektu, využijete nejspíš některý systém pro centrální 
ukládání projektových souborů a scén. Jednou z možností je použít systém Asset Tracking.
Příkazem Asset Tracking máte přímý přístup ke stejnojmennému systému, který umožňuje 
sdílet data, jako jsou scény, bitmapy a použité materiály (včetně verzování), mezi všemi členy 
produkčního týmu. Příkaz najdete ve verzi 2010 pod položkou Manage v hlavní aplikační 
nabídce. 
Tento systém podporuje řešení Autodesk Vault pro správu dat (kromě dalších, jako je Microsoft 
Visual SourceSafe, CVS a Perforce), které funguje jako centrální úložiště dat projektu. Jako 
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účastníci předplatného (tzv. Subscription) máte k aplikaci Autodesk Vault – verzi pro server 
Vault Server a klientskou část Vault Client – bezplatný přístup. Typická práce se systémem Asset 
Tracking spočívá v těchto krocích:

K souborům uloženým v tomto úložišti přistupujte přes hlavní nabídku File → Open from 
Vault 2009 (nebo přes hlavní aplikační nabídku → Open).
Před každým čtením a prací nad souborem uloženým v systému Vault si ho musíte 
nejprve nechat „vydat“ (check-out) a po vámi provedených změnách ho uložit zpět do 
úložiště (zařadit zpět) pomocí funkce Check-In.

Archivace kompletní scény včetně textur
Když budete potřebovat uložit kompletní archiv vašeho projektu,  použijte příkaz File → Archive. 
Tento příkaz najdete ve verzi 2010 v aplikační nabídce pod položkou Save As. Je to vynikající 
způsob k předání kompletního projektu dalším pracovníkům. Jeho smyslem je posbírání všech 
datových souborů (scény, bitmapy, fotometrická data a podobně) do jednoho ZIP souboru. 
Manuálně byste jen stěží nahrávali všechny textury na jedno místo z různých složek na disku. 

Statistika a metainformace scény
Zjištění podrobných informací o scéně vám pomůže odhalit skrytá úskalí během práce na 
projektu. Souhrnné statistiky o scéně zjistíte příkazem Summary Info. (Ve verzi 2010 ho najdete 
v  aplikační nabídce pod položkou Properties.) Ten vám podá spíše statistické informace o aktu-
ální scéně (počet vrcholů, seznam objektů, čas posledního renderovaného snímku, počet světel, 
kamer, využitá RAM paměť a podobně). 

1.

2.

Obrázek 2.8. Formát DWF společnosti Autodesk vám umožní prezentovat 3D prostor bez nutnos-
ti instalace 3ds Max. Kompletní 3D model včetně možnosti otáčení, průchodů a pohledů ze všech 
stran můžete zobrazit v aplikaci Autodesk Design Review.
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Připojit metainformace ke scéně můžete příkazem File Properties. To vám umožní k fyzickému 
souboru scény připojit data jako název scény, jméno autora, společnost, klíčová slova, komen-
táře a podobně.

Prohlížení obrázků
Prohlížení obrazových souborů, které budete potřebovat k texturování scény, bylo před verzí 
2010 dostupné v hlavní nabídce File → View Image File. Ve verzi 2010 najdete tento příkaz v hlav-
ní nabídce Rendering. 

Editování, transformace, výběry a vlastnosti objektů
Abyste si mohli vyzkoušet příkazy probírané v této a dalších kapitolách, je dobré znát tvorbu 
alespoň základních objektů. Vyzkoušejte si to v prázdné scéně přes hlavní nabídku Create → 
Standard Primitives. Zde najdete základní objekty jako krabice (Box), koule (Sphere), válec (Cylinder) 
a další. Primitivní objekt vytvoříte takto:

V hlavní nabídce Create → Standard Primitives si vyberte některý objekt. 
Klepněte do perspektivního pohledu (pravý dolní pracovní výřez, který má vlevo naho-
ře název Perspective), podržte levé tlačítko myši a táhněte s myší. 
Právě jste vytvořili svůj první objekt. Parametry zde měnit nebudeme, to bude náplní 
páté kapitoly „Tvorba základních objektů“.

Základní operace s objekty a scénou
Krok zpět a vpřed po provedené akci v pracovním výřezu provedete příkazem Edit → 
Undo/Redo (Ctrl+Z/Ctrl+Y). Tyto příkazy neplatí pro krok zpět, pokud pohnete nebo 
otočíte pohledem (pro to slouží příkazy Views → Undo View Change – Shift+Z a Redo 
View Change – Shift+Z). Změna se týká zejména parametrických úprav a transformací.  
Rychlé uložení/načtení scény můžete provést příkazy Edit → Hold/Fetch. Je to jakási při-
hrádka pouze pro jeden soubor. Opakovaný příkaz Hold přepisuje naposledy uloženou 
scénu tou aktuální. Příkaz Fetch takovou scénu načte. Oba příkazy se hodí, pokud potře-
bujete scénu uložit, ale není zas natolik důležitá, abyste ji ukládali pod určitým názvem 
příkazem File → Save.

Klon aktuálně vybraného objektu provedete příkazem Edit → Clone (Ctrl+V). Jde o kopii 
vybraného objektu (nebo více vybraných objektů).
Klávesou Delete nebo tímto příkazem odstraníte vybrané objekty ze scény. 

Po provedení příkazu Clone se vám nabídne dialog s výběrem typu klonování. Možnosti jsou 

Copy, Instance a Reference. Kopií vytvoříte klon nezávislý na jeho předloze, objektu, z něhož 

vznikl. Změníte-li parametry kopie či originálu, nebudou se změny projevovat na tom druhém. 

Instance vytváří obousměrný vztah mezi originálem a klonem, kdy změna parametru jednoho 

z nich vyvolá současně změnu i toho druhého (výhodné například u tvorby stejných oken, stro-

mů a dalších objektů, u nichž chcete změnou parametru jednoho z nich vyvolat změnu všech 

ostatních). S referencí se seznámíme v kapitole o modelování.

1.

2.

3.

�

�

�

�

POZNÁMKAPOZNÁMKA

PRÁCE SE SOUBORY A SCÉNOU
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Transformace objektů (posun, otočení a změna měřítka)
Základní a klíčové transformace, které budete používat nejčastěji, jsou posun, otočení a změna 
měřítka objektu. Těmi budete vaše 3D modely umisťovat v libovolné poloze i velikosti na libo-
volné místo. Animací těchto transformací dosáhnete požadovaných pohybů objektů.

Libovolný objekt posunete příkazem Edit → Move. Objekt lze posunovat podle os X, Y, 
Z nebo v rovinách XY, XZ či YZ. Implicitní klávesová zkratka je W. V kombinaci s dal-
šími klávesami E (otočení) a R (změna měřítka) jde o rychlý přístup k transformačním 
příkazům.
Libovolný objekt otočíte příkazem Edit → Rotate. Otočení objektu podle jedné z os či 
jejich kombinací obdobně jako u posunu můžete aktivovat klávesou E.
Objektu změníte jeho velikost příkazem Edit → Scale. Příkaz aktivujete klávesou R. 
Přesné souřadnice transformací zadáte nástrojem Edit → Transform Type-In. Pomocí něj 
můžete přesně určit místo, na které chcete model umístit. Příkaz Transform Type-In vyvolá 
dialog pro zadání souřadnic X, Y, Z v aktuálních jednotkách. Vyvoláte ho také funkční 
klávesou F12 nebo klepnutím pravým tlačítkem na aktivní ikonu vybrané transformace 
(posun, otočení nebo změna měřítka) na hlavním panelu nástrojů. Obrázek 2.9 ukazuje 
možnosti dialogu Transform Type-In pro posun. Pokud zde neuvidíte žádné souřadnice, 
nemáte zřejmě aktivní ikonu pro posun, otočení nebo změnu měřítka (klávesy W, E, R).

1.

2.

3.

4.

Obrázek 2.9. n Dialog Move Transform Type-In nabízí možnost zadání souřadnic X,Y 
a Z pro posun objektu. Máte na výběr mezi absolutními souřadnicemi (na které místo 
chcete objekt přemístit) nebo offsetovými souřadnicemi (o kolik jednotek z aktuální-
ho místa se objekt posune) n. Transformace můžete také provádět pomocí nástroje 
Transform Toolbox o. 

n

K1601.indd   44K1601.indd   44 14.1.2010   13:44:2714.1.2010   13:44:27



45

2
U

ži
v

a
te

ls
k

é
 

ro
zh

ra
n

í,
 z

á
k

la
d

n
í 

p
ří

k
a

zy

Obdobným způsobem zadáváte hodnoty pro otočení (ve stupních) a změnu měřítka 
(v procentech).
Můžete také objekty otáčet o vybraný počet stupňů (Rotate), měnit jejich velikost dle 
vybrané osy, čímž dojde ke zploštění objektu v daném směru (Size), definovat polohu 
tzv. pivotu (zjednodušeně transformační „trojnožka“ ukazující směr os) výběrem os 
a rozsahem (Align Pivot) nebo umisťovat objekt na střed (souřadnice 0,0,0) a kopírovat 
ho v řadě (Object). K tomu použijte nástroj Edit → Transform Toolbox, který je novin-
kou 3ds Max 2010 pro snazší transformace.

Typy výběru objektů
Objekty můžete vybírat následujícími způsoby (všechny příkazy najdete v hlavní nabídce 
Edit):

Výběr všech objektů ve scéně naráz. Aktivujete jej klávesovou zkratkou Ctrl+A (Select 
All).
Zrušení výběru veškerých objektů. Je to obdoba klepnutí levým tlačítkem myši do 
prázdného místa v pracovním výřezu (Select None).
Obrácení výběru. Máte-li například vybrány 3 objekty z 5, příkaz Select Invert vybere 
druhé dva a výběr prvních tří se zruší.
Výběr „podobných“ objektů. Záleží na typu zdrojového objektu (geometrické primi-
tivum nebo editovatelná síťovina) a přiřazeného materiálu. Příkazem Select Similar 
vyberete podobné objekty (například všechny krabice nebo krabice se stejným mate-
riálem).
Výběr všech instancí vybraného objektu. Na základě aktuálně vybraného objektu vybere 
příkaz Select Instances všechny jeho instance (např. všechny stromy).
Výběr dle různých kategorií. Po rozvinutí nabídky Select By můžete dále vybrat požado-
vané objekty podle jejich názvu (Select By Name) bez nutnosti klepání na objekty přímo 
ve výřezu, příslušnosti k vrstvě (Select By Layer) pro výběr všech objektů ležících v dané 
vrstvě nebo výběru podle barvy (Select By Color). Poslední z nich ale nevybere objekty se 
stejným materiálem přiřazeným na objekt z editoru materiálů. Bere v potaz pouze barvu 
drátového modelu, tedy takovou, kterou měl model ihned po svém vytvoření.

5.

1.

2.

3.

4.

5.

6.

Obrázek 2.9. o Dialog Move Transform Type-In nabízí možnost 
zadání souřadnic X,Y a Z pro posun objektu. Máte na výběr mezi abso-
lutními souřadnicemi (na které místo chcete objekt přemístit) nebo off-
setovými souřadnicemi (o kolik jednotek z aktuálního místa se objekt 
posune) n. Transformace můžete také provádět pomocí nástroje 
Transform Toolbox o.

o

PRÁCE SE SOUBORY A SCÉNOU
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Později zjistíte, že barva, kterou má objekt po svém vytvoření, není materiál. Skutečný materiál, 

jaký přiřazujete objektům z editoru materiálů, má mnohem komplexnější charakteristiky, jako je 

odraz nebo průhlednost. O materiálech se dozvíte detailní informace v desáté kapitole.

Definice výběrové oblasti. Výběrová oblast umožňuje vybrat objekty přímo v pracov-
ním výřezu tažením myši. Způsoby (metody), jakými můžete objekty vybírat, jsou 
dostupné v nabídce Selection Region (viz postupně ikony na obrázku 2.11):

Obdélníkový (Rectangular)
Kruhový (Circular)

Volně definovaný tah (Fence)

Smyčka (Lasso)

„Malováním“ po objektech. Kreslením po povrchu objektů ve výřezu vybíráte 
postupně „zasažené“ objekty (Paint).

Přepínači Windows resp. Crossing přepínáte možnosti, zda se budou vybírat pouze objek-
ty, které jsou celým svým objemem uvnitř výběrové oblasti, resp. pro jejich výběr stačí, 
pokud se jich v rámci výběrové metody dotknete.

Vybírat objekty můžete i pouhým klepnutím na objekt. Více jich vyberte se stisknutou klávesou 

Ctrl. Z výběru odebíráte stisknutím klávesy Alt a klepnutím na objekt.

Správa výběrových sad (sad pojmenovaných výběrů – Manage Selection Sets) je vyni-
kající nástroj pro organizaci objektů ve scéně. Slouží pro pojmenování vámi vybrané 
množiny objektů, kterou budete moci kdykoli naráz vybrat přes tento název. Tyto sady 
jsou odlišné od skupin (Groups), které jsou definovány jako uzavřený celek, kdy pro 
výběr celé skupiny stačí klepnout na libovolný z objektů skupiny přímo v pracovním 

7.

�

�

�

�

�

8.

POZNÁMKAPOZNÁMKA

POZNÁMKAPOZNÁMKA

Obrázek 2.10. Dialog Select From Scene vyvoláte, pokud vybíráte objekty 
podle jejich názvu. Můžete začít psát do pole Find, čímž se začnou automaticky 
vybírat všechny objekty začínající na zapsaný řetězec znaků. V řádku Display 
můžete zapínat filtr kategorií objektů, který zobrazí jen ty aktivované.
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výřezu. Naproti tomu sady pojmenovaných výběrů musíte vybrat tak, že zvolíte název 
sady objektů z rozbalovacího pole, jak vidíte na obrázku 2.12 (zde i vybrané množiny 
objektů pojmenováváte). V tomto dialogu můžete objekty mezi sadami přesouvat, 
mazat či přidávat nové. 

Vlastnosti objektů
Dialog Object Properties, který najdete vespod nabídky Edit, nabízí informace o vybraném 
objektu (například viditelnost při renderování, počet vrcholů, čelních ploch, styl zobrazení 
v pracovním prostředí, zda objekt vrhá stíny či je přijímá na svém povrchu a podobně). Pojďme 
se na tyto možnosti podívat podrobněji. Určitě na většinu z nich při větším projektu narazíte. 
Vlastnosti objektu vyvoláte také tímto postupem:

Vyberte objekt a klepněte na něj pravým tlačítkem myši.
Zvolte možnost Object Properties.
Otevře se dialog vlastností, kde můžete určit chování objektu v konkrétních situacích.

Karta General nabízí 6 skupin parametrů – Object Information, Interactivity, Display Properties, 
Rendering Control, G-Buffer a Motion Blur. Ostatní karty jsou typické pro nastavení pokročilého 
osvětlení (Adv.Lighting), rendereru mental ray (mental ray) a pro zadání uživatelských poznámek 
(User Defined). Těmto kartám se budeme věnovat v příslušných kapitolách.

1.

2.

3.

Obrázek 2.11. Rozbalovací ikona Rectangular Selection Region na hlavním panelu 
nástrojů (podržte na ní chvilku levé tlačítko myši) pro zvolení metody výběrů objektů

PRÁCE SE SOUBORY A SCÉNOU

Obrázek 2.12. Named Selection Sets (dialog pro správu pojmenovaných výběrů 
objektů). Tady si můžete sady upravovat, přesouvat mezi nimi objekty a vytvářet 
nové. Je to vynikající způsob organizace souvisejících objektů ve scéně.
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Skupina Object Information obsahuje údaje o názvu a barvě (drátového) modelu, jeho rozměrech 
(Dimensions), počtu vrcholů (Vertices) a čelních ploch (Faces), názvu přiřazeného materiálu 
(Material Name) a vrstvy, do níž objekt náleží (Layer). Pak zde najdete něco málo k hierarchic-
kým vlastnostem, a sice název předka objektu (Parent), počet potomků (Num.Children) a zda 
objekt náleží do nějaké skupiny (In Group/Assembly).

Skrývání a mrazení objektů
V části Interactivity můžete daný objekt skrýt (Hide) či zmrazit (Freeze). Skrytí objektu znamená, 
že nebude vidět v pracovním výřezu ani na vyrenderovaném snímku. Odkrýt objekt můžete 
klepnutím pravým tlačítkem myši kamkoli do výřezu a výběrem příkazu Unhide All (odkrýt vše 
skryté) nebo Unhide by Name (odkrýt podle názvu) v pravém horním kvadrantu čtyřnásobné 
nabídky. Zmrazením objektu zamezíte jeho výběru, například proti náhodnému výběru či 
nežádoucímu posunu objektu. Zmrazené objekty zpět rozmrazíte ve čtyřnásobné nabídce 
výběrem příkazu Unfreeze All (rozmrazit vše).

Obrázek 2.13. Dialog Object Properties nabízí možnost nastavení specifických vlastností objek-
tů. Je přístupný jednak přes nabídku Edit → Object Properties (objekt musí být vybraný) a také 
klepnutím – pravým tlačítkem myši na objekt v pracovním výřezu a výběru Object Properties.
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PRÁCE SE SOUBORY A SCÉNOU

Název čtyřnásobná nabídka, jak ji vidíte na obrázku 2.14 o, vychází z předpokladu, že máte 

vybraný editovatelný objekt typu Editable Poly (polygonová síť), Mesh (trojúhelníková síť), Patch 

(plát) nebo Spline (křivka) popřípadě další typy objektů jako editovatelná křivka a podobně. Čtyři 

kvadranty se tedy objeví, pokud máte možnost editovat vrcholy, hrany, polygony nebo křivky. 

Tomu tak není u základních geometrických primitiv, kdy se klepnutím na pravé tlačítko myši 

zobrazí pouze dva kvadranty. S těmito typy objektů se seznámíme v kapitole o modelování. 

Vlastnosti objektů podle vrstvy
Skupina Display Properties nabízí zaškrtávací pole pro styl zobrazení objektů v pracovním 
výřezu. Přepínací tlačítko s názvem By Object nám dává možnost ovládání těchto vlastností 
individuálně u každého objektu (By Object) nebo prostřednictvím nastavení vrstvy, do níž daný 
objekt náleží (By Layer). V tom druhém případě byste vlastnosti vrstvy nastavili v nabídce Tools 
→ Manage Layers → pravé tlačítko myši na název vrstvy → Layer Properties. Objekt můžete 
nastavit jako průhledný (See-Through), nechat ho zobrazit v podobě drátěné krabice (Display as 
Box) nebo zamezit zobrazení zadních ploch objektu (Backface Cull). Obrázek 2.15 ukazuje rozdíl 
mezi zapnutou a vypnutou volbou Backface Cull. 

POZNÁMKAPOZNÁMKA

Obrázek 2.14. Čtyřnásobná nabídka obsahuje také příkazy pro skrytí i zmrazení objektů n. Čtyři 
kvadranty nabídky se zobrazí u editovatelných typů objektů (Poly, Mesh, Patch, Spline) o, kdežto 
u klasických geometrických objektů pouze dva n. 

n

o
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Zapnuté pole Edges Only zobrazí pouze vnější hrany polygonů utvářející povrch objektu, bez 
diagonál. Vertex Ticks zobrazí vrcholy v podobě modrých teček. To se hodí, když potřebujete 
sledovat detaily modelu. Pokud je model animovaný, můžete zobrazit jeho trajektorii pohybu 
zaškrtnutím pole Trajectory. Zapnuté pole Ignore Extents způsobí ignorování tohoto objektu při 
provádění akcí Zoom Extents a Zoom Extents All (vycentrování všech objektů v aktivním výřezu 
a vycentrování všech objektů ve všech výřezech). Pole Show Frozen in Gray zešediví zmrazený 
objekt ve výřezu.
Pokud pole vypnete, objekt bude mít svou standardní barvu, i když bude zmrazený a vy ho nebu-
dete moci vybrat. Never Degrade nebude nikdy degradovat objekt na jednodušší zobrazení (tzv. 
adaptivní degradace) a nebude ve snaze Maxe vylepšit či urychlit interaktivitu pohledu měnit 
vzhled tohoto modelu na jednodušší typ (například pouhou ohraničující krabici). Vertex Channel 
Display umožní zobrazit barvu vertexů (vrcholů) objektu přímo v pracovním výřezu. K čemu to 
je dobré, se dozvíme až při výkladu modifikátoru Vertex Paint v kapitole o modelování.

Renderovací vlastnosti objektů
Až budete nastavovat, jak se mají objekty chovat během renderování (render spustíte pomocí 
Shift+Q), podívejte se do skupiny parametrů Rendering Control. Najdete tam mnoho možností 
určujících renderovací vlastnosti objektů opět individuálně nebo podle vrstvy, k níž náležejí. 
Pole Visibility umožňuje výběrem hodnoty v intervalu <0,1> nastavit viditelnost (průhlednost) 
objektu, která je také animovatelná. Hodnota 0.5 zprůhlední objekt na 50%. Pole Renderable 
zapne či vypne renderování tohoto objektu. Pokud je pole vypnuté, nebude model v renderu 
vidět a ani nebude mít vliv na ostatní objekty (např. vržené stíny). Inherit Visibility způsobí 
zdědění nastavení hodnoty parametru Visibility předka vybraného objektu. Když si ve scéně 
vytvoříte kameru, můžete nastavit, aby určitý objekt nebyl kamerami pozorován, bude tedy 
vůči kamerám neviditelný. Toho dosáhnete vypnutím pole Visible to Camera. 
Zapnuté pole Visible to Reflection/Refraction způsobí, že objekt bude vidět v odrazech na okol-
ních objektech. Zapnuté pole Receive Shadows umožní objektu přijímat stíny vržené od okol-
ních objektů. Zapnuté pole Cast Shadows naopak zajistí, že objekt bude schopen vrhat stíny. 
Atmosférické efekty jsou typické svým objemem v prostoru. Jejich příkladem může být mlha 
nebo oheň. Pole Apply Atmospherics pak způsobí, že daný objekt bude schopen na sebe přijmout 
takovéto efekty (např. objekt bude vidět v mlze). V opačném případě, když je volba vypnutá, 
volumetrický efekt jakoby „obejde“ tento objekt. Záhadný pojem Render Occluded Objects umož-

Obrázek 2.15. Volba Backface Cull je zapnutá a zadní plošky objektu nejsou vidět n. Pokud toto 
pole vypneme, uvidíme i zadní plošky o, což může být u spousty objektů náročnější na plynulý 
pohyb ve výřezu.
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ní to, že objekty zakryté objektem s tímto polem zapnutým budou renderovatelné. Tím budou 
efekty aplikované na tento zakrytý objekt vidět.

Aplikování efektů přes grafický kanál
Skupina G-Buffer objektových vlastností obsahuje jediné pole – Object ID. Zde nastavujete iden-
tifikační číslo kanálu, skrze nějž bude na objekt aplikován vybraný render efekt (například 
Hair and Fur – Vlasy a ochlupení, efekty kamerových čoček, Blur – rozmlžení pohybujícího se 
objektu a další – viz kapitola o renderování). Jinak řečeno, prostřednictvím této hodnoty bude 
renderovací efekt s objektem propojen. Tyto efekty nastavujete v nabídce Rendering → Effects 
→ tlačítkem Add přidáte efekt, kde taktéž u efektu nastavujete, na který objektový kanál (tedy 
G-Buffer) se má aplikovat. Všechny objekty s tímto G-Buffer ID přijmou daný efekt.

Pokud využíváte renderer mental ray, ověřte si, které renderovací efekty podporuje.

Poslední skupina objektových vlastností karty General s názvem Motion Blur vám dovolí napo-
dobit speciální efekt rozmlžení pohybujícího se (animovaného) objektu. Tento přirozený jev 
kamer jste již určitě zaznamenali. Stačí si pozastavit libovolný film v některé akční scéně. 
Rychle se pohybující objekt bude rozmlžený, jak vidíte na obrázku 2.16.

Takový efekt můžete ovládat na úrovni objektu i vrstvy přepínacím tlačítkem By Object/By Layer. 
Parametr Multiplier ovlivňuje délku efektu rozmlžení. Čím vyšší je tato hodnota, tím výraznější 
je efekt. Polem Enable efekt zapínáte (zapnuté pole) a vypínáte (vypnuté pole). Dále zde máte 
na výběr mezi objektovým rozmlžením (Object motion blur) a obrazovým rozmlžením (Image 
motion blur). Objektové rozmlžení funguje na bázi rychlosti objektu, vytvoří se jeho kopie mezi 
snímky, ty se vyrenderují a pak se ve finále spojí. Obrazové rozmlžení funguje aplikováním na 
celý obraz (bere se v úvahu rychlost každého pixelu), nejen pohybující se objekty. Jde o obdobu 
efektu při pohybu kamery ve scéně, nikoli pouze o pohybující se objekty.

POZNÁMKAPOZNÁMKA

Obrázek 2.16. Porovnání objektů se zapnutým objektovým rozmlžením 
Object Motion Blur (červené auto) a bez něj (modré auto). 

PRÁCE SE SOUBORY A SCÉNOU
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Jestliže kamera zaznamená při otevřené závěrce kamery (tzv. doba expozice = shutter speed) 
pohyb, obraz se rozmlží. Obvykle bývá tento efekt zpracován rychleji než objektové rozmlžení. 
Právě k tomuto typu rozmlžení můžete použít zvýraznění intenzity rozmlžení prostřednictvím 
parametru Multiplier. Další typ rozmlžení, který není přítomen v objektových vlastnostech, je 
rozmlžení celé scény (Scene motion blur). Tento filtr najdete v nabídce Rendering → Video Post 
→ Add Scene Event. S ohledem na docílení optimálního poměru kvalita/doba renderování se 
doporučuje typ Image Motion Blur. 

Nástroje pro správu a organizaci objektů
S mnoha objekty ve scéně a pro přehled nad logickými celky využijte nástroje v nabídce Tools. 
Najdete zde například nástroje pro tvorbu polí objektů, zrcadlení, zarovnávání objektů nebo 
měření vzdáleností. 

Přehled nad objekty ve scéně v Průzkumníkovi scény
Objekty ve scéně spravujete pomocí průzkumníka scény. Otevřete ho z nabídky Tools → New 
Scene Explorer. Určitě znáte aplikaci Průzkumník Windows. Podobně založený je nástroj New 
Explorer, který vám nabízí seznam objektů ve scéně s možností jejich vyhledávání, řazení, fil-
trování, zobrazování požadovaných informací a podobně. Je to obrovský pomocník ve velkých 
scénách, kde vám pomůže vnést pořádek a přehled. 

 Shrneme-li, můžete tento nástroj použít pro: 

Vyhledání objektu(ů) ve scéně (pište do pole Find, objekty se v seznamu vybírají ihned) 
a jejich výběr ve scéně.

1.

Obrázek 2.17. Nástroj Scene Explorer pro organizaci a vyhledávání objektů ve scéně
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Vybrání objektů uvnitř sad pojmenovaných výběrů (Selection Set).
Zobrazování jen určitých kategorií objektů jako 3D geometrie, 2D tvary, světla, kamery, 
pomocné objekty, prostorové deformace, skupiny, XRef objekty a kosti (Display → Object 
Types).
Řízení objektů podle názvu (pravým tlačítkem myši na název záhlaví některého sloupce).
Přidávání si dalšího informativního sloupce (pravým tlačítkem myši na název záhlaví 
některého sloupce  →  Configure Columns).
Ukládání rozšířených filtrů. 

V nabídce Tools najdete také příkaz Manage Scene Explorer, který vyvolá dialog pro správu 
uložených průzkumníků (můžete jich totiž otevřít více najednou). Správou rozumíme uložení 
jejich rozvržení (Save), načtení (Load), odstranění (Delete), přejmenování (Rename) nebo nasta-
vení vybraného průzkumníka jako implicitní volby (Set as Default). Po nastavení jednoho prů-
zkumníka jako implicitního se v nabídce Tools objeví nový příkaz na prvním místě s názvem 
Open Explorer: Název implicitního průzkumníka. Uložené průzkumníky najdete v nabídce Tools → 
Saved Scene Explorers. 

K organizaci scény slouží také Containers – novinka verze 2010. Tyto kontejnery představují 

pomocné objekty umožňující organizování scény do logických skupin, s nimiž můžete nakládat 

jako s jedním objektem. Kontejnery můžete ukládat jako soubory MAXC, a tudíž je lze také sdílet 

více uživateli. Více informací o tomto nástroji najdete v příloze A, kde jsou představeny novinky 

verze 3ds Max 2010.

Izolování a skrývání objektů
Často budete mít ve scéně příliš mnoho objektů, ale pracovat budete pouze s jejich určitou 
podskupinou. Máte dvě možnosti. 

Skrýt objekty „napevno“.
Izolovat si některé objekty po dobu vaší práce (ostatní se po dobu práce skryjí). 

Vyberte požadovanou skupinu objektů, se kterými chcete pracovat.
Použijte příkaz Tools → Isolate Selection. 
Objeví se plovoucí tlačítko Exit Isolation Mode, které po ukončení editací objektů 
stiskněte pro návrat mezi všechny objekty. Je to velký pomocník v komplexních 
scénách a určitě si ho oblíbíte. Klávesová zkratka je Alt+Q. 

Druhou možností, jak si zjednodušit práci, je skrytí či zmrazení objektů. K tomu využijete 
nástroj v podobě plovoucího dialogu Tools → Display Floater. Na kartě Hide/Freeze objekty 
skrýváte (Hide) a zmrazujete (Freeze), kdežto na kartě Object Level pracujete na úrovni objek-
tových kategorií (geometrie, tvary, světla,…). Výhodou tohoto dialogu je, že ho můžete mít 
na ploše otevřený během práce s objekty (proto Floater). Pro skrývání či mrazení objektů 
využijete nejčastěji příkazy Hide Selected (skrýt vybrané), Hide Unselected (skrýt nevybrané), 
nebo Unhide By Name (odkrýt podle názvu). Obdobně fungují příkazy pro mrazení objektů 
v pravém sloupci Freeze. Jak už jsme zmínili, mrazení objektů spočívá v nemožnosti jejich 
výběru. Jde spíše o preventivní opatření proti neúmyslné transformaci nebo odstranění 
objektu ve scéně.

2.

3.

4.

5.

6.

�

�

1.

2.

3.

POZNÁMKAPOZNÁMKA

PRÁCE SE SOUBORY A SCÉNOU
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Obrázek 2.19. Zpřehlednit si scénu můžete prostřednictvím nástro-
je Display Floater. Tady máte na výběr mezi skrýváním a mrazením 
vybraných objektů nebo skrýváním celých objektových kategorií.

Obrázek 2.18. Izolování scény vám pomůže pracovat nad určitou podmnožinou objektů. 
V komplexních scénách tento nástroj využijete určitě často.
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Správa objektů ve vrstvách
Nejen architektonické vizualizace vyžadují důmyslné rozdělení objektů do vrstev. To vám zvýší 
jednak přehlednost, ale především urychlí projekt, protože budete moci efektivněji a hromadně 
měnit vlastnosti objektů prostřednictvím vrstev (např. vrstva oken, vrstva stromů, …). 

Z nabídky Tools → Manage Layers otevřete správce vrstev, který implicitně zobrazuje 
objekty ve vrstvě 0 (default). 
Nové vrstvy můžete vytvářet ikonou Create New Layer (containing selected objects). 
Výběrem objektu v seznamu a klepnutím na něj pravým tlačítkem myši ho můžete 
vyjmout (Cut) a přesunout do nové vrstvy (pravým tlačítkem myši jinou vrstvu a Paste). 
Dále můžete objekty vybrané ve výřezu přidávat do vybrané vrstvy (vysvícená vrstva 
ve správci vrstev) pomocí ikony vyznačené symbolem „+“ – Add Selected Objects to 
Highlighted Layer. Klepnutím na malou kostičku vlevo od názvu objektu se vám otevře 
dialog s vlastnostmi daného objektu Object Properties. U vrstev se klepnutím na symbol 
tří obdélníků nad sebou, který se nachází nalevo od názvu vrstvy, otevře dialog vlast-
ností vrstev Layer Properties. 

Pokud budete chtít, aby objekt náležející do dané vrstvy přijímal její nastavení, musíte v jeho 

objektových vlastnostech zapnout přepínací tlačítko By Layer (viz kapitola Editování, transforma-

ce, výběry a vlastnosti objektů).

1.

2.

3.

4.

TIPTIP

Obrázek 2.20. n Správce vrstev Layer Manager umožňuje seskupit objekty do logicky souvise-
jících skupin – vrstev, takže vaše práce s nimi bude efektivnější n. Ve verzi 2010 se změnil pouze 
vzhled ikon o podobně jako v ostatních dialozích 3ds Max.

n

PRÁCE SE SOUBORY A SCÉNOU
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Layer Manager obsahuje sloupce Hide (skrýt), Freeze (zmrazit), Render (objekt je vidět v rende-
ru), Color (barva) a Radiosity (objekt je součástí pokročilého řešení osvětlení radiozity).

Zachycení více stavů scény v jednom MAX souboru
Představte si situaci, že budete chtít v jednom MAX souboru uchovat scénu s vlastnostmi jako 
ve dne a pak tutéž scénu s napodobením noční atmosféry. Máte vytvořenou scénu, připravené 
3D modely a právě jste nastavili denní osvětlení. To chcete uchovat a současně začít pracovat 
na noční scéně. 

Otevřete nabídku Tools → Manage Scene States.

Klepněte na tlačítko Save pro uchování například denního osvětlení. 
Před uložením zvolte ty části scény, které chcete uchovat (vlastnosti objektů, kamer, 
vrstev, světel, materiály, prostředí). 
Pak můžete směle přistoupit k úpravám a změně osvětlení na noční. Uložte si stejným 
postupem tento nový „noční“ stav. Mezi stavy se přepínáte příkazem Restore. Rozhraní 
zachycuje obrázek 2.21.

Zrcadlení, zarovnávání a pole objektů
Abyste mohli experimentovat samostatně s možnostmi zrcadlení i zarovnávání objektů, měli 
byste umět vytvořit cvičné objekty a posunout s nimi. Vysvětlíme si tedy základní principy 
transformace, které budou předmětem třetí kapitoly. Nicméně na tomto místě byste měli umět 
objekty transformovat (alespoň s nimi posunovat). 

Vytvořte si libovolný objekt z hlavní nabídky Create → Standard Primitives (jak jsem 
naznačil postup v kapitole Editování, transformace, výběry a vlastnosti objektů). 
Vyberte tento objekt a aktivujte klávesu W pro posun. 
Uvnitř objektu se objeví systém tří os – tzv. transformační pivot. Přesuňte kurzor myši 
nad jednu z os, která tak změní barvu na žlutou. Tato osa je tedy aktivní, a pokud nad ní 
podržíte levé tlačítko myši, můžete v této ose s objektem posunout. Posunuli jste objekt 
ve směru této osy. 

1.

2.

3.

4.

1.

2.

3.

Obrázek 2.20. o Správce vrstev Layer Manager umožňuje seskupit objekty do logicky souvise-
jících skupin – vrstev, takže vaše práce s nimi bude efektivnější n. Ve verzi 2010 se změnil pouze 
vzhled ikon o podobně jako v ostatních dialozích 3ds Max.

o
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Zrcadlení objektů
Nyní se se znalostí transformace podívejme na možnost zrcadlení objektů. 

Vytvořte si libovolný objekt a vyberte ho.
Přejděte do hlavní nabídky Tools → Mirror. 
Otevře se dialog, kde je implicitně nastaveno, že se nevytvoří zrcadlová kopie, ale že se 
vybraný objekt sám zrcadlí podle zvolené osy (No Clone). 
Pokud byste chtěli vytvořit kopii nebo instanci, stačí v části Clone Selection vybrat pří-
slušnou volbu. V horní části dialogu nazvané Mirror Axis vybíráte osu nebo kombinace 
os zrcadlení. Jestliže se vám kopie vytvořila uvnitř její předlohy, můžete ji posunout do 
určité vzdálenosti od originálu zadáním hodnoty do pole Offset.

Zarovnávání objektů
Přesné zarovnávání objektů provádíte tímto obecným postupem:

Vyberte objekt, který chcete zarovnat.
Přejděte do hlavní nabídky Tools → Align → Align (Alt+A).
Objeví se kurzor myši pro zarovnání. Klepněte na objekt, s nímž chcete první objekt 
zarovnat.
Vyberte možnosti zarovnání a stiskněte tlačítko OK pro potvrzení.

Na obrázku 2.23 vidíte možnosti dialogu pro zarovnání. V horní části vybíráte osy, podle nichž 
budete zarovnávat. Current Object je aktuálně vybraný objekt, který se přemísťuje (v našem 
případě konvice). Target Object je cílový objekt, tedy kávovar. Možnosti Minimum (minimum 
ohraničující krabice objektu v ose X, Y a Z), Maximum (maximum ohraničující krabice objektu 
v ose X, Y a Z), Center (střed ohraničující krabice objektu) a Pivot Point určují způsob zarovnání 

1.

2.

3.

4.

1.

2.

3.

4.

Obrázek 2.21. Dva stavy scény s různým osvětlením – ve dne a v noci. Obě varianty zachytíte 
v jednom MAX souboru.

PRÁCE SE SOUBORY A SCÉNOU
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vybraného nebo cílového objektu. Zarovnávání nemusíte (a někdy ani nemůžete) provádět ve 
všech krocích najednou. Musíte například nejprve zarovnat objekty v osách X a Y, potvrdit čás-
tečné zarovnání tlačítkem Apply a potom zarovnat v ose Z. Na příkladu konvice, která je zcela 
mimo kávovar ve všech osách, bychom postupovali takto:

Výběr konvice, provedení příkazu Tools → Align → Align.
Klepnutí na horní část kávovaru (samostatný objekt).
Výběr os X a Y v části Align Position (World) a Center Current Object a Center Target Object. 
Tím zarovnáte konvici s horní částí kávovaru půdorysně (v osách X a Y). Stiskněte tla-
čítko Apply pro potvrzení této operace.
Vypněte osy X, Y a zapněte osu Z. Vyberte Current Object → Minimum a Target Object → 
Pivot Point (minimum konvice se zarovná s pivotem horní desky kávovaru, který leží 
přesně tam, kde je třeba).
Stiskněte tlačítko OK pro potvrzení finálního zarovnání.

Pro úplnost uvedeme zbylé nástroje pro zarovnávání, které najdete v nabídce Tools → Align.

Quick Align – rychlé zarovnání objektů bez vyvolání dialogu Assign Selection a bez 
jakéhokoli nastavování. Pokud máte vybrán jeden objekt, zarovnají se pivoty těchto 
objektů.

1.

2.

3.

4.

5.

�

Obrázek 2.22. Zrcadlení objektu podle vybrané osy
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Spacing Tool – rozmístí jeden objekt libovolněkrát podél cesty (2D křivky). Například 
stromy (3D objekty) podél cesty (cesta = 2D křivka, kterou si vytvoříte).
Clone and Align – rozmístí jeden vybraný objekt v kopiích na místa značek (destination 
objects).
Align To View – zarovná aktuálně vybraný objekt s aktivním pohledem. Objekt se bude 
„dívat“ na vás a jako by byl nasměrován na kameru. Hodí se v případech, kdy chcete 
rychle zarovnat objekt tak, aby byl orientován směrem k vám.
Normal Align – zarovná dva objekty v místě vybraných normál (viz tip níže).
Align Camera – zarovná vybranou kameru s vybraným místem na povrchu modelu 
(normálou čelní plochy).
Place Highlight – dokáže přemístit vybrané světlo tak, abyste dosáhli požadovaného 
odlesku na objektu tam, kde je třeba (jinak řečeno sdělíte světlu, kam má svítit, a to se 
samo přesune).

Normála je vektor, který ukazuje směr, kam je orientována čelní plocha (polygon) objektu. Tím 

jsou vlastně objekty vidět. Pokud například z nějakého důvodu nevidíte v renderu nebo i v pra-

covním výřezu některý 3D objekt, může to být tím, že jsou obrácené normály (směřují dovnitř 

modelu). Jak je převrátit, najdete v kapitole o modelování (viz modifikátor Normal). Předchozí 

postupy zarovnávání si vyzkoušejte na základních objektech. V projektech je budete potřebovat 

(minimálně Spacing Tool a Clone and Align).

�

�

�

�

�

�

TIPTIP

Obrázek 2.23. Konvice zarovnaná na kávovar příkazem Align ve dvou krocích
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Dotek dvou objektů na požadovaných místech
Název této kapitoly představuje schopnosti módu zarovnání Normal Align. Nástroj Normal Align 
pro zarovnání dvou objektů na konkrétních místech obou objektů (dotek polygonu na poly-
gon) využívá právě směru normál čelních ploch. Pro zarovnání čelních ploch (polygonů) dvou 
objektů postupujte takto:

Vyberte první objekt a z hlavní nabídky Tools → Align vyberte Normal Align. Klepněte 
ve výřezu a držte levé tlačítko myši. Pohybujte se se stisknutým levým tlačítkem myši 
po povrchu prvního modelu a vyberte jeho styčnou plochu, kde se má dotýkat druhý 
objekt, puštěním levého tlačítka.
Totéž proveďte u druhého objektu. Potvrďte klepnutím na tlačítko OK. 
Zarovnali jste dva objekty na požadovaných místech.

Vytváření libovolných polí objektů
Už znáte způsob tvorby klonu objektu (kopie, instance), ale složitější by bylo vytvořit pravidel-
ně rozmístěné objekty – v poli. Pole může být lineární (např. alej stromů podél cesty), rovinná 
(např. pět řad vojáků za sebou) nebo třírozměrná (např. DNA šroubovice). Pojďme se podívat 
na tento postup a vysvětlit si rozhraní nástroje pro tvorbu pole – Array. 

Vyberte si libovolný objekt ve výřezu (např. vytvořený Box). 
Přejděte do nabídky Tools → Array. Objeví se dialogové okno jako na obrázku 2.25.
V horní polovině dialogu zadáváte, jak se má objekt posunovat (Move), otáčet (Rotate) 
nebo měnit velikost (Scale). V levém sloupci hodnot pro osy X, Y a Z (viz část 
Incremental) zadáváte offsetové hodnoty, tj. o kolik jednotek se bude objekt posunovat, 
otáčet (ve stupních) nebo měnit svou velikost (v procentech). V pravé skupině hodnot 
(viz část Totals) zadáváte, jaká bude celková hodnota velikosti pole. Tak například pokud 

1.

2.

3.

1.

2.

3.

Obrázek 2.24. Nástroj Spacing Tool zarovná a rozmístí objekty podél vybrané cesty. Určitě si 
vymyslíte mnoho případů jeho užití.
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budeme posunovat objekt o 150 cm v ose X (zadáme do pole X v části Incremental) 
a chceme celkem 10 objektů v lineárním poli, pak se automaticky vyplní hodnota pole 
X v části Totals (1 500 cm). Pokud klepnete na tlačítko Preview, uvidíte náhled pole. 
Fyzicky ho vytvoříte stisknutím tlačítka OK.

PRÁCE SE SOUBORY A SCÉNOU

Obrázek 2.25. Pomocí nástroje Array vytvoříte impresivní pole objektů, 
která byste manuálně jen stěží zvládli

transformace objektu v poli 
(Posun, otočení a změna měřítka)

výběr lineárního pole (1D), rovinného (2D) nebo 
třírozměrného (3D) s možnostmi transformací

Obrázek 2.26. Třírozměrné pole vytvoříte jednoduchým zadáním hodnot posunu v jednotlivých 
osách (osa X: lineární pole nahoře v části Incremental), 2D pole v části Array Dimensions (osa Y: 
vytvoření rovinného pole) a konečně 3D pole zadáním hodnoty dole do sloupce Z. Současně 
zadáváte počty objektů v jednotlivých dimenzích (Count).

lineární pole

1D = lineární pole
2D = rovinné pole
3D = třírozměrné pole
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Pokud tedy v lineárním poli vytvoříte 5 objektů (přepínač 1D), v rovině 3 (přepínač 2D) a ve 
3D také 3 (přepínač 3D), získáte celkem 5x3x3, tj. 45 objektů (viz pole Total in Array).

Zkuste si vytvořit klasickou šroubovici jako na obrázku 2.27. Jde o kombinaci posunutí a otočení. 

Jen je důležité si uvědomit, že střed otočení musí být mimo objekt (střed, kolem kterého se 

šroubovice vytvoří). Implicitně se totiž pivot (transformační střed) u geometrických primitiv 

vytváří ve fyzickém středu objektu (nebo v podstavě). Následující odstavec vám poradí, jak docí-

lit přesunutí středu objektu mimo něj. 

Přemístění transformačního středu objektu mimo objekt
Mnohdy potřebujete přemístit transformační střed mimo objekt. Ať už kvůli animaci nebo 
prostému vytvoření pole. Abyste mohli ovládat pivot bez ohledu na objekt, musíte s vybraným 
objektem přejít na panel Hierarchy, kde máte dvě možnosti:

Stiskem tlačítka Affect Pivot Only zapnete mód, kdy budete pohybovat pouze pivotem, 
nikoli objektem. Posuňte pivot na požadované místo a vypněte tlačítko Affect Pivot Only. 
Tento postup změní fyzickou polohu lokálního pivotu, na rozdíl od možnosti využít 
jeho tzv. pracovní verzi (viz druhý bod).
Využít tzv. Working Pivot (pracovní pivot), který je pracovní variantou oproti klasickému 
lokálnímu pivotu objektu (bod 1). Máte tedy dvě možnosti (dva pivoty), podle kterých 

1.

2.

TIP

Obrázek 2.27. Šroubovice vytvořená nástrojem Array. Jde o kombinaci dvou transformací (posunutí 
a otočení) s využitím pouze 1D (druhé rameno šroubovice bylo vytvořeno stejně jako první, pouze 
s jinou počáteční pozicí první koule). Předpokladem správného výsledku je přemístění transformač-
ního středu pivotu (gizma) koule, čehož docílíte přes panel Hierarchy → tlačítko Affect Pivot Only.
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je možné transformovat. Nastavení polohy pracovního pivotu dosáhnete stiskem tla-
čítka Edit Working Pivot a jeho přemístěním. Po umístění pivotu nezapomeňte tlačítko 
vypnout, abyste mohli zpátky posunovat objektem, nikoli pouze pivotem. Tlačítkem Use 
Working Pivot ho využijete pro účely transformací.

Pokud zapnete Use Working Pivot, přepne se současně referenční souřadnicový systém (Reference 
Coordinate System) na Working. Výhoda využití pracovního pivotu je zachování lokálního pivotu 
na jeho původní nezměněné pozici. 

PRÁCE SE SOUBORY A SCÉNOU

Obrázek 2.28. Možnosti přesunutí pivotu objektu (transformačního středu) 
nabízí panel Hierarchy

Referenční 
souřadnicový 
systém

lokální 
pivot

pracovní 
pivot
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Použití přemístěného pivotu pro transformace
Po přemístění pivotu budete určitě chtít použít tento pivot pro posunování, otáčení nebo 
změnu měřítka. V případě, že se vám nedaří zobrazit pivot správně, jak jste ho fyzicky přemís-
tili, postupujte takto:

S vybraným objektem zvolte posun nebo otočení (klávesa W nebo E). 
Ověřte, že je aktivní ikona Use Transform Coordinate Center na hlavním panelu nástrojů 
(viz vrchní ikona na obrázku 6.7). Pivot se přemístí na správné místo, kam jste pivot 
přesunuli.
Taktéž bude třeba přepnout referenční souřadnicový systém na Local nebo Working 
podle toho, který pivot chcete použít.
Nyní můžete posunovat nebo otáčet objektem kolem vámi přemístěného pivotu.

Hromadné přejmenování objektů
Když začnete tvořit a realizovat vaše představy, můžete opomenout pojmenovávat objekty už 
od začátku. Co když například vytvoříte plot se sto dvaceti plaňkami a ty jsou nazvané Box01, 
Box02, …? Naštěstí nemusíte přejmenovávat jednu po druhé. Stačí využít nástroj Tools → 
Rename Objects. Postup přejmenování je jednoduchý:

Vyberte objekty, které chcete přejmenovat (musí mít společný název lišící se maximálně 
zakončujícím číslováním – Numbered).
Do řádku Base Name zadejte název objektů.
Volitelně můžete zadat předponu (Prefix) a příponu (Suffix).
Zaškrtněte pole Numbered, pokud chcete, aby byly objekty odlišeny koncovým číslová-
ním (např. Okno01, Okno02, …).
Pro přejmenování stiskněte tlačítko Rename.

Nastavení pracovní mřížky, přichytávání objektů k mřížce i mezi sebou
Před zahájením každé práce je důležité připravit si pracovní prostředí podle vašich potřeb. 
K tomu pomůže nastavení mřížky, na které vytváříte všechny 2D i 3D objekty. Klepnutím na 
Tools → Grids and Snaps → Grid and Snap Settings se otevře stejnojmenný dialog pro zapnutí typů 
přichytávání. Když vytváříte objekty, můžete se přichytávat k následujícím typům elementů 
(karta Snaps):

Bodům mřížky (Grid Points)
Pivotu (Pivot)
Vrcholu na křivce či síťovém modelu (Vertex)
Hraně (Edge/Segment)
Čelní plošce (Face)
Spojnicím mřížky (Grid Lines)
Ohraničující krabici objektu (Bounding box)
Tečně bodu na křivce (Tangent)
Koncovému bodu křivky či hrany síťových modelů (Endpoint)
Středu křivky či hran síťových modelů (Midpoint)
Středu čelní plošky (Center Face)

1.

2.

3.

4.

1.

2.

3.

4.

5.
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Po zapnutí některého typu přichytávání společně s tlačítkem 2D nebo 3D se při zahájení tvorby 
některého objektu v pracovním výřezu ukáže modrý kurzor, který naznačuje aktivní přichytá-
vání. Pokud se začnete takto pohybovat nad dalšími objekty, budou se vyhledávat typy úchytů 
na geometrii (ke kterým se můžete přichytit). Zobrazují se jen ty,  které máte zapnuté v dialogu 
Grid and Snap Settings. 

Hlavní mřížku zapínáte a vypínáte v kterémkoli výřezu klávesou G. Přichytávání aktivujete 
klávesou S.

Měnit nastavení přichytávání „za běhu“ můžete prostřednictvím pomocného panelu nástrojů 

Snaps, který vyvoláte pravým tlačítkem myši na hlavní panel nástrojů a výběrem Snaps.

Otáčení a změna měřítka objektů v definovaných přírůstcích
Přestože se budeme transformacím včetně otáčení a změny měřítka věnovat ve třetí kapitole, 
už teď se můžete obohatit o znalost otáčení po definovaném přírůstku ve stupních (například 
po 5 stupních). Stejně tak můžete definovat procentuální hodnoty zmenšení/zvětšení objektu. 
Postup využití této funkce bude následující:

Vytvořte si libovolný objekt.
Aktivujte otáčení klávesou E. Přemístěte kurzor myši nad jednu z kružnic představující 
osu otáčení (X = červená kružnice, Y = zelená kružnice, Z = modrá kružnice a žlutá 
je aktuálně vybraná). Podržte levé tlačítko myši a pohybujte s vybranou kružnicí. 
Objektem otáčíte plynule.
Zapněte klávesu A (Angle Snap Toggle). Na obrázku 2.29 ji vidíte jako ikonu v podobě 
magnetu s vyznačeným úhloměrem. 
Otáčejte objektem a pozorujte otáčení skokově po pěti stupních.

1.

2.

3.

4.

TIP

Obrázek 2.29. Dialog Grid and Snap Settings pro nastavení typů přichytávání (úchytů). V tomto 
dialogu najdete také nastavení velikosti hlavní mřížky (karta Home Grid), upřesňující nastavení 
přichytávání včetně velikosti přichytávacích značek (karta Options → Marker → Display) nebo 
možnosti aktivace uživatelské mřížky na místo hlavní mřížky (User Grids).

PRÁCE SE SOUBORY A SCÉNOU
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Co se týká změny měřítka „skokově“, jako v případě otáčení, postupujete takto: 
Vytvořte si libovolný objekt.
Aktivujte změnu měřítka klávesou R. Přemístěte kurzor myši nad jednu z os (nebo 
vyberte změnu měřítka ve všech osách při umístění kurzoru doprostřed gizma) před-
stavující osu změny měřítka (X = červená osa, Y = zelená osa, Z = modrá osa a žlutá 
je aktuálně vybraná). Podržte levé tlačítko myši a pohybujte s vybranou osou gizma. 
Objektu plynule měníte měřítko.
Zapněte klávesu Ctrl+Shift+P (Percent Snap Toggle). Na obrázku 2.29 ji vidíte jako mag-
net s vyznačeným procentem. 
Měňte měřítko nyní a pozorujte přírůstky/úbytky velikosti po deseti stupních.

Měření vzdáleností mezi objekty
Pokud chcete měřit vzdálenosti mezi dvěma objekty, můžete to provést pomocí nástroje 
Measure Distance, který najdete taktéž v nabídce Tools. Pokud ho vyberete, stačí jen klepnout na 
první bod a pak na druhý koncový bod. Výslednou vzdálenost si můžete přečíst vlevo dole na 
stavovém panelu či okně MAXScript Mini Listener.

Seskupování objektů
Řekněme, že jste vytvořili například model kostry jako na obrázku. Obvykle takové komplexní 
objekty vytváříte z jednotlivých stavebních bloků (torzo je složeno ze žeber nebo se okno skládá 
ze skleněné tabule a rámů). Pokud ale v pokročilejší fázi práce chcete s takovými objekty mani-
pulovat najednou (například pohyb celé ruky složené z jednotlivých prstů), musíte vytvořit buď 

1.

2.

3.

4.

Obrázek 2.30. Měření vzdálenosti mezi objekty pomocí nástroje Measure Distance

MAXScript Mini Listener

Výsledek měření vzdálenosti se objeví 
na stavové liště (Status Bar)
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tzv. hierarchii (pro účely animace), kdy jeden objekt bude ovládat následující články a tyto další 
články atp., nebo jednodušeji vytvořit skupinu (Group). 

Pro vytvoření skupiny vyberte všechny objekty, které mají fungovat jako celek, a přejdě-
te do nabídky Group → Group. 
Zadejte název skupiny a stiskněte tlačítko OK.

Více o skupinách a jejich možnostech se dozvíte v sedmé kapitole „Organizace scény“.

Specializované oblasti pro konkrétní činnosti 
v rámci 3ds Max

Přizpůsobení vzhledu pracovních výřezů
Nastavení pracovních výřezů, jejich ukládání, přiřazení fotografií na pozadí výřezu, zjedno-
dušení objektů při pohybu s výřezem nebo nastavení zobrazení světel a stínů přímo ve výřezu 
(tedy nejen na vyrenderovaném snímku) provedete v hlavní nabídce Views. 
Nebo zde můžete zajistit, aby byla zachována určitá rychlost a plynulost pohybování s výřezem 
(pokud se ve scéně vyskytuje mnoho objektů, bez jejich určitého zjednodušení by byl pohyb 
ve výřezu příliš pomalý) – Adaptive Degradation. Najdete zde i nastavení pro nástroje ViewCube, 
resp. Steering Wheels, které slouží pro rychlé nastavení či návrat k požadovanému pohledu 
(čelní, horní, boční,…), resp. procházení či manipulaci výřezem. Všechny důležité postupy 
najdete ve třetí kapitole „Práce a navigace ve 3D prostoru“.

1.

2.

PRÁCE SE SOUBORY A SCÉNOU

Obrázek 2.31. Skupiny objektů pomáhají v lepší manipulaci s komplexními a souvisejícími částmi 
jednoho objektu. V tomto případě můžeme posunovat celým torzem, než abychom museli vybírat 
jednotlivá žebra.
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Tvorba 3D/2D geometrických primitiv a všech ostatních typů objektů
Pokud budete vytvářet jakýkoli typ objektu v 3ds Max, podívejte se do nabídky Create. Najdete 
zde kategorie od základních objektů, 2D tvarů, světel, kamer až po speciální deformace a síly. 
S těmito druhy se seznámíme v páté kapitole „Tvorba základních objektů“.

Změna tvaru objektů nad rámec základních parametrů, jejich modifikace
Vytvořili jste objekt, ale potřebujete ho ohnout, otočit, protáhnout, zkosit či jinak změnit jeho 
tvar? Chcete přidat texturu na objekt, ale ta je natolik komplexní, že vyžaduje speciální algo-
ritmus, který určí, jak bude na objekt namapována? Chystáte se na dráhu animátora postav 
a vytvořili jste si kostru i síťový model postavy, ale nevíte, jak je propojit? Odpověď na všechny 
tyto otázky je jedna. Použijte modifikátory. Smysl modifikátorů je změnit tvar objektu požado-
vaným způsobem. Na obrázku 2.33 vidíte ukázku aplikování modifikátoru Bend (ohnutí), který 
dokáže ohnout libovolný objekt podle vybrané osy a libovolným směrem.
Jak už jste asi poznali, tyto modifikátory, rozdělené do jednotlivých kategorií, jsou dostupné 
v nabídce Modifiers. S těmi se seznámíte v osmé kapitole „Dáváme myšlenkám tvar: Modelovací 
techniky“.

Animování
Jednoduchý název, pod nímž se skrývá mnoho zajímavých postupů, jak vdechnout objektům 
život pohybem. Animace v 3ds Max vyžaduje základní znalosti animace, které když pochopí-
te, můžete ovládnout i tak složité postupy, jako je animace postav. Všechny základní příkazy 
a nástroje pro 3D animaci najdete v nabídce Animation. Ve dvanácté kapitole věnované animaci 
se s těmito nástroji seznámíte podrobněji. Naučíte se pomocí nich animovat změny materiálů, 
pohybovat se základními i hierarchicky poskládanými objekty, ovládat dráhu kamery a stát se 
režisérem,  vytvářet přesvědčivé vizuální efekty a simulace nebo rozpohybovat postavu. 

Obrázek 2.32. Nástroje ViewCube a SteeringWheels zjednodušují navigaci v pracovním výřezu 
a orientaci ve 3D prostoru. Tyto nástroje jsou postupně integrovány i v mnoha dalších 3D návrho-
vých aplikacích od Autodesku.
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3ds Max dokáže animovat vše, na co si jen vzpomenete. Mnoho nástrojů, včetně modifikátorů 
nebo parametrů materiálů lze animovat. Mohli bychom říci, že je spíše málo oblastí, které 
nelze animovat. Další část rozhraní Maxe věnující se animaci je jeho spodní část. Tu si stručně 
zmíníme v kapitole „Přehrávání animace a animační stopa“.

Úprava animace v grafických editorech
3ds Max by nebyl plnohodnotný animační nástroj bez grafických editorů, kde můžete upravo-
vat průběh animace. Max nabízí dva pohledy na animaci: prostřednictvím klíčů (Dope Sheet) 
a křivek (Curve Editor). Ty najdete v nabídce věnované také animačním nástrojům – Graph 
Editors. Tedy editací animačních křivek nebo klíčů (pouze jiný pohled na stejná data) dosahuje-
te změn transformací či jiných vlastností objektů v čase a animaci máte jako na dlani.

Obrázek 2.33. Modifikátor Bend je jeden z mnoha, který dokáže velmi jednoduše změnit tvar 
objektu. Cílem tohoto je ohnutí objektu.

PRÁCE SE SOUBORY A SCÉNOU
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Obrázek 2.34. Nabídka Animation představuje bránu do světa 3D 
animace. Najdete zde často používané nástroje a animační ovla-
dače. Veškeré možnosti animace ale spočívají ve změně parametrů 
dostupných u objektů, materiálů i modifikátorů v čase.

Obrázek 2.35. Dope Sheet a Curve Editor jsou dva základní editory animace. Úpravou průběhu 
křivek či vlastností animačních klíčů objektů měníte průběh animace. Zvládnutím těchto editorů 
máte vynikající předpoklad stát se skutečným animátorem.
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Tyto dva klíčové editory doplňuje ještě schematický pohled na hierarchie a propojení objektů 
(Schematic View). Zde můžete prostřednictvím vizuálního editoru měnit vztahy mezi objekty, 
propojovat a vytvářet hierarchické vztahy. Uvnitř této miniaplikace si připravujete solidní 
základ pro vytvoření komplexní animace. V pracovním výřezu byste totiž z důvodu nepřehled-
nosti jen stěží dokázali propojit všechny objekty a dotáhnout animaci do finální podoby. 

Renderování, pokročilé osvětlení a efekty
Cokoli se týká výstupu vaší scény na filmové plátno (tedy zpočátku jen na pevný disk), nasta-
vení rozlišení obrazového výstupu nebo tiskové kvality (A4, A3, DPI a podobně), využijete 
hlavní nabídku Rendering. Můžete si zvolit renderovací filtr určující ostrost nebo naopak měk-
kost obrazu a vybírat si mezi vhodností výstupu pro tisk nebo video. V této nabídce najdete 
i nástroj (spíše aplikaci) Video Post, v němž si poskládáte vyrenderované sekvenční obrázky 
(zachycující pohyb v jednotlivých snímcích, anglicky „frames“) do výsledného 1 videosouboru 
(např. MOV nebo AVI).
S renderováním je úzce spojeno pokročilé osvětlení (Advanced Lighting), které zde najdete pod 
názvy Light Tracer a Radiosity. Výklad renderovacích technik, produkčního nastavení, tipů a tri-
ků najdete ve třinácté kapitole „Natočte si svůj film: Renderování aneb Výstup na libovolné 
médium“. 
Osvětlení bude předmětem deváté kapitoly. Začínající animátoři často chtějí využít efektů 
kamerové čočky, pohybového rozmlžení nebo hloubky ostrosti (hloubka zorného pole). Tyto 
možnosti najdete v nabídce Rendering → Effects. Zasazení scény do vámi zvoleného prostředí 
(např. fotografie na pozadí) umožňuje nabídka Rendering → Environment. Pokud jste fanoušci 
fotografie, určitě se ptáte, kde najdete kontrolu expozice. Odpovědí je opět nabídka Rendering 
→ Exposure Control, kterou ovládáte (spíše korigujete) světlost obrazu (příliš světlý obraz ztma-
vujete a naopak).

Obrázek 2.36. Schematický pohled podává jasný přehled o vztazích mezi objekty. Ty je totiž 
nutné nastavit, pokud vytváříte složitější animace, kdy jeden objekt ovládá několik dalších 
(například pohyb paže ovládá celou ruku).

PRÁCE SE SOUBORY A SCÉNOU
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Pokud se chcete stát součástí týmu vývojářů her, neměl by vám uniknout nástroj Render To 
Texture pro tvorbu komplexních textur, resp. jejich přípravu pro použití ve Photoshopu nebo 
jiné 2D aplikaci. Šikovnou pomůckou je též dávkové renderování (Batch Render), které využijete 
při renderování více kamer. Stačí dát do fronty seznam takových pohledů a Max se postará 
o jejich sekvenční renderování. Když může vyhotovení jednoho obrázku trvat celé hodiny 
strojového času, jistě oceníte možnost zajít si raději s přáteli za zábavou, než sedět u počítače 
a čekat na dokončení jednoho snímku, abyste mohli spustit další. 

Programování vlastních nástrojů a utilit
Máte chuť si kromě umělecko-kreativních výtvorů vyzkoušet také programování nějakých 
užitečných nástrojů pro 3ds Max v podobě skriptů? V tom případě můžete využít vestavěný 
skriptovací jazyk 3ds Max – MAXScript. Ve stejnojmenné hlavní nabídce najdete příkazy pro 
práci se skripty (otevřít, založit nový, otevřít příkazový řádek MAXScript Listener (klávesa F11)). 
Jde o velmi robustní a silnou zbraň v rukách technických výtvarníků. Pomocí skriptů můžete 

Obrázek 2.37. V nabídce Rendering najdete příkazy pro nastavení výstupního formátu 
a kvality renderování
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ovládat pohyb postav nebo vizuální efekty. Prostě neomezené možnosti. Více se o tomto jazyce 
dozvíte v patnácté kapitole.

Často opakované operace v 3ds Max
Hlavní panel nástrojů obsahuje často používané operace, které takto máte pořád na očích. 
Následující seznam přibližuje jednotlivé nástroje, které vidíte na obrázku 2.38.

Pokud používáte verzi 3ds Max 2009 a starší, bude mít nástrojový panel trochu odlišný vzhled 

od verze 2010. Ve verzi 2009 budou na prvních dvou místech ikony pro provedení kroku zpět 

(Undo) a krok vpřed (Redo). Ve verzi 2010 začíná nástrojový panel ikonou Select and Link. Příkazy 

pro krok zpět a vpřed byly umístěny na panel pro rychlý přístup doleva nad hlavní nabídku.

 1. Hierarchické propojení objektů (Select and Link) a příprava na animaci.
 2. Zrušení hierarchického vztahu (rozpojení objektů – Select and Unlink).
 3. Připojení objektu k efektům prostorových deformací (Bind to Space Warp – viz dvanáctá 

kapitola o animaci).
 4. Omezení výběru na určité kategorie objektů (Selection Filter).
 Můžete si zvolit omezení výběru na geometrické objekty (geometry), tvary (shapes), 

světla (lights), kamery (cameras), pomocné objekty (helpers), prostorové deformace 
(Warps), libovolné kombinace (combos), kosti (bone), řetězec inverzní kinematiky (IK 
chain), bod (point). 

 5. Výběr objektů. Klepnutím na objekt v pracovním výřezu ho vyberete (Select Object).
 6. Výběr objektu podle názvu (Select by Name).
 7. Typ výběrové oblasti (Selection Region). Stejná funkcionalita jako v nabídce Edit → 

Selection Region.
 8. Volba výběru obkreslením celého objektu (Window) nebo jeho dotknutím (Crossing).
 9. Posun objektu (Move).
10. Otočení objektu (Rotate).
11. Změna měřítka (Scale).

POZNÁMKA

ČASTO OPAKOVANÉ OPERACE V 3DS MAX

 1  2  3    4   5  6   7 8   9 10 11  12   13 14  15 16 17 18 19  20    21     22 23 24 25 26 27  28 29 30 31

Obrázek 2.38. Hlavní panel nástrojů nabízí 
nejčastěji používané nástroje napříč všemi 
oblastmi pracovního toku v 3ds Max

hlavní aplikační 
nabídka

lišta 
pro rychlý přístup
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12. Volba typu referenčního souřadnicového systému určující chování či orientace pivotu 
pro transformace (Reference Coordinate System). Více se o tomto příkazu dozvíte v šesté 
kapitole v části „Vybíráme způsob transformací pomocí souřadnicových systémů“.

13. Výběr pivotu (Use Pivot Point Center), který ovlivňuje transformaci objektů. Více se 
o tomto příkazu dovíte v šesté kapitole „Vybíráme způsob transformací pomocí souřad-
nicových systémů“.

14. Select and Manipulate umožní přímo ve výřezu měnit základní parametry některých 
objektů.

15. Keyboard Shortcut Override Toggle přepíná aktivní klávesové zkratky pro hlavní uživa-
telské rozhraní a módy či aplikace v 3ds Max, jako je Editable Poly nebo Material Editor. 
Stručně řečeno, klávesová zkratka pro hlavní rozhraní může mít jinou úlohu než uvnitř 
editoru materiálů.

16. Zapnutí přichytávání ve 2D/3D. Pokud na této ikoně podržíte stisknuté levé tlačítko 
myši, můžete si vybrat další typy přichytávání.

17. Otáčení objektu po přírůstcích stupňů (Angle Snap Toggle).
18. Zvětšování/zmenšování objektů po přírůstcích procent (Percent Snap Toggle).
19. Zvyšování/snižování hodnoty všech číselníků v Maxovi v daném intervalu (přírůstky 

například po jedné jednotce se projeví klepáním na šipky číselníků – Spinner Snap 
Toggle). 

20. Správa sad pojmenovaných výběrů pro organizaci objektů ve scéně (Edit Named Selection 
Sets) 

21. Pole pro zadání názvu sady pojmenovaného výběru (Named Selection Sets).
22. Zrcadlení objektů (Mirror).
23. Zarovnávání objektů (Align).
24. Správce vrstev (Layer Manager).
25. Sada nástrojů pro efektivní modelování (Graphite Modeling Tools). První načtení trvá 

trochu déle, další vypínání a zapínání je už rychlé. Pod hlavním panelem nástrojů se 
ukáže řada dalších ikon pro usnadnění práce v modelování. 

26. Editor animačních křivek (Curve Editor – viz dvanáctá kapitola).
27. Nástroj pro schematický pohled na vztahy mezi objekty (Schematic View).
28. Otevření editoru materiálů (Material Editor). Více o tomto velmi komplexním nástroji 

najdete v desáté kapitole věnované materiálům.
29. Nastavení parametrů renderování (Render Setup – viz třináctá kapitola).
30. Zobrazení naposledy renderovaného obrázku (Rendered Frame Window – viz třináctá 

kapitola).
31. Vyrenderování aktuálního výřezu bez nastavení (Render Production – viz třináctá kapito-

la).

Kategorie objektů v 3ds Max
Příkazový panel (Command Panel) je místem, kde budete nastavovat parametry objektů, měnit 
jejich tvar, animovat pohyb postav, připravovat vizuální efekty a realizovat mnoho dalších zají-
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mavých aktivit. Podívejme se, jaké úlohy zde provádíte a čeho lze dosáhnout. Tato kapitola je 
opět seznamovací, do hloubky půjdeme postupně v dalších kapitolách. 

Tvorba objektů z příkazového panelu
Vytváříte-li libovolný objekt, můžete tak učinit z hlavní nabídky Create. Druhou možností je 
stejnojmenný panel, který najdete právě na příkazovém panelu. Najdete tady sedm kategorií 
objektů, o nichž se více dozvíte v páté kapitole „Tvorba základních objektů“:

Geometry – 3D geometrické objekty, implicitně zobrazená standardní primitiva (kvádr, 
koule, válec, …)
Shapes – 2D tvary
Lights – světla
Cameras – kamery
Helpers – pomocné objekty
Space Warps – prostorové deformátory jako gravitace, exploze, víry, …
Systems – složitější systémy složené z dílčích prvků

Základní stavební 3D prvky: Geometrická primitiva
Rozvinutím rozevíracího seznamu s názvem Standard Primitives (viz obrázek 2.39) můžete vybí-
rat z dalších podkategorií geometrických primitiv. Po jejich výběru se aktualizuje rozbalovací 
nabídka Object Type, kde se objeví aktuálně dostupné typy objektů. Stačí jen klepnout na tla-
čítko s názvem objektu a vytvořit ho v pracovním výřezu. Blíže si dostupné objekty přiblížíme 
v páté kapitole „Tvorba základních objektů“.

Kreslení křivek a tvorba 2D tvarů
Klepnutím na tlačítko libovolného 2D tvaru jste připraveni ho vytvořit v pracovním prostředí. 
Ze základních tvarů, jako je křivka (Line), obdélník (Rectangle), kružnice (Circle) nebo napří-

�

�

�

�

�

�

�

Obrázek 2.39. Příkazový panel je centrálním místem pro tvorbu a modifikaci 
objektů. Cokoli chcete provést s libovolným objektem, měli byste se poohlédnout 
právě sem. V druhé řadě ikon najdete sedm objektových kategorií.

KATEGORIE OBJEKTŮ V 3DS MAX
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klad text (Text), můžete později vytvořit i komplexní 3D tvary. Tyto postupy nám odhalí osmá 
kapitola, kde si ukážeme rozsáhlé možnosti tzv. modifikátorů. 

Světla
Jak vidíte na obrázku 2.41, světla představují třetí kategorii na příkazovém panelu Create. 
Implicitní volba nabízí tři typy světel, ale to jen v rámci fotometrických světel (vysvětlení najde-
te v deváté kapitole). Světla vytváříte i přemísťujete jako všechny ostatní objekty.

Obrázek 2.40. Základní 2D tvary stejně jako 3D primitiva vám poskytují 
základní stavební kameny pro tvorbu složitějších objektů

Obrázek 2.41. 3ds Max si světla uchovává ve dvou skupinách – standardní 
a fotometrická. Obě podkategorie jsou přístupné z rozevíracího seznamu 
s názvem Photometric. 
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Kamery
Standardně se v pracovním výřezu na objekty nedíváte skrze objektiv kamery, ale prostřed-
nictvím klasického perspektivního pohledu. Pokud byste chtěli vytvářet „kamerová kouzla“, 
musíte kameru nejprve vytvořit a aktivovat ji. Jedenáctá kapitola vám pomůže tato tajemství 
odhalit.

Pomocné objekty
Dozajista se během své práce v 3ds Max setkáte s činnostmi, které budou vyžadovat vhodné 
pomocníky. Těmi mám na mysli například úhloměr, měřicí pásku, bod umístitelný na přesné 
místo ve 3D prostoru nebo kompas. V 3ds Max se takové objekty označují příznačným názvem 
Helpers. Při tvorbě složitějších struktur (například postavy) oceníte možností tzv. Dummy objek-
tů, které mohou ovládat celé hierarchie dalších objektů. Většinou se postavy animují právě 
pomocí těchto pomocných objektů. Tuto specifickou kategorii si přiblížíme v páté kapitole. 

Prostorové deformace jako základ vizuálních efektů
Rádi byste napodobili tornáda, vítr, gravitaci, víry, exploze, různé tlakové síly včetně motoru 
nebo odporu vzduchu a nespočet dalších? Pak si zapamatujte tuto kategorii pojmenovanou 
Space Warps. Když klepnete na rozevírací seznam Forces (síly), objeví se další podkategorie 
deformací, pomocí nichž působíte na další objekty. Prostorové deformátory nejsou obdobně 
jako pomocné objekty renderovatelné (neuvidíte je na výsledném obrázku), ale příkazem Bind 
to Space Warp je můžete připojit k těm objektům, na které mají působit. Deformátory se často 
propojují s částicovými systémy (Particles). Více prostoru jim budu věnovat ve dvanácté kapi-
tole. 

KATEGORIE OBJEKTŮ V 3DS MAX

Obrázek 2.42. Kamery jsou v 3ds Max dvojího druhu. 
Jedna je bez cíle a druhá s cílem. Smysl jejich existence si 
vysvětlíme v kapitole o kamerách.

Obrázek 2.43. Pomocné objekty vám pomohou v mnoha 
činnostech. Od přesného měření vzdáleností či úhlů až po ani-
maci.
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Tvorba kostí, lidí a denního osvětlení
Denní osvětlení, kosti i lidi mají i přes svá specifika a odlišnosti něco společného. Jedná se 
o složeniny dílčích objektů, které mají ve finále komplexnější podobu. 

Změna parametrů vytvořeného objektu
Vždy po vytvoření objektu (z panelu Create nebo stejnojmenné nabídky) ho můžete parame-
tricky upřesnit, doladit a nastavit jeho parametry zadáním přesných hodnot. To provádíte na 
panelu Modify („modifikační panel“). Následující postup si zapamatujte: 

Objekt vytvoříte tak, že na panelu Create vyberete kategorii objektu a konkrétní objekt.
V pracovním výřezu vytvořte objekt pouze přibližně tažením myši. 
Přejděte na modifikační panel (viz obrázek 2.46).
Upřesněte parametry objektu podle potřeby.

Každý objekt má své specifické parametry, které můžete nastavovat. Více se o tomto postupu 
dozvíte v páté kapitole o tvorbě základních objektů.

Tvorba hierarchií pro účely animace
Na příkazovém panelu najdete také dílčí panel věnující se podpůrným animačním nástrojům 
a postupům. Je jím panel Hierarchy. Pokud chcete definovat vztahy mezi objekty (propojení) 
a pravidla pohybu objektů v rámci hierarchií, kdy potomek ovládá rodiče (tzv. inverzní kine-

1.

2.

3.

4.

Obrázek 2.44. Prostorové deformace (Space Warps) jsou 
zvláštní kategorií objektů, jejichž úlohou je působit na 
ostatní geometrické objekty určitou silou či deformací

Obrázek 2.45. Poslední kategorie objektů – Systems – obsa-
huje pokročilejší objekty složené z některých základních. Pro 
osvětlení například využijete denní osvětlení Daylight, které 
se skládá ze slunečního světla a nebeské klenby.
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matika), učiníte to na tomto panelu (viz obrázek 2.47). Zde také definujete, které objekty se 
smí či nesmí pohybovat, otáčet či měnit měřítko podle os X, Y nebo Z (jednoduše zamknete 
transformace objektu podle vybraných os). 
Zákaz posunu objektu podle osy vystihuje následující postup:

Vytvořte objekt a nastavte mu požadované parametry.
Vyberte ho a přejděte na panel Hierarchy → tlačítko Link Info.
Zapněte pole Move → Z. Tím jste zakázali pohybu objektu v ose Z. Stejně tak můžete 
omezit i otočení a změnu měřítka. 

Další vlastnosti si popíšeme ve dvanácté kapitole o animaci.

Ovládání a úprava pohybu objektů
Pokud zanimujete jakýkoli objekt a bude třeba jeho trajektorii pohybu (či tzv. ovladače pohybu 
– controllers) nějak upravit, můžete to provést na panelu Motion. Ten je speciálně navržen k při-
řazování animačních ovladačů jednotlivým stopám (posun, otočení a změna měřítka). Můžete 
tady také vytvářet animační klíče a vybírat typy přechodů od jednoho klíče k druhému (rychlý 
pohyb, pomalý, lineární a podobně).

1.

2.

3.

KATEGORIE OBJEKTŮ V 3DS MAX

Obrázek 2.46. Modifikační panel je místo, kde nastavujete parametry objektů a přetváříte je tak 
do požadované podoby
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Vlastnosti zobrazení vytvářených objektů
Po vytvoření objektu můžete provádět mnoho úprav v souvislosti se zobrazením daného objek-
tu v pracovním výřezu. Mezi ně patří skrývání objektů, průhlednost, mrazení, skrývání určitých 
kategorií objektů. Hodně těchto příkazů je také přístupných v dialogu vlastností objektu (Object 
Properties). Tyto a další možnosti najdete na panelu Display, který vidíte na obrázku 2.49.

Obrázek 2.47. Na panelu Hierarchy můžete definovat umístění pivotu objektu (tlačítko Pivot), 
nastavovat principy animace pomocí inverzní kinematiky (IK) nebo zakazovat objektům transfor-
mace podle vybraných os (Link Info)

Obrázek 2.48. Panel 
Motion využijete 
jako animátoři, a to 
zejména při úpravách 
pohybu objektů či 
přiřazení konkrétních 
ovladačů, které mají 
na starost způsob či 
specifické omezení 
chování animovaných 
objektů
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Pomocné nástroje pro různé činnosti v 3ds Max
Když nenajdete některý příkaz ve standardní nabídce Maxe nebo hledáte pomůcku, která by 
urychlila nebo usnadnila určitou činnost, měli byste se podívat na panel Utilities. Tady najde-
te mnoho nástrojů pro práci s materiály, kamerami, soubory, scénami a další. Více o těchto 
nástrojích se dozvíte v příslušných kapitolách.

Přehrávání animace a animační stopa 
Pokud se budete věnovat animaci, podívejte se na spodní část uživatelského rozhraní. Až něco 
zanimujete, objeví se vám na animační stopě klíče, které zaznamenávají pohyb, otočení, změnu 
měřítka nebo jakoukoli jinou operaci, již lze zaznamenat jako animovanou změnu. Tato stopa 
představuje zjednodušenou alternativu ke komplexnějším animačně-editačním nástrojům, 
jako je Curve Editor nebo Dope Sheet. Klíče zde můžete přímo editovat, posunovat v čase a upra-
vovat tak průběh animace.

KATEGORIE OBJEKTŮ V 3DS MAX

Obrázek 2.49. Na panelu Display nastavujete 
vlastnosti zobrazení objektu v pracovním výřezu 
včetně skrývání, mrazení, průhlednosti nebo 
barvy objektu

Obrázek 2.50. Panel Utilities nabízí pomocné 
nástroje k nejrůznějším aktivitám včetně souboro-
vých, animačních nebo materiálových operací 
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Navigace v pracovních výřezech
Efektivní navigace v pracovních výřezech je jedna z nejdůležitějších činností ovlivňujících vaši 
produktivitu a především přesnost. Proč přesnost? Když si nedokážete prohlédnout model ze 
všech stran, může se vám lehce stát, že přehlédnete chybu (například vyčnívající vrchol, chybě-
jící polygon a podobně). Zde je na místě vám dát jednu velmi důležitou radu:
Během modelování si prohlížejte model pečlivě, přibližujte se, otáčejte se, sledujte, zda polygo-
ny na sebe navazují správně. Prostě snižte na minimum riziko chyby tím, že provedete inspekci 
svého výtvoru velmi důsledně.
Obrázek 2.52 ukazuje rozhraní Maxe pro navigaci ve výřezech.

Přizpůsobení uživatelského rozhraní
V této části se podíváme na možnosti, které vám rozhraní Maxe nabízí v souvislosti s jeho 
přizpůsobením. Stejně jako platí, že si před jakoukoli činností uzpůsobíte své okolí, aby se vám 
pracovalo dobře, to samé je v 3ds Max. Jinak si prostředí nastavíte pro oblast modelování, jinak 
pro osvětlení, renderování, či texturování. Jinými slovy, každý potřebuje mít pro svou každo-
denní práci na očích jiné příkazy.

Využití klávesových zkratek
První možnost, jak si uzpůsobit prostředí Maxe, je přiřadit si svým oblíbeným příkazům klá-
vesové zkratky. To provedete následovně:

Klávesové zkratky nastavujete v nabídce Customize → Customize User Interface → karta 
Keyboard. Dialog Customize User Interface vidíte na obrázku 2.53. 
Na kartě Keyboard vidíte rozevírací seznam Group, který seskupuje funkčně příbuzné 
příkazy. Stačí si vybrat, kterou skupinu funkcí si chcete přizpůsobit, vybrat si v seznamu 
funkci a do pole Hotkey zapsat klávesovou zkratku. 

1.

2.

Obrázek 2.51. Animační stopa (track bar) zaznamenává animační klíče objektů. Je to držitel histo-
rie uložených pohybů, rotací, změny měřítka nebo editovatelných parametrů.

Obrázek 2.52. Navigace ve výřezech vám umožní odhalovat chyby na modelech. Čím pečlivěji 
budete přistupovat k prohlížení modelu, tím více chyb odhalíte a váš model dozná na kvalitě.
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V poli Assigned To se objeví slovo Unassigned v případě, že je klávesa volná, anebo název 
příkazu, kterému je již tato klávesa přiřazená a můžete ji přepsat nebo zapsat jinou. 

Přidání nového panelu nástrojů
Pokud klepnete pravým tlačítkem myši kamkoli na hlavní panel nástrojů, objeví se nabídka 
s možnostmi zapínání a vypínání plovoucích panelů. Najdete zde například panel pro správu 
vrstev (Layers), nástroje pro simulaci dynamických efektů (reactor), animační vrstvy (Animation 
Layers) a další. Na obrázku 2.54 vidíte všechny tyto panely. Co když si chcete vytvořit takový 
vlastní panel a přidat si sem své oblíbené nástroje? 

V nabídce Customize → Customize User Interface → karta Toolbars klepněte na tlačítko New.
Zadejte název svého nového panelu a stiskněte tlačítko OK. 
Objeví se nový panel, kam můžete z dialogu Customize User Interface přetahovat metodou 
drag-and-drop dostupné příkazy. Můžete si sem přidávat i nově instalované plug-iny 
nebo skripty (viz čtvrtá kapitola „Výměnné formáty, vstupy z externích aplikací, spouš-
tění skriptů a plug-inů“).

3.

1.

2.

3.

Obrázek 2.53. Dialog Customize User Interface pro nastavení klávesových zkratek, přidání nástrojo-
vých panelů, upravení čtyřnásobné nabídky a hlavní nabídky nebo změny barev prostředí 3ds Max

PŘIZPŮSOBENÍ UŽIVATELSKÉHO ROZHRANÍ
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Změna vzhledu ikony vybraného nástroje
Nelíbí se vám standardní ikona vašeho oblíbeného nástroje? Nebo ještě lépe, vytvořili jste si 
svůj vlastní plug-in nebo skript a rádi byste mu přiřadili nějakou ikonu? Pak postupujte takto:

Vytvořte si ve svém oblíbeném 2D grafickém editoru dvě ikony (pro jeden příkaz). 
První, větší, bude mít rozměry 24x24 pixelů. Pak tu samou ikonu jako její menší verzi 
uložte o velikosti 16x15 pixelů.
Nahrajte tyto ikony do složky C:\Program Files\Autodesk\3ds Max 2010\UI\Icons\ 
v případě standardní instalace. Pokud máte Maxe na jiné cestě, nahrajte ikony tam.
Restartujte Maxe.
Otevřete si svůj nástrojový panel nebo již některý standardně dodávaný (například 
Extras nebo Brush Presets).
Klepněte na již přidaný příkaz (musí zde nějaký být) pravým tlačítkem myši a vyberte 
příkaz Edit Button Appearance. Otevře se vám dialogové okno Edit Macro Button, kde si 
můžete z rozevíracího seznamu Image Button → Group vybrat vámi uloženou ikonu 
a přiřadit ji tak svému příkazu.
Stiskněte tlačítko OK.

1.

2.

3.

4.

5.

6.

Obrázek 2.54. Mezi standardními nástrojovými panely může být i ten váš. Stačí si ho vytvořit 
v dialogovém okně Customize User Interface.

Obrázek 2.55. Možnost přiřazení vlastní ikony vybranému příkazu. 3ds Max je 
velmi flexibilní systém co se týče přizpůsobení uživatelského rozhraní.
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Přizpůsobení čtyřnásobné nabídky podle vlastní potřeby
Čtyřnásobná nabídka je kontextově závislá nabídka, kterou vyvoláte klepnutím pravým tla-
čítkem myši s vybraným objektem. Podle rozpoznaného typu objektu (3D, 2D, světlo, …) se 
v nabídce objeví specifické příkazy. Velmi výhodné je zapamatovat si kombinaci klávesových 
zkratek, které přistupují ke konkrétním tematicky zaměřeným skupinám příkazů (viz dále tip 
v této kapitole).
Až budete pracovat se čtyřnásobnou nabídkou, tzv. quad menu (a to především během mode-
lování), budete možná často a opakovaně využívat některé příkazy, které na ní nejsou dostup-
né. Abyste si zjednodušili život a zrychlili práci, uvítáte možnost je sem přidat. Obrázek 2.56 
ukazuje přizpůsobenou čtyřnásobnou nabídku – přidal jsem modifikátor Edit Poly do pravého 
dolního kvadrantu. 
Následující postup ukáže, jak na to:

Otevřete nabídku Customize → Customize User Interface → karta Quads

Vpravo otevřete seznam, kde je aktuálně vybráno Default Viewport Quad.

Vyberte typ nabídky, kterou si chcete přizpůsobit.
Přetáhněte příkaz z levého sloupce (můžete filtrovat přes kategorie příkazů – Category) 
do pravého dolního okna v dialogu Customize User Interface.

Zobrazí se oddělovač (horizontální čára ukazující, kam příkaz vkládáte). Až budete 
spokojeni s jeho pozicí v rámci nabídky, pusťte levé tlačítko myši.
Nabídku si můžete uložit klepnutím na tlačítko Save. Soubor bude mít koncovku MNU.

Můžete si přizpůsobit také barvy, průhlednost, fonty nebo typ animovaného přechodu při jejím 
vyvolání. Tyto možnosti si nastavujete klepnutím na tlačítko Advanced Options.

1.

2.

3.

4.

5.

6.

Obrázek 2.56. Přizpůsobená čtyřnásobná nabídka. Pokud zjistíte, že neustále při dané činnosti 
musíte aktivovat některou funkci přes vícero nabídek, je čas na přidání tohoto příkazu do rychle 
přístupné čtyřnásobné nabídky

PŘIZPŮSOBENÍ UŽIVATELSKÉHO ROZHRANÍ
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Čtyřnásobná nabídka je kontextově závislá. 

Pokud stisknete Ctrl+pravé tlačítko myši, vyvoláte modelovací čtyřnásobnou nabídku.

Pokud stisknete Alt+ pravé tlačítko myši, vyvoláte animační čtyřnásobnou nabídku.

Pokud stisknete Ctrl+Alt+ pravé tlačítko myši, vyvoláte osvětlovací/renderovací čtyřnásob-

nou nabídku.

Pokud stisknete Shift+pravé tlačítko myši, vyvoláte čtyřnásobnou nabídku s možnostmi 

přichytávání.

Pokud stisknete Shift+Ctrl+ pravé tlačítko myši, vyvoláte svou vlastní čtyřnásobnou nabídku, 

která je implicitně prázdná. Proto si musíte tuto nabídku nejprve sestavit, aby se vám v pra-

covním prostředí zobrazila.

Přidání vlastní hlavní nabídky
Položky hlavní nabídky můžete přidat z dialogu Customize → Customize User Interface → karta 
Menus. Postup je obdobný jako v případě panelu nástrojů. Vytvořte si novou nabídku stiskem 
tlačítka New a přetažením příkazu zleva doprava ji naplňte. Můžete také naplnit stávající nabíd-
ku novým příkazem (tedy nemusíte vytvářet novou nabídku). Nabídku si můžete uložit stiskem 
tlačítka Save.

�

�

�

�

�

TIP

Obrázek 2.57. Čtyřnásobnou nabídku si přizpůsobíte v nabídce 
Customize → Customize User Interface → karta Quads
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Změny barev pracovního prostředí 3ds Max
Pro tento úkon postupujte následovně: 

Vyvolejte nabídku Customize → Customize User Interface → karta Colors. 
V horní části vlevo máte na výběr elementy, jimž můžete změnit barvu (Elements – uce-
lené bloky funkcí jako je Track View, animační stopa Track Bar nebo elementy pracovních 
výřezů Viewports, kde můžete změnit například barvu pozadí pracovních výřezů příka-
zem Viewport Background). Stačí vybrat položku v seznamu a pak klepnout na barevný 
vzorek vpravo nahoře. Vyberte barvu klepnutím dovnitř barevného spektra a doladě-
ním hodnot Whiteness a Blackness bílými trojúhelníky (jezdci) přiřaďte konečný odstín.
V dolní části Scheme → Custom Colors můžete měnit přímo barvy prvků uživatelského 
rozhraní (například barva tlačítka Auto Key pro animaci nebo pozadí všech dialogů 
příkazem Background).

1.

2.

3.

Obrázek 2.58. Změna barev pro-
středí 3ds Max. Máte zde k dispo-
zici téměř každou část uživatelské-
ho rozhraní, které můžete změnit 
barvu n. Nástroj pro výběr barvy 
Color Selector vás bude doprová-
zet vždy, když budete chtít změnit 
barvu, a to nejen uživatelského 
rozhraní o, ale i 3D objektům.

n

o

PŘIZPŮSOBENÍ UŽIVATELSKÉHO ROZHRANÍ
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Uložení a načítání uživatelského rozhraní
Všechny předchozí postupy, které vedly k přizpůsobení určitých částí 3ds Max, lze uložit či 
načíst najednou. Pokud chcete uložit kompletní uživatelské rozhraní Maxe, proveďte následu-
jící kroky:

Přejděte do hlavní nabídky Customize → Save Custom UI Scheme.

Vyberte, které části rozhraní chcete uložit (rozvržení rozhraní (.ui), klávesové zkratky 
(.kbd), hlavní nabídky (.mnu), čtyřnásobnou nabídku (.qop) a barvy (.clr) – viz postup-
ně možnosti shora na obrázku 2.59.

Pokud chcete nějaké nastavení rozhraní načíst, učiníte to z nabídky Customize → Load Custom 
UI Scheme. Na zkoušku si můžete načíst nastavení dodávaná v základní instalační sadě 3ds Max, 
která při standardní instalaci najdete ve složce C:\Program Files\Autodesk\3ds Max 2010\UI\. 
Jejich složení je následující:

DefaultUI: Standardní rozhraní, které se načítá po instalaci.
Ame-dark: Standardní rozhraní s tmavým pozadím dialogů i výřezů.
Ame-light: Stejné rozhraní jako Ame-dark, avšak ve světle šedém hávu.
ModularToolbarsUI: Modulární rozhraní, v němž si můžete přeuspořádat i části hlavní-
ho panelu nástrojů podle svého gusta včetně dalších dílčích nástrojových panelů. Toto 
rozhraní vidíte na obrázku 2.60.

Pokud budete mít v dialogu Preferences → General panel zapnuté pole Save UI Configuration On 

Exit, bude se vám při každém opuštění Maxe ukládat aktuálně rozvržené uživatelské rozhraní.

Návrat uživatelského rozhraní k původnímu rozvržení
Jestliže jste si rozhraní přeuspořádali ne zrovna podle svých představ a cesta zpět je trnitá, mám 
pro vás dobrou zprávu. Příkaz Customize → Revert to Startup Layout provede návrat uživatelské-
ho rozhraní k počátečnímu nastavení.

1.

2.

�

�

�

�

TIP

Obrázek 2.59. Při uložení uživatelského rozhraní máte na výběr 
uchovat si všechny nebo jen některé komponenty
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Uzamčení aktuálního rozvržení uživatelského rozhraní
Když jste spokojeni s nastavením aktuálně rozvrženého uživatelského rozhraní, můžete si ho 
uzamknout, abyste nemohli například omylem přesunout nástrojový panel na nežádoucí místo. 
Rozvržení rozhraní uzamknete příkazem Customize → Lock UI Layout.

Předdefinovaná nastavení rozhraní pro konkrétní typ 
práce (animace nebo vizualizace)
3ds Max nabízí čtyři sady s předdefinovanými parametry prostředí (nazvané Max, Max.men-
talray, DesignVIZ a DesignVIZ.mentalray – viz nabídka Customize → Customize UI And Defaults 
Switcher) pro konkrétní projektové činnosti (obecné a vizualizace). To se například projevuje 
v implicitně zapnutých nebo vypnutých stínech včetně vybraných typů stínů (pro animaci se 
hodí jiné typy stínů než pro detailní architektonické vizualizace), vybraného rendereru (scan-
line nebo mental ray) či v typu implicitního materiálu v editoru materiálů (např. Standard 
nebo Arch & Design). Každá sada má pak takto individuálně nastavené všechny parametry 
ve vlastním souboru CurrentDefaults.ini, který najdete pro každou sadu ve složce C:\Program 
Files\Autodesk\3ds Max 2009\Defaults\název sady\FactoryDefaults\. Sada se načítá při každém 
spuštění Maxe jako implicitní.
Nastavení aktuálně aktivní sady najdete ve Windows Vista ve složce C:\Users\VašeJméno.
Doména\AppData\Local\Autodesk\3dsmax\2010 – 32bit\enu\defaults. Ve Windows XP najde-
te tentýž aktivní soubor ve složce C:\Documents and Settings\VašeJméno\Local Settings\Data 
Aplikací\Autodesk\3dsmax\2010 – 32bit\enu\defaults. 

Obrázek 2.60. Kromě standardního rozhraní si můžete načíst předpřipravené modulárně konci-
pované uživatelské rozhraní, které vám dovolí uspořádat si i dílčí části hlavního panelu nástrojů

PŘIZPŮSOBENÍ UŽIVATELSKÉHO ROZHRANÍ
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Ve Windows Vista se po výběru jedné ze sad její aktuální nastavení přenese do složky C:\Users\
VašeJméno.Doména\AppData\Local\Autodesk\3dsmax\2010 – 32bit\enu\defaults\vybraná sa-
da. Proto pokud chcete editovat soubor CurrentDefaults.ini a nastavit si jinak vlastnosti určitých 

parametrů, než je tomu v tomto souboru, upravujte ho zde, a nikoli na původní cestě instalace 

3ds Max (C:\Program Files\Autodesk\3ds Max 2010\Defaults\název sady\FactoryDefaults).

Pokud byste si chtěli vybrat konkrétní styl práce, stačí si v dialogu Choose initial settings for tool 
options and UI layout vybrat vlevo konkrétní sadu a vpravo schéma uživatelského rozhraní, které 
budete využívat. Pak klepněte na tlačítko Set a restartujte Maxe.

Pokud pracujete ve Windows Vista, může se vám při opouštění Maxe objevit varovné hlášení, že 

nemáte přístup k dané složce Defaults. Přiřaďte jí tedy vaše oprávnění k zápisu. 

POZNÁMKA

POZNÁMKA

Obrázek 2.61. Přepínač mezi sadami přednastavených parametrů v 3ds Max pro konkrétní typ 
práce. Pokud se chystáte na dráhu profesionální 3D vizualizace, vyberte si například nastavení 
Max.mentalray.
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Přístupové cesty ke zdrojům scény
Když si spustíte scénu, kterou vám dal kolega, a navíc k ní přidal několik textur, může se vám 
stát, že se ke scéně textury správně nepřipojí a při otevření scény se objeví varování Missing 
External Files. Současně se zobrazí cesta, kde 3ds Max texturu postrádá. Abyste ji správně načetli, 
můžete ji nahrát sem. Při větším množství adresářů byste si ale u sebe na disku vytvořili spíše 
nepořádek. Druhou možností je nahrát texturu do složky, kde Max textury přímo hledá, takže 
na ni při načítání scény „narazí“. Cesty k takovým souborům nastavujete v nabídce Customize 
→ Configure User Paths, jak vidíte na obrázku 2.62. Tento dialog má tři karty, kde si cesty definu-
jete. První z nich je I/O (zachycuje cesty k vstupně výstupním souborům), kde si přímo nahoře 
můžete změnit cestu k projektové složce (totéž můžete provést z hlavní aplikační nabídky 3ds 
Max → Manage → Set Project Folder nebo panelu pro rychlý přístup – viz obrázek 2.38 o). 
Další cesty určují přístup k animacím, archivům, exportovaným a importovaným souborům, 
náhledům, renderovaným výstupům, vlastním scénám, zvukům a dalším.
Karta External Files obsahuje cesty k zejména k mapám. Tedy pokud nebude Max při startu moci 
najít nějaký soubor, nahrajte ho sem (např. C:\Program Files\Autodesk\3ds Max 2010\Maps). 
Karta XRef zobrazuje cestu k externě odkazovaným souborům (viz obrázek 2.5).

Změna cesty k souborům
Vyberte cestu, kterou chcete změnit.
Klepněte na tlačítko Modify.

Vyberte novou cestu a potvrďte klepnutím na tlačítko Use Path.

Přidání nové cesty k souborům
Přejděte na kartu External Files.
Klepněte na tlačítko Add.
Vyberte novou cestu a potvrďte klepnutím na tlačítko Use Path.

1.

2.

3.

1.

2.

3.

Obrázek 2.62. 
Konfigurace 
uživatelských cest 
umožňuje uživa-
teli nastavit, kde 
bude Max hledat 
různé zdrojové 
soubory
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Systémové cesty k některým souborům nastavujete přes hlavní nabídku Customize → Configure 
System Paths (jde zejména o ikony, makra nebo dočasné soubory uložené na cestě C:\Users\
VašeJméno.Doména\AppData\Local\Autodesk\3dsmax\2010 – 32bit\enu\UI).

Měrné jednotky
Ještě před započetím prací na projektu je vhodné nastavit měrné jednotky. To provedete takto:

Přejděte do hlavní nabídky Customize → Units Setup.

V dialogu Units Setup vyberte v rozevírací nabídce Metric požadované jednotky. Tím jste 
nastavili pouze jednotky zobrazení v pracovním výřezu. Můžete si vybrat také bezroz-
měrné jednotky (Generic Units). 
Nyní musíte nastavit jednotky, v nichž bude Max interně skutečně počítat. Jde o systé-
mové jednotky. Klepnutím na tlačítko System Unit Setup se otevře stejnojmenný dialog, 
kde můžete nastavit měřítko scény. Zde definujete, kolik skutečných jednotek odpovídá 
1 jednotce (např. 1 Unit = 1 cm). 
Zapnuté pole Respect System Units in Files způsobí, že při každém otevření souboru, který 
obsahuje jiné jednotky, než jaké jsou aktuálně nastavené v 3ds Max, se objeví dialog 
s otázkou, zda se mají respektovat jednotky obsažené v tomto souboru. Pokud je zde 
pole vypnuté, budou se jednotky nastavené v otevíraném souboru automaticky konver-
tovat na jednotky nastavené v 3ds Max. 

Ujistěte se, že objekty vytváříte blízko středu (světového počátku – Origin, tedy souřadnic 0,0,0). 

Jakmile bude váš objekt příliš daleko od středu souřadnicového systému, může se stát, že se 

vám s ním bude špatně pohybovat. Čím dále od středu objekt je, tím menší je přesnost mani-

pulace s ním. Zkuste si do pole Distance From Origin zadat největší možnou hodnotu určující 

vzdálenost od středu, v jaké bude některý objekt ležet. Pole Resulting Accuracy vám pak ukáže, 

s jakou přesností budete moci s objektem manipulovat. 

1.

2.

3.

4.

TIP

n

o

Obrázek 2.63. Dialogové okno pro nastavení měrných 
jednotek vás bude doprovázet před každým zahájením 
projektu. Nastavujte jednotky zobrazení v pracovním 
výřezu n a systémové jednotky, podle nichž Max 
interně počítá o.
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Neshoda měrných jednotek při načítání scény
Před otevřením scény Max kontroluje, jaké jsou jednotky v otevíraném souboru ve srovnání 
s aktuálně otevřenou scénou. Pokud se shodují a jednotky jsou „nadimenzovány“ stejně, pak 
se tento dialog neobjeví. Pokud ale dojde ke zjištění rozdílných jednotek, objeví se dialog File 
Load: Units Mismatch (viz obrázek 2.64) a vy máte na výběr:

Vybrat si jako primární jednotky obsažené v právě otevíraném souboru (příchozí). Pak 
si vyberte druhou možnost (Adopt the File´s Unit Scale).
Pokud chcete naopak konvertovat jednotky příchozího souboru do primárních systé-
mových jednotek nastavených v aktuální scéně, pak vyberte první možnost (Rescale the 
File Objects to the System Unit Scale). Změnou jednotek se mění i velikost objektů. Přibližte 
se nebo se vzdalte ve výřezu kolečkem myši, abyste objekt(y) viděli.

Změna jednotek v aktuálně otevřené scéně
Není katastrofou, pokud zjistíte během práce nebo v otevřeném souboru, že máte chybně 
nastavené měrné jednotky. Ke změně měřítka použijte nástroj Rescale World Units, který je 
dostupný na panelu Utilities, o němž jsme hovořili v souvislosti s příkazovým panelem. Postup 
změny měřítka je následující:

Přejděte na panel Utilites.

Klepněte na tlačítko More.

Otevře se seznam s dostupnými nástroji pro různé činnosti v rámci 3ds Max.
Vyberte nástroj Rescale World Units.

Dole na panelu Utilities se objeví tlačítko Rescale. Klepněte na něj.
Objeví se dialog Rescale World Units, kde můžete do pole Scale Factor zadat hodnotu 
změny měřítka. Pokud sem například zadáte hodnotu 2, pak krychle s původním roz-
měrem hrany 10 cm bude mít 20 cm. Stejně tak pokud zadáte hodnotu 0.5, změní se 
délka hrany krychle na 5 cm z původních 10 cm.
Můžete si také vybrat, zda chcete změnit měřítko pouze pro vybrané objekty (Selection), 
nebo pro celou scénu (Scene).

�

�

1.

2.

3.

4.

5.

6.

7.

Obrázek 2.64. Během otevírání nového souboru si dejte pozor na to, 
které jednotky považujete za primární. Buď ty v příchozím otevíraném 
souboru, nebo jednotky aktuálně nastavené scéně.
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Předvolby pro různé nástroje 3ds Max
Chová se některý nástroj ne zcela podle vašich představ? Rádi byste mu změnili chování, napří-
klad nějaký postup či hodnotu? Pak požadovaný parametr najdete nejspíše v hlavní nabídce 
Customize → Preferences.

Dialog nabízí spoustu možností rozdělených do několika karet sdružujících funkce z různých 
oblastí Maxe (mental ray, renderování, animace, radiozita v osvětlení, nastavení vlastností 
gizma, MAXScript, kontrast a gamma korekce a další). Zde si uvedeme tipy na usnadnění 
práce související výhradně s uživatelským rozhraním a obecnými postupy (karta General, Files 
a Gamma and LUT). Ostatní přizpůsobení funkcí najdete v příslušných kapitolách.

Obrázek 2.65. Šikovný nástroj Rescale World Units dokáže změnit měřítko rozpracované scény. 
Stačí zadat faktor měřítka (Scale Factor) a vaše scéna se může rázem zvětšit nebo zmenšit.

Obrázek 2.66. Dialog Preferences vám dovolí změnit chování některých nástrojů a postupů v 3ds 
Max. Pokud si chcete přizpůsobit některý nástroj či funkci, najdete to nespíše v tomto dialogu.
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Zvýšení počtu kroků zpět
Na kartě General v části Scene Undo → Levels můžete zvýšit počet kroků, které budete moci 
učinit zpět, když se vám nebude dařit v práci. Znamená to, kolikrát můžete klepnout na hlavní 
nabídku Edit → Undo nebo na šipku Zpět na panelu rychlého přístupu.

Nastavení hodnoty přírůstků číselníků
Když klepete na šipku číselníku, můžete nastavit hodnotu jednoho přírůstku. Učiníte tak na 
kartě General v části Spinners → Snap. Zadejte sem požadovanou hodnotu přírůstku/úbytku 
číselníku a zapněte pole Use Snap. Parametrem Decimals definujete počet desetinných míst 
v polích číselníků

Velikost kurzoru pro výběrový typ Paint Selection
Při detailním výběru polygonů pomocí metody kreslení po modelu je vhodné měnit velikost 
kurzoru štětce. Tu nastavíte na kartě General → část Scene Selection → Paint Selection Brush Size. 

Zde mimochodem také nastavujete, jakým způsobem vybíráte objekty, táhnete-li s myší zprava 

doleva nebo naopak. Pokud zapnete volbu Auto Window/Crossing by Direction, pak výběrem 

objektů tažením myši zprava doleva (Right → Left → Crossing) je vybíráte pouhým dotknutím 

(není nutné obkreslit objekt celý, aby byl vybrán). Můžete si zvolit i opačný směr (Left → Right 
→ Crossing).

Přizpůsobení předvoleb zobrazení uživatelského rozhraní
Některé předvolby zobrazení speciálních prvků rozhraní (vzhled kurzorů, tlačítek, kontextové 
nápovědy a podobně) nastavujete v dialogu Preferences → General → UI Display. Následující 
seznam popisuje dílčí předvolby, z nichž asi nejzajímavější je možnost uložit si nastavení roz-
vržení či konfigurace rozhraní při opouštění 3ds Max.

Zobrazení nápovědy k objektům – Enable Viewport Tooltips. Když umístíte kurzor nad 
objekt ve výřezu (nemusí být vybraný), Max k němu zobrazí tooltip (plovoucí nápově-
du).
Přehrání náhledu animace – AutoPlay Preview File. Po vytvoření náhledu animované-
ho výstupu (tzv. Preview) v podobě videa Max automaticky spustí přehrávač Media 
Player.
Zobrazení nitkového kříže – Display Cross Hair Cursor. Zobrazí výběrový (někdy též kur-
zorový či nitkový) kříž přes celý pracovní výřez. Slouží především pro rychlejší orientaci 
a nalezení kurzoru. Můžete si také změnit jeho barvu.
Varování o změně topologie – Display Topology Dependence Warning. Varování zobrazu-
jící se při modelování a přecházení mezi modelovacími úrovněmi. Na nich se při změně 
parametrů některého modifikátoru vespod zásobníku modifikátorů mění topologie 
objektu, která může mít za výsledek nepříznivé účinky. Je to dobrá připomínka, že pořa-
dí modifikátorů v zásobníku je klíčové pro určení konečného vzhledu (i nežádoucího) 
modelu.

�

�

�

�

POZNÁMKA
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Varování zhroucení zásobníku – Display Stack Collapse Warning. Zapíná zobrazení 
varování při hroucení zásobníku modifikátorů. A co to vlastně znamená? Jednoduše 
řečeno, 3ds Max tímto procesem „zapeče“ veškerou historii objektu do jeho topologie, 
což znemožňuje pozdější editaci některých základních parametrů. Výhodou je úspora 
paměti, jelikož nemusí držet dílčí kroky. Více o tomto postupu se dozvíte v kapitole 
o modelování.
Uložení konfigurace před opuštěním 3ds Max – Save UI Configuration on Exit. Uloží 
pokaždé aktuální konfiguraci a rozvržení panelů před opuštěním 3ds Max. Při příštím 
spuštění se toto uživatelské rozhraní zobrazí.
Použití velkých tlačítek – Use Large Toolbar Buttons. Aktivuje větší tlačítka panelu 
nástrojů.
Horizontální text na vertikálním panelu – Horizontal Text in Vertical Toolbar. Zajistí, 
že text bude ve vertikálně orientovaných nástrojových panelech horizontální. Vypnutá 
volba umožní zobrazovat i vertikální text.
Pevně stanovená šířka textových tlačítek – Fixed Width Text Button. Určí maximální 
šířku textových tlačítek.
Doba rozbalení tlačítka – Flyout Time.Nastaví dobu (v milisekundách) rozbalení tla-
čítka od klepnutí myši. Tato tlačítka mají v pravém dolním rohu malý trojúhelník, 
který napovídá, že pokud nad ním podržíte stisknuté levé tlačítko myši, objeví se další 
možnosti.
Výběr barvy – Color Selector. Vybere standardní nástroj pro výběr barvy nebo jiný plug-
in, který ho zastupuje. Kdykoli pracujete v 3ds Max s barvou, budete to provádět tímto 
nástrojem. 

Určení velikosti a viditelnosti gizma (pivotu) objektu
Pokud se vám ztratí tři osy pro transformaci objektu (tzv. pivot nebo gizmo) nebo jsou příliš 
malé, můžete jejich velikost změnit na kartě Gizmos dialogu Preference Settings. Důležité je zde 
pole On (zapínáte zobrazení gizma) a hodnota Size, kde zadáváte vlastní velikost gizma.

�

�

�

�

�

�

�

Obrázek 2.67. Možnost zobrazení kurzorového kříže (Cross Hair) v pracovním prostředí
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Řízení vlastností vytvořených objektů dle vrstev
Když klepnete na objekt pravým tlačítkem myši, můžete vybrat Object Properties, kde nasta-
vujete vlastnosti objektu. Ty jsou standardně nastaveny tak, aby každý objekt měl své vlastní 
nastavení bez ohledu na nastavení vrstvy (u jednotlivých skupin parametrů je aktivní přepínač 
By Object). Pokud v nabídce Customize → Preferences → karta General zapnete volbu Default to By 
Layer for New Nodes, budou se nové objekty vytvářet se zapnutým přepínačem By Layer v Object 
Properties. 
To znamená, že vlastnosti objektu budou řízeny vlastnostmi vrstvy, k níž objekt náleží, nikoli 
na objektové úrovni. V této části je také volba New Lights Renderable By Layer, která říká, že 
u nově vytvořených světel bude jejich objektová vlastnost Renderable řízená na úrovni vrstvy.
Propagate Unhide/Unfreeze Commands to Layers znamená, že pokud odkryjete nebo rozmrazíte 
objekt na skryté či zmrazené vrstvě, můžete si vybrat, zda tato akce ovlivní pouze vybraný 
objekt nebo celou vrstvu (Propagate = celá vrstva, Do Not Propagate = pouze objekt, Ask = Max 
se dotáže, kterou možnost si chcete vybrat).

Předvolby operací se soubory
Na kartě Files dialogu Preferences můžete nastavovat preferované operace se soubory. Těmito 
akcemi rozumíme například zálohování (Backup), přírůstkové ukládání (Incremental Save) nebo 
komprimace ukládaného souboru (Archive).

Obrázek 2.68. Souborové operace jako archivace a zálohování, správa logu nebo 
počet naposledy otevřených souborů v nabídce File → Open Recent nastavujete 
na kartě Files dialogu Preferences

PŘIZPŮSOBENÍ UŽIVATELSKÉHO ROZHRANÍ
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Pokud pracujete s větší scénou, jejíž uložení nějakou tu dobu zabere, může vás obtěžovat její 

automatické zálohování. Pokud tuto volbu chcete vypnout a vyhnout se tak vynuceným prosto-

jům, vypněte v části Auto Backup volbu Enable nebo zvyšte intervaly ukládání (Backup 

Interval).

Optimální konfigurace grafické karty
Pokud se vám zdá, že odezva práce v pracovním prostředí není ideální, měli byste se nejprve 
podívat na nastavení vaší grafické karty v rámci 3ds Max a zkusit změnit některé parametry. To 
provedete opět v dialogu Preferences na kartě Viewports. V dolní části jsou dvě tlačítka (obrá-
zek 2.69 n) – pro výběr ovladače grafické karty (Choose Driver), kde si můžete vybrat mezi 
OpenGL, Direct3D a softwarovým ovladačem, a druhé tlačítko (Configure Driver) pro nastavení 
aktuálně vybraného ovladače (obrázek 2.69 p). Ve většině případů a vlastnostech současných 
grafických karet byste měli využívat doporučený Direct3D. Klepnutím na tlačítko Choose Driver 
si můžete vybrat, kterou verzi DirectX chcete v rámci Direct3D používat (9.0 nebo 10.0). Pod 
Windows Vista máte možnost využít i verzi 10 (na rozdíl od Windows XP, kde je k dispozici 
pouze 9.0). Zde také můžete změnit ovladač na OpenGL (tlačítkem Revert from Direct3D), jak 
vidíte na obrázku 2.69 o.

TIP

Obrázek 2.69. no Nastavení grafické karty pro optimální rychlost během práce v 3ds Max

n

o
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Pokud se vám z jakéhokoli důvodu Max nespustí po změně grafického ovladače korektně, a to ani 

do prostředí Maxe, kde byste mohli změnit ovladač nazpět, můžete tak učinit spuštěním příkazu 

„C:\Program Files\Autodesk\3ds Max 2010\3dsmax.exe–h“ nebo jednoduše ve Windows klepnu-

tím na nabídku Start → Programs → Autodesk → 3ds Max 2010 → Change Graphics Mode.

Většina nastavení na obrázku 2.69 p představuje kompromis mez kvalitou obrazu a rych-
lostí práce v 3ds Max. Například v části Appearance Preferences vybíráte kvalitu zobrazených 
textur (čím vyšší hodnota, tím kvalitnější textury, ale na úkor výkonu). Vzhledem k velkému 
množství karet dostupných na trhu je nutné vyzkoušet si vlastní kombinace parametrů a pozo-
rovat změnu výkonu. Obrázek 2.69 p ukazuje jednu z možných variant vyhovujícího výkonu 
pro náročnou práci v prostředí výřezů 3ds Max. 

Dosažení vyváženého kontrastu obrazu
Karta Gamma and LUT na dialogu Preferences ovládá gamma korekci displeje a bitmap. Cílem 
parametrů na této kartě je dosáhnout shodných kalibračních nastavení na různých HW zaříze-
ních. Soubory LUT (Look-up-table) umožňují načítat nastavení z jiných aplikací či HW, čímž 
můžete dosáhnout kompatibility na rozdílných platformách. Abyste dosáhli konzistence barev 
bez ohledu na monitor, na němž pracujete, zapněte volbu Enable Gamma/LUT Correction. Pak 

TIP

Obrázek 2.69. pNastavení grafické karty pro opti-
mální rychlost během práce v 3ds Maxp

PŘIZPŮSOBENÍ UŽIVATELSKÉHO ROZHRANÍ
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vyberte přepínací tlačítko Gamma a zadejte takovou hodnotu, kdy se menší středový čtverec 
„slije“ s pozadím, abyste viděli minimální rozdíly (kontrast).

Chcete-li, aby Gamma ovlivnila také prostředí nástroje pro výběr barev (Color Selector) nebo 
editor materiálů (Material Editor), zapněte obě volby v části Materials and Colors. Totéž můžete 
provést s bitmapami a doporučuje se nastavit vstupní gammu (Input Gamma na stejnou hod-
notu jako Display Gamma).

Obrázek 2.70. Karta Gamma and LUT pro kalibraci kontrastu displeje a bitmap
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Práce a navigace 

ve 3D prostoru 

Poznáváme 3D prostor 
v 3ds Max
Tato kapitola bude vstupní branou do seriózní práce v 3ds 
Max. Abyste mohli efektivně modelovat, animovat, texturovat, 
nasvěcovat i renderovat, musíte excelentně zvládnout ovládá-
ní výřezů, jejich přizpůsobení i nastavení. Naučíte se mani-
pulovat s výřezy (pohledy) – otáčet je, přibližovat, posunovat 
a mnoho dalšího. Transformace objektů budou předmětem 
šesté kapitoly. Pojďme na to, určitě už jste dychtiví po prvních 
výsledcích!
Po otevření Maxe vidíte čtyři výřezy, které jsou pohledem do 
3D prostoru. Standardně po instalaci jsou to (názvy vidíte 
vlevo nahoře v každém výřezu):

Horní čili půdorysný (TOP)
Čelní pohled (FRONT)
Levý bokorys (LEFT)
Perspektivní 3D výřez (PERSPECTIVE)

Aktivní výřez je ohraničen žlutou barvou a je to ten, ve kterém 
můžete aktuálně vytvářet objekty. Klepnutím na pravé tlačítko 
myši dovnitř požadovaného výřezu ho aktivujete. Zvykněte si 
na tento postup, protože když výřez vyberete levým tlačítkem 
myši a máte vybrané některé objekty, klepnutím výběr zrušíte 
(což při přechodech mezi výřezy nebývá žádoucí). Proto je 
výhodnější pro přecházení mezi pohledy používat pravé tla-
čítko myši, které výběr neruší.

Změna pohledu a jejich typy
Samozřejmě to nejsou jen tyto pohledy, prostřednictvím nichž 
můžete nahlížet do 3D prostoru. Pokud klepnete pravým 
tlačítkem na název výřezu, objeví se možnosti, které s výřezy 
můžete provádět. Nabídku vidíte na obrázku 3.2.

�

�

�

�

3
K A P I T O L A

Témata kapitoly:

Poznáváme 3D prostor 

v 3ds Max

Navigace ve 3D prostoru

Některé tipy na usnadnění 

a urychlení práce ve 3D 

prostoru

�
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102 KAPITOLA 3   �   PRÁCE A NAVIGACE VE 3D PROSTORU

Ve verzi 3ds Max 2010 došlo k rozšíření možností práce s výřezem. Vlevo nahoře u každého výřezu 

máte možnost klepnutím pravým tlačítkem myši na symbol „+“ vyvolat nabídku s příkazy napří-

klad pro maximalizaci výřezu, statistiky, chování a zobrazení mřížky, zapnutí navigačních nástrojů 

ViewCube a SteeringWheels nebo dalších nastavení (Configure). Když klepnete pravým tlačítkem 

myši na název výřezu (např. Perspective), zobrazí se možnosti pro jeho výměnu. Můžete ho 

vyměnit za jiný pohled nebo nástroj, jakým může být třeba Track View určený k animaci. Konečně 

možnost Smooth + Highlights (popř. Wireframe) dovolí vybrat typ zobrazení objektů ve výřezu. Ve 

verzích před 2010 jste měli všechny tyto možnost pod jednou nabídkou – názvem výřezu.

Jaké pohledy máte na výběr?
Perspektivní – klasický typ pro 3D pohled. V tomto pohledu se na objekt můžete dívat 
ze všech stran přirozeným způsobem.
Ortografický – 2D výkresy, jak je znáte, jsou představiteli ortografických pohle-
dů. Díváte-li se na předměty z přímých, kolmých směrů, jde o ortografický pohled. 
Následující pohledy řadíme mezi ortografické:

Horní pohled (Top), klávesová zkratka T
Dolní pohled (Bottom), klávesová zkratka B
Čelní (Front), klávesová zkratka F
Zadní (Back), klávesová zkratka implicitně nedefinovaná
Levý bokorys (Left), klávesová zkratka L
Pravý bokorys (Right), klávesová zkratka R

�

�

�

�

�

�

�

�

Obrázek 3.1. Čtyři pracovní výřezy či pohledy, ve kterých budete vytvářet své modely

POZNÁMKA

K1601.indd   102K1601.indd   102 14.1.2010   13:44:4814.1.2010   13:44:48



103

3
P

rá
ce

 a
 n

a
v

ig
a

ce
 

v
e

 3
D

 p
ro

st
o

ru

Interaktivní renderovaný náhled (Activeshade) – tento pohled vám usnadní vidět 
aktualizovaný renderovaný náhled objektu ihned po jakékoli změně materiálu nebo 
vlastnosti světla. Někdy při složité scéně může být tento pohled spíše brzdou.
Animační nástroj Track View (Track) – pokud se chystáte na dráhu animátora, určitě 
oceníte možnost integrace klíčového nástroje pro animaci – Track View – přímo do jed-
noho z pracovních výřezů.
Schematický pohled (Schematic View) – obdobně můžete začlenit do jednoho z výřezů 
schematický pohled, který nabízí snadnou cestu propojování objektů do hierarchií pro 
animační účely.
Volně přizpůsobený pohled pomocí mřížky – pokud vám nestačí pohledy, které jsou 
implicitně dostupné, nebo jen chcete jinak orientovanou dočasnou mřížku, můžete si 
vytvořit svou vlastní díky pomocnému objektu Grid (mřížka). Postup využití je tento:

Vytvořte si pomocný objekt Create → Helpers → Grid.

Natočte a posuňte mřížku podle vašich představ.
Klepněte na ni pravým tlačítkem myši a vyberte Activate Grid. Tím jste aktivovali 
pomocnou mřížku a ta hlavní (Home Grid) se potlačila.
Teď můžete využít nabídku klepnutím pravým tlačítkem myši na název výřezu 
→ Views → Grid a vybrat si požadovaný ortografický pohled skrze tuto mřížku. 
Například čelní pohled, jak ho znáte v klasickém pojetí, získá takto jiný vzhled.

�

�

�

�

1.

2.

3.

4.

Obrázek 3.2. Hlavní dialog pro změnu typu a vzhledu výřezů ve verzi 2009 n. Ve verzi 2010 došlo 
k drobné úpravě. Na místo jedné položky s názvem výřezu zde máte tři o.

n

o

POZNÁVÁME 3D PROSTOR V 3DS MAX
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Integrace rozšiřujících nástrojů – na místo pracovního výřezu můžete umístit jeden 
z následujících nástrojů:

Asset Browser pro správu max souborů a digitálních aktiv
Biped AnimationWorkbench – nástroj pro úpravu animace postav
Motion Mixer – nástroj pro míchání pohybů
MAXScript Listener – rozhraní pro programovací jazyk MAXScript

Vybraný tvar a jeho orientace definující pohled – Shape. Stačí vytvořit 2D tvar, nějakým 
způsobem ho natočit a pak vybrat tuto volbu. Pohled se zarovná s tímto tvarem.

Ortografický pohled je společně s izometrickým pohledem typem tzv. axonometrického pohle-

du (viz obrázek 3.11 izometrický pohled vpravo nahoře). O co jde? Rovnoběžné hrany modelu 

zůstávají i při pohledu na model ve 3D stále rovnoběžné. Izometrický pohled je právě ten typ 

pohledu, kdy se na objekt mohu dívat ve 3D z různých pohledů a hrany zůstávají rovnoběžné. 

Ortografický pohled respektuje pohled ve 2D (v jedné rovině). Perspektivní pohled naopak 

napodobuje lidské oko, kdy se nám do dáli ubíhající rovnoběžné hrany objektu zdají, jakoby se 

sbíhaly. 

�

�

�

�

�

�

Obrázek 3.3. Pomocný objekt Grid vám pomůže dočasně nastavit jakýkoli pohled jako primární 
pro modelování. Například klasický čelní pohled nemusí odpovídat novému čelnímu pohledu 
dosaženému pomocí pomocného Grid objektu.

POZNÁMKA
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Změna vzhledu objektů ve výřezu
Určitě jste si všimli, že když vytvoříte objekty v různých pohledech (pracovních výřezech), 
mají různý vzhled – drátový, stínovaný, popřípadě kombinovaný. K čemu jsou a jak je měnit? 
Především slouží k pochopení složení modelu (drátový model – Wireframe). Vidíte, kde procházejí 
hrany, jak je model detailní a jak velké jsou polygony (základní stavební kameny polygonového 
modelu). Obrázek 3.4 n ukazuje vlevo drátový model a vpravo stínovaný (Smooth+Highlights) 
model. Pokud pracujete s rozsáhlou scénou s mnoha detailními objekty, bývá odezva systému 
při pohybu výřezem většinou rychlejší s nastaveným drátovým módem. Pak je tu ještě význam-
ný mód – stínovaný se současně zobrazeným drátovým povrchem (Edged Faces – viz obrázek 3.4 
o), který je výhodný, pokud současně modelujete (potřebujete vědět, kde leží vrcholy, hrany, 
polygony) a také chcete vidět výsledný tvar na stínovaném povrchu modelu.
Pokud klepnete pravým tlačítkem myši na možnost Smooth+Highlights vedle názvu výřezu 
Perspective (ve verzi 2010), můžete si vybrat z výše uvedených módů.

Pro přepínání vzhledu výřezu pomohou také klávesové zkratky:
F3 = přepínání mezi stínovaným a drátovým módem.
F4 = zapnutí drátového módu na povrchu stínovaného.

Přizpůsobení a vzhled pracovních výřezů 
Maximalizace výřezu 
Když modelujete, potřebujete mít maximální přehled nad každým detailem modelu, proto je 
žádoucí zvětšit si aktuální pohled. To provedete s aktivním pohledem stiskem kláves Alt+W. 
K tomu slouží taktéž ikona Maximize Viewport Toggle, kterou najdete vpravo dole v uživatelském 
rozhraní Maxe. 

Individuální rozložení (layout) výřezů
Každý pracujeme dle svého vkusu a individuální rozvržení pracovního místa sem zajisté patří. 
Pokud si chcete rozvrhnout pracovní výřezy, jako například na obrázku 3.5, postupujte takto:

�

�

Obrázek 3.4. 3ds Max umožňuje pracovat s různým vzhledem objektů ve výřezu. Většinou 
využijete stínovaný+drátový mód. Další módy najdete pod položkou Other Visual Styles. Pokud 
vám například světlo vrhá stín na model a vy nevidíte jeho povrch, můžete využít mód Flat. Pro 
zjednodušení komplexnosti scény můžete použít mód Bounding Box (pouze ohraničující krabice).

n o

POZNÁVÁME 3D PROSTOR V 3DS MAX
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106 KAPITOLA 3   �   PRÁCE A NAVIGACE VE 3D PROSTORU

Klepněte pravým tlačítkem myši na symbol „+“ vlevo nahoře v libovolném výřezu.
Vyberte Configure.

Vyberte kartu Layouts a zvolte požadovaný typ rozložení výřezů. Můžete si je i přenasta-
vit. Stačí klepnout do požadovaného výřezu a vyměnit pohled za jiný.

Pokud se s kurzorem myši přemístíte nad okraj libovolného výřezu nebo do jejich společného 

průsečíku, stisknete levé tlačítko a pohnete myší, můžete změnit velikost daného výřezu.

Navigace ve 3D prostoru
Navigace ve 3D prostoru doznala novinek příchodem dvou nástrojů, jejichž cílem je usnadnit 
uživateli manipulaci s výřezy. Jsou jimi ViewCube a SteereingWheels. Vidíte je po instalaci vpravo 
nahoře v každém výřezu. Pojďme se na ně podívat podrobněji.

Předdefinované orientace výřezů
Nástroj ViewCube (viz 3.6 obrázek n) umožňuje rychlé přepínání mezi pohledy, a to klepnutím 
na určitou část krychle umístěnou v pravém horním rohu vybraného výřezu. Jediným klepnu-
tím máte k dispozici základní pevné pohledy, s nimiž se ve scéně neztratíte. Navigační krychli 
zapínáte a vypínáte klepnutím pravým tlačítkem myši na symbol „+“ výřezu (pro její vypnutí 

1.

2.

3.

Obrázek 3.5. Je libo jiné rozvržení pracovní plochy, než 3ds Max nabízí po instalaci? Můžete si 
vybrat na kartě Layouts.

TIP
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přímo na krychli) → Configure → vypněte Show the View Cube. Na kartách ViewCube a Steering 
Wheels (viz obrázek 3.6 p) máte další možnosti. Jejich nastavení najdete také v hlavní nabídce 
Views, která je shodná s nabídkou vyvolanou pomocí pravého tlačítka myši na „+“ → ViewCube 
a Steering Wheels. Klávesové zkratky sloužící k zapínání a vypínání ViewCube a SteeringWheels 
jsou postupně Alt+Ctrl+V a Shift+W.

n o

p
Obrázek 3.6. Navigační nástroje ViewCube a SteeringWheels 
nastavujete na stejnojmenných kartách dialogu Viewport Configuration

NAVIGACE VE 3D PROSTORU
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Manipulace s pohledem pomocí průvodce 
s navigačními příkazy
SteeringWheels čili „kormidelní kolo“ nabízí všechny potřebné navigační příkazy v jediném 
nástroji (viz 3.6 o): Zoom (přibližování a vzdalování), Orbit (otáčení kolem scény), Pan (šven-
kování), Rewind (zpět v pohledu), Center (vycentrování pohledu podle vybraného pivotu objek-
tu), Walk (chůze), Up/Down (pohled shora/zdola) a Look (dívání se kolem sebe z jednoho místa). 
K jejich aktivaci nyní stačí, abyste zobrazili „kormidelní kolo“ pomocí kláves Shift+W, klepnuli 
na jeden příkaz, drželi levé tlačítko myši a pohybovali se. Takto používáte daný příkaz a navi-
gujete se ve scéně. Puštěním levého tlačítka myši můžete plynule přejít k dalšímu příkazu.
SteeringWheels zapínáte a vypínáte klávesami Shift+W.

Pokud vám klávesová zkratka nefunguje, zkuste zapnout příkaz Keyboard Shortcut Override 
Toggle na hlavním panelu nástrojů. Tento příkaz přepíná mezi rozpoznáním klávesových zkratek 

pro hlavní rozhraní Maxe a zkratkami pro konkrétní skupiny funkcí v rámci jednotlivých nástrojů 

3ds Max.

Manuální navigace prostorem
Nyní, když se umíte navigovat 3D prostorem pomocí nástroje SteeringWheels, si ukážeme příka-
zy, které vám dají skutečnou svobodu pohybu. Někomu se mohou navigační nástroje ViewCube 
a SteeringWheels zdát spíše omezující a brzdící v práci. Pokud patříte mezi tuto skupinu grafiků, 
přečtěte si následující pracovní postupy.

Otáčení scénou
Pokud chcete otáčet pohledem (ne objektem), postupujte takto:

Podržte klávesu Alt a podržte stisknuté kolečko myši.
Pohybujte se s myší a pozorujte otáčení pohledem.

Další tipy na manipulaci s pohledem:
Ctrl+Alt+stisk kolečka myši+pohyb provádí plynulé přibližování/vzdalování ve scéně 
(viz další bod)
Shift+Alt+stisk kolečka myši+pohyb způsobí horizontální otáčení pohledem bez změn 
výšky (otáčení v jedné úrovni)

Úkon otáčení výřezem lze podle obrázku 3.7 provést po stisku příslušné ikony pro otočení 
– Orbit (třetí ikona zleva v druhé řadě na obrázku 2.52). Vyzkoušejte si otáčet výřezem uvnitř 
kruhu, mimo něj, na obvodu a na značkách kruhu obloukové rotace. Použití nástroje s kurzo-
rem myši umístěným na těchto místech způsobí jiný druh otočení. 

Otáčet se můžete také kolem vybraného objektu, resp. podobjektů (viz kapitola o modelování). 

Podržte stisknuté levé tlačítko myši na navigační ikoně pro Orbit a vyberte Orbit Selected, resp. 

Orbit SubObject. Výhodou tohoto přístupu zůstává, že vámi zvolený objekt se stane středem 

otáčení, takže se nedostane mimo pohled. 

1.

2.

�

�
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Přibližování/vzdalování se ve scéně
Kromě ikony Zoom (přibližování/vzdalování aktuálního výřezu) nebo Zoom All (přibližování/
vzdalování všech výřezů najednou) v navigačních ovládacích prvcích vpravo dole (viz první 
dvě ikony v horní řadě na obrázku 2.52) můžete použít kolečko myši. Pokud se budete pohy-
bovat příliš skokově, použijte zmíněnou ikonu Zoom. Tento „skokový“ přírůstek si ale můžete 
nastavit přes nabídku Customize → Preferences → karta Viewports → část Mouse Control → pole 
Wheel Zoom Increment. 
Zoomování ve výřezu s kurzorem myši jako středem přibližování/vzdalování docílíte taktéž 
zde, a to zapnutím pole Zoom About Mouse Point (Perspective) nebo Zoom About Mouse Point 
(Orthographic) podle toho, ve kterých typech pohledů chcete tento typ přibližování/vzdalování 
zpřístupnit. 

Gesta myši představují možnosti nadefinování určitých tahů myši, které budou zastupovat 

konkrétní příkaz. Definování takových specifických pohybů a jejich přiřazení příkazům můžete 

provést na panelu Utilities → tlačítko More → Strokes → zapněte Draw Strokes → proveďte 

charakteristický tah myši → Define. Podle obrázku 3.8 přiřaďte provedenému tahu příkaz ze 

seznamu Command to Execute a potvrďte stiskem tlačítka OK. Nyní jen stačí nastavit, aby se 

při stisku kolečka myši vyvolávala gesta, nikoli švenkování. To, jak již víte, provedete na kartě 

Viewports dialogu Configure Viewports.

Obrázek 3.7. Základní nástroj Orbit pro obloukové otáčení pohledem 
je možné nahradit kombinací kláves Alt+kolečko myši

TIP

NAVIGACE VE 3D PROSTORU
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„Švenkování”
„Švenkování” čili posunování kamery v rovině obrazovky docílíte stisknutím kolečka myši a je-
jím posunem. Tento úkon zastupuje druhá ikona v druhé řadě na obrázku 2.52 (Pan View). To, 
zda kolečko myši použijete pro „švenkování” nebo tzv. gesta myši (Mouse Strokes), nastavujete 
taktéž na kartě Viewports → část Mouse Control → Middle Button. 

Změna zorného pole (FOV)
Změnu zorného pole můžete měnit s pomocí ikony Field-of-View (první ikona v druhé řadě 
na obrázku 2.52). Tento efekt je podobný změně čočky kamery. Zorné pole je šířka pohledu 
měřená jako úhel s vrcholem v počátku pohledu. Čím širší je FOV, tím více vidíte kolem sebe 
(větší záběr scény, ale s deformovanějším pohledem). Konkrétní hodnotu FOV můžete nastavit 
klepnutím pravým tlačítkem myši na ikonu FOV a zadáním hodnoty vpravo dole (ve stupních) 
do pole Field of View na dialogu Viewport Configuration → karta Rendering Method.

Vycentrování výřezu (jak se ve výřezu neztratit)
Když se při pohybování ve výřezu ztratíte a potřebujete se zaměřit na konkrétní objekt, vyberte 
ho například podle názvu (klávesa H) a použijte příkaz Zoom Extents Selected (klávesa Z). Aktivní 
výřez se přemístí tak, že vybraný objekt bude v jeho středu. Pokud to chcete učinit ve všech výře-
zech naráz, klepněte na ikonu Zoom Extents All Selected. Pokud nevíte, jaký je název objektu, můžete 
vybrat kterýkoli jiný. Alespoň se přiblížíte zpátky mezi vaše objekty, pokud se beznadějně ztratíte.

Obrázek 3.8. Přiřazení gest pohybu myši (Strokes) příkazům může 
výrazně zefektivnit vaši práci. Vyhnete se tak často opakovaným pro-
cházením zdlouhavých cest v nabídkách nebo dokonce zkratek myši 
a definujete si jednoduché tahy. Nástroj Define Stroke najdete na 
panelu Utilities → More → Strokes.
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Pokud podržíte stisknuté levé tlačítko na ikoně Zoom Extents All (vycentruj všechny výřezy tak, 

aby byly vidět všechny objekty, které jsou ve scéně), ukáže se další možnost – Zoom Extents All 

Selected (vycentruj všechny výřezy tak, aby byl ve středu každého z nich vybraný objekt). Jak 

jsem již uvedl, některé ikony uživatelského rozhraní mají v pravém dolním rohu malý trojúhel-

ník, který napovídá, že se pod ní skrývá další příkaz. Na obrázku 3.10 vidíte ikony Walk-Through 

a Zoom Region (viz následující body).

Obdélníkové přiblížení na konkrétní oblast v některém ortografickém pohledu
V jakémkoli ortografickém pohledu se místo ikony pro změnu zorného pole (FOV) zobrazí 
ikona Zoom Region pro obdélníkové přiblížení na požadovanou oblast. Klávesová zkratka je 
Ctrl+W. Vyzkoušejte si například v půdorysném pohledu přiblížení na vybranou oblast.

Interaktivní procházení scénou
Pomocí módu Walk-Through (viz obrázek 3.10) můžete procházet scénou stejně jako v počíta-
čových hrách pomocí kláves W (pohyb vpřed), S (vzad), A (úkrok vlevo), D (úkrok vpravo). 
Pokud je pohyb pomalý, stiskněte klávesu Q pro zrychlení (dalšího přizpůsobení rychlosti 
chůze docílíte klávesami „[“ pro zpomalení a „]“ pro zrychlení). Když příkaz Walk-Through 

n o
Obrázek 3.9. Široké zorné pole (FOV=140 stupňů) n a úzké zorné pole (FOV=10 stupňů) o. 
S kamerou získáte mnohem rozsáhlejší možnosti nastavení zorného pole.

Obrázek 3.10. Ikony zastupující navigační ovládací prvky. Pokud podržíte stisknuté levé tlačítko 
myši na některých z nich, objeví se další možnosti.

POZNÁMKA

NAVIGACE VE 3D PROSTORU

Zoom Extents Selected Zoom Extents All

Zoom Region Walk Trough
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aktivujete, objeví se ve výřezu malý kruhový terčík, který slouží pro pozorování prostoru (stačí 
držet levé tlačítko a pohybovat myší). Mód Walk-Through vyvoláte po delším stisknutí ikony 
Truck Camera (v kamerovém pohledu) nebo Pan View (v perspektivním pohledu) vpravo dole 
v navigačním panelu 3ds Max. Vyzkoušejte si tuto funkci v perspektivním výřezu.

Uložení a načtení pohledu
Když se vám líbí některý pohled, s nímž jste si pohráli a pěkně jej nastavili, obvykle stojí za to 
uložit si ho. To provedete s aktivním pohledem v hlavní nabídce Views → Save Active „Název_pohle-
du“ View. Načítat uložený výřez můžete stejně přes nabídku Views → Restore Active „Název_pohledu“ 
View (požadovaný výřez musí být aktivní). Takto můžete uložit a načíst každý výřez.

Krok zpět (návrat) v orientaci pohledu
Pokud jste omylem posunuli či jinak natočili výřez a rádi byste ho vrátili do původní polo-
hy, nepomůže vám klasicky klávesová zkratka Ctrl+Z (Edit → Undo), která se používá pro 
návrat změn parametrů a transformací objektů, nikoli pohledů. Musíte použít příkaz hlavní 
nabídky Views → Undo View Change (krok zpět – Shift+Z) nebo Redo View Change (krok vpřed 
– Shift+Y).

Obrázek 3.11. Uložení ortografického (resp. přesněji izometrického) pohledu
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Obrázek na pozadí výřezu jako předloha
Určitě by vás nebavilo koukat na skicu, kterou máte na stole, a překreslovat ji v Maxovi tak nějak 
„od oka“. Nejlepším způsobem, jak integrovat skicu přímo do výřezu Maxe, je tento postup:

Naskenujte si svoji předlohu a uložte si ji v některém obrazovém souboru (JPG, TIF, 
BMP, …).
Vyberte si některý výřez, kde budete předlohu obkreslovat. Pokud máte například skicu 
z čelního pohledu, aktivujte pohled Front.
Přejděte do hlavní nabídky Views → Viewport Background → Viewport Background 
(Alt+B).
Klepněte na tlačítko Files a vyberte si naskenovanou předlohu.
Ujistěte se, že máte zapnutou volbu Display Background (zobrazit pozadí), Match Bitmap 
(zachovat rozměry bitmapy) a případně Lock Zoom/Pan (možnost pohybování výřezu 
s připnutým obrázkem na pozadí). Zvlášť důležité jsou rozměry bitmapy – můžete si 
totiž vybrat, zda chcete, aby se bitmapa napasovala do rozměrů výřezu (Match Viewport), 
což může deformovat texturu, nebo si vybrat Match Rendering Output (přizpůsobení bit-
mapy rozměrům renderovaného výstupu, který najdete v nabídce Rendering → Render 
Setup → Output Size).

Některé tipy na usnadnění a urychlení 
práce ve 3D prostoru
V této části si představíme možnosti, jak si přizpůsobením funkcí Maxe můžete usnadnit či 
urychlit standardní práci.

1.

2.

3.

4.

5.

Obrázek 3.12. Načtení obrázku jako předlohy na pozadí výřezu

NAVIGACE VE 3D PROSTORU
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Zrychlení odezvy zobrazování komplexních modelů
Když budete pracovat s mnoha objekty v jedné scéně a začnete otáčet výřezem, můžete pozo-
rovat značné zpomalení v odezvě systému. V případě 32bitového systému budete hledat mož-
nosti, jak urychlit manipulaci s pohledem, který obsahuje mnoho objektů. Jednou možností je 
využít příkaz Adaptive Degradation, který je dostupný ve spodní části uživatelského rozhraní, 
jak vidíte na obrázku 3.13. 
Adaptivní degradace umožňuje při pohybu výřezem zachovávat vámi zadaný minimální počet 
snímků za sekundu tak, že se místo geometrie zobrazují pouze ohraničující krabice objek-
tů, počínaje těmi nejvzdálenějšími od kamery. Funkci si můžete vyzkoušet tak, že vytvoříte 
více komplexních objektů s dostatečným počtem segmentů, a pak s aktivní funkcí Adaptive 
Degradation pohybujete výřezem. Pozorujte dynamickou změnu vzhledu objektů na ohrani-
čující krabice.
Nastavení požadované rychlosti provedete klepnutím pravým tlačítkem myši na ikonu Adaptive 
Degradation. Na kartě Adaptive Degradation pak nastavíte požadované zachování FPS při pohy-
bu ve výřezu polem Maintain Frames Per Second.

Pevné nastavení zobrazení objektů jako ohraničující krabice
Pevného zobrazení objektů jako ohraničující krabice (na rozdíl od dynamické funkce Adaptive 
Degradation) docílíte dvěma způsoby:

Buď na objektové úrovni tak, že vyberete objekty, které se mají zobrazovat jako jedno-
duché krabice, a klepnete na ně pravým tlačítkem myši → Object Properties → Display As 
Box. Ostatní objekty mohou zůstat stínované.
Hromadně všem objektům ve výřezu pomocí klepnutí pravým tlačítkem myši na název 
výřezu → Configure → karta Rendering Method → část Rendering Level → Bounding Box. 
Pokud chcete, aby se pouze aktuálně vybrané objekty zobrazovaly ve stínovaném módu, 
klepněte na nabídku Views → Shade Selected. Tuto možnost oceníte zejména při přehrá-
vání animace, kdy vám jde zejména o plynulý pohyb objektů spíše než o jejich vzhled. 

Všechny další možnosti zobrazení na kartě Rendering Method kromě Smooth nebo 
Smooth+Highlights mohou urychlit pohybování s výřezem.

Urychlit práci se systémem můžete také vypnutím možnosti Views → Update During Spinner 
Drag. Tím docílíte toho, že ruční změnou hodnoty číselníku pro upravení rozměrů některého 

objektu se tento ve výřezu aktualizuje až poté, co přestanete upravovat danou hodnotu či para-

metr (tedy pustíte levé tlačítko myši). 

Vyřazení výřezu z aktualizací 
Urychlit práci ve výřezu můžete také tak, že právě neaktivní výřez vyřadíte z aktualizací, při 
kterých upravujete objekty v některém jiném výřezu. To provedete tak, že s aktivním výřezem 
stisknete klávesu „D“ (označuje slovo Disable-vyřadit). Výřez se pak bude aktualizovat pouze 
tehdy, pokud ho znovu aktivujete, tedy do něj klepnete. Aktualizovat se bude vždy pouze ten 
výřez, v němž aktuálně pracujete (pokud jsou všechny ostatní „vyřazené“).

�

�

TIP
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Funkce Adaptive Degradation je zapnutá

Obrázek 3.13. Funkce Adaptive Degradation umožňuje automaticky („za letu“) měnit vzhled 
objektů na jednodušší zobrazení, aby byla zaručena vámi zadaná rychlost pohybování s výřezem 
(Maintain Frames Per Second). Ve scéně je v tomto případě zachyceno téměř 5 000 robotů.

n

o

NĚKTERÉ TIPY NA USNADNĚNÍ A URYCHLENÍ PRÁCE VE 3D PROSTORU
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Globální vypnutí textur na objektech
Někdy pomůže vypnutí textur u všech objektů, pokud potřebujete uvolnit zdroje systému, nebo 
jen prostě potřebujete vidět objekty v difúzních barvách, abyste mohli lépe pozorovat účinky 
světla. K tomu použijte Configure Viewports → Rendering Method → část Rendering Options → 
zapněte Disable Textures.

Vypnutí zadních plošek objektů (Backface Cull)
Znatelné ulehčení systémovým zdrojům může být vypnutí zadních plošek objektů. Jedná se 
o vnitřní plochy, které nemusí být ve většině případů vidět. Na obrázku 3.14 vidíte dva objekty, 
jeden bez zobrazených zadních plošek (3.14 – 1) a jeden s nimi (3.14 – 2). Pokud budete mít 
takových objektů hodně, může to mít významný dopad na výkonnost systému. Ve druhé kapi-
tole jsme si ukázali zakázání zadních plošek na úrovni objektových vlastností (Object Properties). 
Nově vytvářeným objektům tuto funkci zajistíte takto:
Vyberte nabídku Customize → Preferences → část Viewports → zapněte Backface Cull on Object 
Creation. Takto při tvorbě libovolného nového objektu budou zadní plošky potlačeny. 

Tím jsme uzavřeli kapitolu o manipulaci a navigaci v pracovních výřezech. Další součástí 
zvládnutí práce ve 3D prostoru bude samotná transformace objektů (ta bude náplní šesté kapi-
toly). V následující kapitole se podíváme na způsoby a možnosti přenášení a konverze souborů 
v souvislosti s dalšími 3D aplikacemi, s nimiž byste mohli přijít do kontaktu.

Obrázek 3.14. Možnost Backface Cull on Object Creation potlačí zobrazení zadních ploch při tvor-
bě objektu, čímž můžete při větším množství objektů dosáhnout rychlejší interaktivity při pohybo-
vání s výřezem (n-Backface Cull zapnutá, o-Backface Cull vypnutá, p-dialog Preference Settings, 
kde funkci Backface Cull on Object Creation najdete).

n

o

p
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Výměnné 

formáty, vstupy 

z externích 

aplikací, spouštění 

skriptů a plug-inů

Nejčastěji využívané 
výměnné formáty
Na Internetu je dostupných mnoho 3D modelů v různých 
formátech, a navíc až pokročíte v 3ds Max, zjistíte, že si musí-
te umět „povídat“ i s jinými aplikacemi pro specializované 
činnosti. Výhodou je, že většina z těchto aplikací je pod tak-
tovkou společnosti Autodesk, která pečuje o interoperabilitu 
mezi 3D aplikacemi. Z AutoCADu si můžete načítat DWG 
soubory, z Mayi OBJ formát, z Adobe Illustratoru (známého 
vektorového editoru) AI soubory, pohybové soubory FBX 
z Autodesk Motion Builder a podobně. I když v poslední verzi 
2010 je mnoho novinek zejména v oblasti modelování, můžete 
využít například Autodesk Mudbox pro detailní high-poly 
modelování. Tudíž musíte vědět, jak svůj model do takové 
aplikace dostat. Pojďme se podívat na ty nejčastější případy. 

3D modely z Internetu – formát 3DS
Pokud napíšete například do vyhledávače Google hledané 
spojení „3D models“, najdete vskutku nepřeberné množství 
3D modelů k zakoupení nebo zdarma. Na obrázku 4.1 vidíte 
ukázku serveru 3DXtras, který nabízí pestrou škálu modelů. 
Takových serverů je celá řada a je jen na vás, kolik času chcete 
procházení bohatých knihoven věnovat.
Po stažení modelu, který je většinou ve formátu 3DS, můžete 
přistoupit k jeho importu do prostředí 3ds Max. Výhodou 

4
K A P I T O L A

Témata kapitoly:

Nejčastěji využívané 

výměnné formáty

Rozšíření vlastností Maxe 

pomocí externích aplikací 

a plug-inů

Další typy plug-inů a jejich 

správa

Externí aplikace
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formátu 3DS je jeho použitelnost v různých verzích 3ds Max, kdežto standardní soubor MAX 
otevřete jen ve verzi, v níž byl uložen, nebo novější. Například soubor uložený ve verzi 2009 
neotevřete ve verzi 2008. 
Postup importu je tento: 

V nabídce File → Import (verze 2009) vyberte soubor, který chcete načíst. Ve verzi 2010 
najdete funkci importu pod hlavní aplikační ikonou → Import → Import.
Objeví se skromný dialog, který vidíte na obrázku 4.2.
Pokud chcete model do aktuální scény přidat, vyberte možnost Merge objects with cur-
rent scene. Pokud chcete nahradit stávající scénu tímto modelem, vyberte si Completely 
replace current scene. Možnost Convert Units zkonvertuje jednotky v souboru na jednotky 
ve scéně.

Importovaný model je typu editovatelné sítě (Editable Mesh), kterou můžete dále upravovat. 
Samozřejmě ne parametricky, jako například krabici, kterou vytvoříte ze základních primitiv, 
ale pouze modelovacími technikami (viz dále kapitola o modelování). 

1.

2.

3.

Obrázek 4.1. Server 3DXtras nabízí mnoho 3D modelů ke stažení. 
Ke stažení libovolného modelu se musíte jen zaregistrovat.
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Importujeme architektonické výkresy – AutoCAD DWG
Import DWG souborů je nejčastějším úkolem při přebírání projekčních výkresů, které je třeba 
vizualizovat ve 3D. Nejprve si uvědomte, zda je pro vás výhodnější DWG soubor připojit 
pomocí nástroje File Link Manager, nebo ho přímo importovat (viz „Připojení CAD výkresů“ 
ve druhé kapitole). V případě, kdy ještě výkres není hotový a pracuje na něm nějaký projek-
tant (i po síti), můžete si výkres připojit pouze jako podkladovou vrstvu přes nástroj File Link 
Manager. Půjde o živé napojení na DWG soubor. Pokud se rozhodnete pro importování DWG 
souboru (z nabídky File → Import), objeví se dialog AutoCAD DWG/DXF Import Options. Máte 
zde mnoho možností, co můžete s importovaným souborem, potažmo grafickými daty v něm 
uloženými provést.

První karta Geometry nabízí možnosti změny a nastavení parametrů importované geo-
metrie.
Další karta Layers zobrazuje seznam importovaných vrstev (zvolením přepínacího tla-
čítka Select From List můžete zvolit, které vrstvy chcete importovat).
Třetí karta Spline Rendering shromažďuje skupinu parametrů pro nastavení tloušťky čar 
(zda budou vidět v renderovaném snímku nebo v pracovním výřezu) a jejich mapování.

Volba měřítka importovaného modelu
V horní části Model Scale si vyberte jednotky, v nichž je projekt vytvářen. Zde byste měli nasta-
vit správné jednotky, aby nedošlo k nežádoucím konverzím. V řádku Resulting Model Size pak 
vidíte, jak Max spočítal a vymezil ohraničující pásmo modelu (na základě příchozích jednotek 
v DWG souboru, systémových jednotek a jednotek pro zobrazení modelu v Maxovi). 

�

�

�

Obrázek 4.2. Dialog pro import 3DS souboru

NEJČASTĚJI VYUŽÍVANÉ VÝMĚNNÉ FORMÁTY
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Způsob odvození typu geometrie
Když chcete vybrat, jak má 3ds Max odvodit vytvoření (skupin) objektů z DWG souboru do 
Maxe, podívejte se do části Derive AutoCAD Primitives By (odvodit primitiva AutoCADu podle). 
Implicitně je zde nastavena volba Layer, Blocks as Node Hierarchy, Split by Material, která zna-
mená, že všechny objekty v jedné vrstvě AutoCADu (a které netvoří bloky) jsou spojeny do 
jednoho objektu typu Editable Mesh nebo Spline. Bloky se importují jako hierarchická spojení 

Obrázek 4.3. Dialog AutoCAD DWG/DXF Import Options nabízí spoustu parametrů pro 
přizpůsobení importované geometrie
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(rodič-potomek). Navíc jsou objekty rozděleny podle aplikovaného materiálu (bez ohledu na 
příslušnost k jedné vrstvě).
Pokud importujete stěny, kterým chcete přidat tloušťku, zaškrtněte políčko Use Extrude modifier 
to represent thickness. Výchozí objekty z aplikace AutoCAD Architecture je dobré importovat 
jako logické objekty (celky), nerozdělené na dílčí elementy. Zapněte tedy také Create one scene 
object for each ADT object. Pokud chcete využít materiály definované v 3ds Max namísto v pří-
chozím souboru (musí mít stejný název), zaškrtněte také Use scene material definitions. Další 
volby můžete ve většině případů nechat tak, jak jsou. 

3D vizualizace informačního modelu 
budovy (BIM) – Revit Architecture
V posledních verzích Maxe i Revitu (softwaru spadajícího do kategorie AEC – stavebnictví) 
došlo k významným posunům interoperability mezi těmito aplikacemi. Formát FBX, nativní 
souborový formát v aplikaci Autodesk MotionBuilder (aplikace používaná pro tvorbu, edito-
vání a mixování motion capture technologie a klasické animace s klíčováním), můžete použít 
i pro výměnu grafických dat s aplikací Revit Architecture. Je to také velmi vhodný formát pro 
výměnu mezi Mayou a 3ds Max. FBX s sebou nese novou technologii pro rozpoznání scény 
(Scene-Loading Recognize), která umožní v exportovaném FBX souboru Revitu rozpoznat 
přesně geometrii, světla, materiály a data kamery, které tvůrci vytvořili v Revitu.

Obrázek 4.4. Z aplikace Revit Architecture můžete data pro 3ds Max exportovat prostřednictvím 
formátu FBX

NEJČASTĚJI VYUŽÍVANÉ VÝMĚNNÉ FORMÁTY
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Postup exportu Revit modelu do FBX formátu zachycují následující kroky:
V aplikaci Revit Architecture otevřete 3D pohled a připravte ho k exportování. 
Klepněte na nabídku File → Export → 3ds Max (FBX). Pokud je volba šedivá a nelze ji ote-
vřít, otevřete 3D pohled projektu. Pak zkuste export znovu. 
Pojmenujte soubor a klepněte na tlačítko Save.

Revit Architecture vygeneruje soubor FBX a uloží jej. Nyní můžete importovat soubor FBX do 
3ds Max prostřednictvím plug-inu FBX. 
Potěšující zprávou pro uživatele Revitu je fakt, že i Revit materiály mají stejné charakteristiky 
(terminologii) jako v 3ds Max, takže nebude činit větší problém rychle se zorientovat. 
Postup importu Revit modelu do 3ds Max zachycují následující kroky:

Před importem FBX souboru se ujistěte, že máte správně nastavené systémové měrné 
jednotky v Maxovi. 
V nabídce File → Import (vyberte FBX) otevřete požadovaný soubor a importujte. Objeví 
se dialog jako na obrázku 4.5. Všimněte si verze uvedené v záhlaví dialogu.
Až si vyberete nastavení, které je pro vás přijatelné (moc možností zde nemáte, spíš jen 
nastavte jednotky a zaškrtněte pole, které typy objektů chcete importovat).
Potvrďte import klepnutím na tlačítko OK, 3ds Max rozpozná všechny aspekty včetně 
materiálů, světel (dokonce i systém Daylight) a kamer, které naimportuje do scény.

Poslední verzi plug-inu FBX si můžete zdarma stáhnout pro aktuální verzi 3ds Max na adrese 

http://www.autodesk.com/fbx.

Vizualizace strojařských 3D modelů z Inventoru
Pokud chcete importovat soubory ze strojařské aplikace Autodesk Inventor, využijte k tomu 
nativní souborové formáty IPT (parts) a IAM (assemblies). Po importu budou mít modely 
podobu editovatelné sítě (Editable Mesh), s níž můžete pracovat stejně jako s jinými typy objektů 
v 3ds Max. Postup importu objektů Inventoru do 3ds Max je následující:

Předpokladem importu je nepříjemné omezení, že musíte mít na stejném počítači nain-
stalovaný společně 3ds Max i Inventor. Další omezení spočívají v nemožnosti importu 
animace kamery, světel nebo některých omezení pohybu částí modelu. To vyžaduje 
provést adekvátní činnosti znovu v 3ds Max. 
Klepněte na hlavní nabídku File → Import.
Vyberte typ souborů Autodesk Inventor (*.IPT, *.IAM).
Vyberte soubor, který chcete importovat.
Nastavte možnosti na dialogu Autodesk Inventor File Import a stiskněte tlačítko OK.

Dotažení 3D modelu k dokonalosti – Autodesk Mudbox
V kapitole o modelování se dozvíte mnohem více o tomto úžasném nástroji, v němž se můžete 
stát skutečným digitálním umělcem. V této kapitole se podíváme pouze na možnosti exportu 
modelů z 3ds Max do Mudboxu, popřípadě jiných aplikací. Pokud chcete komunikovat s touto 

1.

2.

3.

1.

2.

3.

4.

1.

2.

3.

4.

5.

POZNÁMKA
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aplikací pro detailní high-poly modelování, musíte modely exportovat do formátu OBJ. To 
provedete takto:

S hotovým modelem přejděte do nabídky File → Export.
Zadejte název exportovaného souboru a vyberte možnost gw:: OBJ-Exporter (*.OBJ).
Objeví se dialog OBJ Export Options. Dole v části Preset vyberte možnost Mudbox. 
Všimněte si celé škály dalších aplikací, do nichž můžete prostřednictvím formátu OBJ 

1.

2.

3.

Obrázek 4.5. Průvodce importem formátu FBX do 3ds Max

NEJČASTĚJI VYUŽÍVANÉ VÝMĚNNÉ FORMÁTY
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exportovat. Pokud klepnete na tlačítko napravo od rozevíracího seznamu, otevře se dia-
log Edit OBJ-Export Presets, kde si můžete přizpůsobit hodnoty pro vybranou aplikaci.

3D modely Mayi v Maxovi
Autodesk 3ds Max a Autodesk Maya jsou zřejmě nejpoužívanější aplikace pro tvorbu 3D ani-
movaného obsahu. Někteří autoři preferují specifické postupy v jedné nebo druhé aplikaci. 
I na velkých filmových dílech se mohou účastnit obě aplikace současně, nijak se nevylučují, ba 
naopak doplňují. I když mají obě aplikace celkem jasně vymezené tržní segmenty (Maya spíše 
pro film, Max pro hry a vizualizace), mohou vytvořit pro 3D tvůrce výhodnou symbiózu. Proto 
je vhodné znát způsoby interoperability (spolupráce) obou aplikací. Společnou řečí pro obě 
aplikace jsou formáty FBX a OBJ, které jsme si popsali v předchozích bodech. 

Rozšíření vlastností Maxe pomocí 
externích aplikací a plug-inů
3ds Max v sobě obsahuje také nástroje pro tvorbu dalších softwarových doplňků, které obohatí 
jeho možnosti. Tzv. plug-iny můžete psát prostřednictvím aplikačního programového rozhraní 
API. Jednou z odlišností mezi 3ds Max a 3ds Max Design je právě dostupnost vývojářské sady 
Software Development Kitu (SDK) pro 3ds Max. Server www.maxplugins.de nabízí opravdu 
rozsáhlou základnu takových plug-inů z různých oblastí (efekty, objekty, animace, světla, filtry, 
renderery a další), ať komerčních nebo volně dostupných. Následující podkapitoly popisují 
některé často používané zásuvné plug-iny využitelné v profesionální tvorbě. 

Stromy a vegetace
Společnost Onyx Computing se specializuje na tvorbu plug-inů a aplikací pro procedurální 
tvorbu stromů a různorodé vegetace. Nabízejí k zakoupení samostatné aplikace na tvorbu bam-
busů, listnatých stromů, jehličnanů, květin, trávy nebo palem. Můžete zde získat i plug-iny pro 
Maxe, a to buď Tree Storm, nebo Onyx2Max, takže přímo v Maxovi můžete upravovat dodané 

Obrázek 4.6. Dialog importování souborů Inventoru do 3ds Max
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stromy vytvořené v aplikaci Onyx. Onyx2Max je plug-in, který umožňuje přímo importovat 
modely vegetace včetně textur vytvořené v aplikaci Onyx (z proprietárního formátu ONX). 
Pokud vážně uvažujete o tvorbě vegetace, přečtěte si více informací na www.onyxtree.com. 
Další plug-in pro Maxe související s vegetací je Forest Pack. Už jste chtěli vytvořit tisíce stro-
mů, ale 3D geometrie velmi brzy po několika desítkách stromů zahltila systémové prostředky 
a paměť počítače? Pak se vám bude zamlouvat plug-in Forest Pack, pomocí něhož můžete 
vytvořit rozsáhlé prostory s vegetací, jehož předností je především úspora paměti při takovém 

Obrázek 4.7. Prostřednictvím formátu OBJ můžete komunikovat kromě Mudboxu s mnoha další-
mi aplikacemi. Autodesk Mudbox vám umožní detailizovat 3D model pomocí speciálních modelo-
vacích nástrojů. Zdroj: Produktová stránka Autodesk Mudbox

ROZŠÍŘENÍ VLASTNOSTÍ MAXE POMOCÍ EXTERNÍCH APLIKACÍ A PLUG-INŮ
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Obrázek 4.8. Onyxtree je dostupný také jako plug-in pro 3ds Max. Můžete vytvořit široké spekt-
rum jehličnatých i listnatých stromů. Autorem tohoto obrázku je Brian Smith ze společnosti 3DATS.

Obrázek 4.9. Předností Forest Pack je možnost práce s mnoha tisíci stromy, které byste se skuteč-
nými 3D modely jen stěží v Maxovi rozpohybovali
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množství stromů. Společnost Itoo Software (www.itoosoft.com) nabízí kromě komerční verze 
také volně dostupnou variantu Forest Lite. Ta je v některých funkcích omezená v porovnání 
s komerční Forest Pack Pro. 

Podívejte se také na stránky společnosti Bionatics (www.bionatics.com), která se taktéž zabývá 

dodávkami aplikací a plug-inů pro tvorbu stromů a vegetace. Pomocí jejich plug-inu natFX 

můžete simulovat a animovat růst stromů, měnit roční období a variace vegetace a především 

zachovávat nízký počet polygonů pro snadnou manipulaci a rychlé renderování.

Volumetrické efekty – plyny, mračna
Afterburn je osvědčený plug-in společnosti Sitni Sati pro tvorbu volumetrických efektů hodných 
filmových trháků jako Matrix Reloaded, Let Fénixe, Armageddon nebo Dracula 2000. Řešení 
je založeno na částicích, které dohromady tvoří shluky či mračna a vytvářejí mohutné oblaky 
vhodné pro napodobení kouřových mračen či plynů. Jestliže budete vytvářet exploze, rádi 
budete animovat průlety oblaky, podívejte se na stránky www.afterworks.com. Společnost nabízí 
podobný plug-in FumeFX, který poskytuje dynamický engine pro tvorbu kouře a prachu.

Hory a exkluzivní scenerie
Když se rádi procházíte po virtuálních horách, můžete vyzkoušet plug-in DreamScape (od spo-
lečnosti Sitni Sati). Jedná se o důmyslnou sadu nástrojů pro tvorbu a renderování realistických 
hor, moří a oceánů, nebes a venkovního osvětlení. Můžete po modelu malovat a aplikovat tak 
vyvýšeniny i eroze. Dreamscape dokáže importovat i digitální modely terénu (DEM) a Terra-
gen soubory. 
Další samostatnou aplikací pro tvorbu hyperrealistických scenerií je výše zmíněná aplikace 
Terragen (www.planetside.co.uk). Co dokáže, vidíte na obrázku 4.11. Pro Terragen je dostup-
ných mnoho dílčích plug-inů a lze ho integrovat s několika dalšími 3D aplikacemi (Lightwave, 

POZNÁMKA

Obrázek 4.10. Pokud jste nadšenci všech možných kouřových efektů, mračen či explozí, bude pro 
vás Afterburn nebo FumeFX opravdovou zábavou

ROZŠÍŘENÍ VLASTNOSTÍ MAXE POMOCÍ EXTERNÍCH APLIKACÍ A PLUG-INŮ
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Maya, Blender nebo Cinema 4D). Pomocí plug-inu TG-MAX můžete vaše výtvory z Terragenu 
přenášet do 3ds Max.

Obrázek 4.11. Terragen je velmi výkonná aplikace pro tvorbu 3D scenerií včetně světel a materiá-
lů. Existuje i dostupný plug-in pro import výstupů z Terragenu do 3ds Max (TG-MAX).

Oživte scénu lidmi nebo auty
Architektonické vizualizace byste měli oživit fotorealistickými objekty, jako jsou lidé, auta 
na silnici nebo stromy, různým vybavením, okolním prostředím, popřípadě dalšími objekty. 
K tomuto účelu můžete použít plug-in RPC 3.0 od společnosti Archvision (www.archvision.
com). Prostřednictvím plug-inu RPC (Rich Photorealistic Content) můžete do scény přidávat 
velmi reálně vzhlížející objekty, které budou vypadat jako skutečně prostorové 3D modely, 
i když jde ve skutečnosti o sadu planárních (rovinných) vhodně orientovaných objektů. 
Technologie RPC využívá vysoce kvalitní obrázky kombinované s nízkopolygonální geometrií 
pro tvorbu iluze 3D modelu. V potaz se bere také pohyb kamery, takže se objekt jeví jako sku-
tečně třírozměrný. Tohoto výsledku se dosáhne bez nutnosti využití objektů s vysokým počtem 
polygonů, což by bylo při větším množství objektů ve scéně neefektivní. Umístěním RPC 
zástupce do scény je při renderování zjištěna nejlepší orientace (pohledový úhel) vzhledem 
k umístění kamery. Obrázky utvářející objekt jsou pak patřičně spojeny, aby byla vytvořena 
iluze kompletního 3D modelu (včetně náhledu z výšky, tedy podle osy Z). Animace jsou tedy 
s těmito objekty možné, aniž by výstup vypadal nereálně nebo v horším případě komicky.
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Další typy plug-inů a jejich správa
Když si vyberete svůj plug-in, který vám ušetří práci, musíte ho zaintegrovat do 3ds Max. 
Pokud jde o „větší“ aplikaci ve smyslu předchozích kapitol, budete mít nejspíš instalační sadu, 
která se postará o vše za vás. Pokud ale narazíte na plug-in, který má souborovou koncovku 
.dlc, .dlr, .dlo, .dlu, .dlv, nebo .dlm, měli byste ho nahrát do složky \plug-ins, o níž Max ví. Při 
spuštění Max tyto soubory načítá automaticky. 

Kde najdu, jaké plug-iny mám nainstalované?
Pokud se chcete podívat, jaké plug-iny máte nainstalované (včetně těch dodávaných standard-
ně v 3ds Max), přejděte do nabídky File → Summary Info (ve verzi 2010 tento příkaz najdete 
pod aplikační ikonou → Properties) a pak klepněte na tlačítko Plug-In Info. Zobrazí se dialog 
zobrazující seznam všech dostupných plug-inů.

Správa dostupných plug-inů
Pokud si chcete nově získaný plug-in načíst a začít ho používat bez nutnosti restartovat 3ds 
Max, můžete to provést z nabídky Customize → Plug-in Manager. Objeví se stejnojmenný dialog 
jako na obrázku 4.13.
Klepnutím pravým tlačítkem myši kamkoli do seznamu s plug-iny se objeví místní nabídka. 
Pokud vyberete Load New Plug-in, můžete nalistovat váš oblíbený plug-in a načíst ho pro použití.

Obrázek 4.12. Autor Ed Heidenreich ze společnosti Eppstein Uhen Architects využil ve scéně lidi 
i stromy díky plug-inu RPC

DALŠÍ TYPY PLUG-INŮ A JEJICH SPRÁVA
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Záleží pak na konkrétním plug-inu, kde se v uživatelském rozhraní 3ds Max objeví. Podívejte 
se do uživatelské příručky tohoto plug-inu.

Zdroje plug-inů
Pokud se rozhodnete systematicky hledat pro vaši verzi 3ds Max plug-iny (všech možných 
kategorií – animační, atmosférické, importní/exportní, materiálové, modifikátory, částicové, 
procedurální objekty a další), můžete použít následující zdroje:

www.turbosquid.com
www.digimation.com
www.maxplugins.de
www.afterworks.com

Rozhodně byste také měli zhlédnout stránky Autodesku, kde najdete seznam certifikovaných 
plug-inů, testovaných pro kompatibilitu s 3ds Max (http://usa.autodesk.com/adsk/servlet/item?
siteID=123112&id=5682049).  

Načítejte plug-iny do paměti, jen když je to třeba
Není účelné pokaždé načítat do paměti všechny instalované plug-iny. V nabídce Customize → 
Preferences → karta General → Plug-In Loading → Load Plug-ins When Used můžete zapnutím této 
volby zajistit, že se plug-iny budou načítat pouze v případě, když je skutečně použijete.

Externí aplikace
Ještě než začnete vytvářet komplexní projekt v 3ds Max, dobře se seznamte s možnostmi 
externích aplikací, které mohou řešit konkrétní oblasti vašeho zájmu, na které se Max tolik 

�

�

�

�

Obrázek 4.13. Správa plug-inů prostřednictvím dialogu Plug-in Manager. Zde můžete plug-iny 
načítat nebo vypínat přímo z 3ds Max.
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nespecializuje. Nemusí jít přímo o plug-iny, ale o specializované aplikace. Nesnažte se tedy za 
každou cenu vytvořit vše v 3ds Max, můžete si práci zjednodušit využitím účelově zaměřené 
aplikace. Následující kapitoly přibližují několik softwarových řešení, která by se vám během 3D 
tvorby mohla hodit.

Tvorba přírodních scenerií
Například společnost e-on software nabízí produkt Vue 7, který se zaměřuje na tvorbu sce-
nerií beroucích dech. Aplikace Vue 7 Infinite a Vue 7 xStream mají širší záběr, a to i v oblasti 
animace, architektury, produktové vizualizace. Více informací najdete na stránkách výrobce 
http://www.e-onsoftware.com.

Obrázek 4.14. Ukázka scény z aplikace Vue 7 nazvané „Cerro Verde“ od Erana Dinura. Takového 
výsledku dosáhnete ve Vue 7 jednodušeji než v 3ds Max.

Kouzla s tekutinami
Viděli jste reklamy a kouzelné vizuální efekty s tekutinami? Chcete poručit vodě a pohrávat 
si s fyzikálními zákony? Je vaší snahou dosažení realistických simulací? Naučte se pracovat 
s Realflow od společnosti Next Limit Technologies. Moto společnosti „Bringing Science & 
Simulation Together“ (spojujeme vědu a simulaci) vystihuje možnosti aplikace. 
S využitím reálných vlastností tekutin s širokými možnostmi parametrizace můžete ztvárnit 
téměř libovolnou představu. Tekutiny mohou kolidovat také s okolím, což vám umožňuje 
vytvářet simulace vhodné pro filmové efekty či realistické animace. Aplikace je založená na 

EXTERNÍ APLIKACE
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technologii XPH (Extended Particle Hydrodynamics) spočívající v přesných možnostech 
simulací a kolizí kvant částic tvořících tekutiny. Přirozený způsob chování činí tuto aplikaci 
skutečnou špičkou v oboru. Navštivte stránky www.nextlimit.com nebo www.realflow.com, kde 
si můžete stáhnout demoverzi nebo si prohlédnout ukázky z projektů.

Obrázek 4.15. Realflow vás může posunout do oblasti profesionálních efektů hodných celovečer-
ních filmů. Jestli chcete vyzrát nad gravitací a okouzlit publikum simulovanými efekty s tekutina-
mi, Realflow je právě pro vás.

Autor: společnost WOW, Tokyo. Zdroj: http://www.realflow.com/n_cs_zero.htm.

Generování 3D postavy
I když Max obsahuje nástroje pro tvorbu obecné postavy, je zde nutné vytvořit model svépo-
mocí a od základu (pokud zrovna neimportujete hotový model). Cesta k vytvoření kompletní 
postavy může být složitá. Specializovaná aplikace Poser od společnosti Curious Labs se zamě-
řuje na jednoduchou tvorbu 3D postav a nabízí také základní knihovny lidských, zvířecích, 
robotických a pohádkových postav. Současně nabízí funkce pro animaci a renderování lidských 
a zvířecích postav. Také obsahuje možné pózy, vlasy, pomocné objekty, textury a gesta včetně 
obličejových výrazů. Neumožňuje však modelovat základní objekty.

Animování postav
I přestože můžete animovat postavy přímo v 3ds Max prostřednictvím Character Studia, které 
bude předmětem kapitoly o animaci, nabízí Autodesk specializovanou aplikaci MotionBuilder 
pro profesionální přístup k animaci postav. Jedná se o výkonný software, v němž vdechnete 

POZNÁMKA
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život 3D postavám určeným pro hry, filmy i multimedia. Vhodně doplňuje 3D aplikace 3ds 
Max i Maya, s nimiž si data můžete vyměňovat prostřednictvím formátu FBX. 
Definujete zde také interakce s dalšími objekty, aby nedocházelo k nežádoucím pronikáním 
objektů a postavy. Simulace pádů a složitějších animací postavy v reálném čase (tzv. ragdoll) 
značně zjednodušuje a eliminuje nutnost náročné manuální animace. Nechte počítač pracovat 
za vás! Zobrazování hardwarově akcelerovaných světel a materiálů v reálném čase (díky nové 
CgFX knihovně) umocní zkušenost z animace na další úroveň. Podpora 64bitových operačních 
systémů a programovacího jazyka Python činí kromě jiného MotionBuilder vhodnou aplikací 
pro animátory postav jako doplněk 3ds Max.

Procedurální textury – výběr map pro vaše projekty
Vynikající aplikace Genetica je nástroj pro tvorbu textur a map použitelných ve vašich projek-
tech. Najdete zde přes 700 volně použitelných textur (cihly, stavby, krystaly, dveře, podlahy, 
zdi, tekutiny, středověké struktury, mramor, kovy, planety, sníh a led, kameny, terény, pouště, 
skály, vulkanické a plynné materiály nebo okna). Na výběr je mnoho vzorků, které si můžete 
nechat vyrenderovat ve vysokém rozlišení (až 2 048 × 2 048). Prohlížeč i balík textur si můžete 
stáhnout u výrobce aplikace, společnosti Spiral Graphics, na adrese www.spiralgraphics.biz. 

Skripty v jazyce MAXScript
Kromě plug-inů, k jejichž vývoji můžete použít SDK (Software Development Kit = sada vývo-
jářských nástrojů) Maxe, je další alternativou obohacení schopností 3ds Max tvorba skriptů. 
Jejich vývoj bude náplní patnácté kapitoly. V této části si jen zmíníme jejich možnost, spuštění 

Obrázek 4.16. Hotový model postavy v aplikaci Poser společnosti Curious Labs. Specializované 
funkce a parametry pro animaci a přizpůsobení vzhledu postavy včetně knihovny postav činí tuto 
aplikaci špičkou v oboru.

EXTERNÍ APLIKACE
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Obrázek 4.17. MotionBuilder je pro animátory 3D postav vhodným doplňkem k 3ds Max

Obrázek 4.18. Genetica je vynikající aplikace se spoustou volně dostupných procedurálních 
textur, které můžete použít ve svých projektech. Ve sbírce obsahující více než 700 textur si určitě 
vyberete pro libovolný projekt.
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v 3ds Max a podíváme se na některé dostupné zdroje se skripty zdarma ihned použitelnými ve 
vašich projektech. Co je tedy MAXScript?
MAXScipt je skriptovací jazyk Maxe, prostřednictvím něhož můžete vytvářet programový kód 
automatizující určitou činnost, která obohatí základní funkční vybavení 3ds Max. Pokrývá 
všechny oblasti 3ds Max – od modelování po renderování. Je objektově orientovaný a jeho syn-
taxe je přátelská i vůči začátečníkům, takže i když nemáte s programováním žádné zkušenosti, 
nemělo by vám jeho zvládnutí činit větší problémy. 

Zdroje skriptů a jejich spuštění
Pokud nejste zrovna programátorské povahy, asi upřednostníte stahování skriptů před jejich 
tvorbou. Vynikajícím zdrojem volně dostupných skriptů je server www.scriptspot.com. A co 
skripty umožňují? Jsou velmi podobné plug-inům, zaměřují se na zjednodušení konkrétních 
kroků v 3ds Max ve všech oblastech a umožňují jedním klepnutím vytvořit složitější paramet-
rické objekty. Skripty jsou soubory s koncovkami *.ms, *.mse, *.mcr, *.mzp a *.ds.
Skript spustíte takto:

Klepněte na hlavní nabídku MAXScript → Run Script nebo obdobně z příkazového pane-
lu → panel Utilities. 
Vyberte uložený skript a potvrďte tlačítkem Otevřít.

Většinou se po spuštění nic nestane, nevyskočí na vás žádný dialog, který by vám představil 
novou funkci. Nastudujte proto přiložené informativní soubory skriptů od jejich autorů, které 
popisují, kde skripty v rámci rozhraní 3ds Max po instalaci najdete. Většinou je najdete po 
spuštění nabídky Customize → Customize User Interface mezi ostatními příkazy.

1.

2.

Obrázek 4.19. Skript Facemaker automatizuje postup tvorby lidské hlavy. Pouhým klepnutím vytvoříte 
hrubý model, který můžete parametricky měnit dle svého vkusu. Dalšími modelovacími technikami 
docílíte finálního modelu. Autorem tohoto skriptu je Bruce Forel. Asi je vám jasné, co skripty dokážou!

SKRIPTY V JAZYCE MAXSCRIPT
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Obrázek 4.20. Skript Advanced Painter vám dovolí kreslit po povrchu objektu a vytvářet tak 
další objekty. Obrovská úspora času, když si představíte, že byste například stébla trávy nebo jiné 
objekty měli umisťovat ručně. Autorem tohoto skriptu je Herman Saksono.

n

o
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Obrázek 4.21. Skript Biped to Bones dokáže zkonvertovat strukturu bipeda (lidská kostra jako 
objekt generovaný v 3ds Max) na obecné kosti. S těmi můžete libovolně nakládat a vytvářet sofis-
tikované modely pro účel animace. Autorem tohoto skriptu je Jason Labbé.

Takových skriptů najdete na Internetu mnoho. Pokud správně formulujete dotaz do vyhledáva-
če, s největší pravděpodobností již někdo skript vyhovující vašim představám vytvořil. Šetřete 
si svůj čas využíváním šikovných plug-inů a skriptů!

SKRIPTY V JAZYCE MAXSCRIPT
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Tvorba 

základních 

objektů

V této kapitole se naučíte vytvářet základní objekty, z nichž 
můžete modelovat složitější 3D modely. Specifické objekty, 
jako jsou částicové systémy pro tvorbu vizuálních efektů nebo 
kamery, si probereme v příslušných kapitolách o animaci. 
V této části se budeme věnovat základním stavebním blo-
kům pro tvorbu 3D modelů. Pokud se naučíte dobře ovládat 
a přizpůsobovat základní objekty, budete na nejlepší cestě za 
zvládnutím všech modelovacích technik. Po úvodních kapito-
lách, v nichž jste se seznámili s rozhraním Maxe, ovládáním 
výřezů, světem plug-inů a skriptů a dalšími dílčími metoda-
mi přizpůsobení rozhraní, začíná skutečná vizuální zábava. 
Pojďme na to!

Kategorie základních 
geometrických primitiv
Když se podíváte do hlavní nabídky Create, najdete zde všechny 
typy objektů, které můžete v 3ds Max vytvořit. Od 3D primitiv 
(Standard a Extended Primitives) až po světla a kamery (Lights 
a Cameras). Nejprve se podíváme na 3D objekty, konkrétně 
asi nejpoužívanější – kvádr. Klepněte na hlavní nabídku Create 
→ Standard Primitives → Box. Otevře se také příkazový panel 
vpravo, odkud můžete tvořit ty samé objekty.

Postup tvorby objektů
Na příkladu tvorbu krabice (Box) si ukážeme princip tvorby 
všech ostatních objektů. 

S aktivním tlačítkem „Box“ na příkazovém panelu 
klepněte do perspektivního výřezu a držte levé tlačítko 
myši.
Táhněte s myší, vytvoříte podstavu krabice (kvádru).

1.

2.

5
K A P I T O L A

Témata kapitoly:

Kategorie základních 

geometrických primitiv

Ostatní typy geometrických 

objektů

�

�
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Pusťte levé tlačítko myši a pohněte s myší směrem nahoru. Vytvoříte přibližnou výšku 
kvádru (přesné hodnoty zadáme později). 
Až budete spokojeni s výškou kvádru, klepněte znovu pravým tlačítkem myši, čímž ji 
potvrdíte.
Klepněte pravým tlačítkem myši k ukončení tvorby dalších kvádrů (tento bod si osvojte, 
bude se velmi hodit!).

Obrázek 5.1. Z jednoduché krabice můžete vytvořit i tak složitý objekt, jako je 3D model postavy. 
Při pohledu na jednoduchý kvádr je to ale poněkud frustrující situace. Jakmile zvládnete modelo-
vací principy, začnete opakovaně využívat již hotové části modelů a práci budete odvádět rychleji.

Vyzkoušejte si obdobně tvorbu dalších objektů, kterými jsou:
Koule (Sphere)
Válec (Cylinder)
Prstenec (Torus)
Čajová konvice (Teapot)
Kužel (Cone)
Zeměkoule (Geosphere)
Tubus (Tube)
Pyramida (Pyramid)
Rovina (Plane)

Co stojí za zmínku, je rozdíl mezi koulí a geosférou. Zatímco klasická koule (Sphere) se skládá 
ze čtvercových polygonů, které se směrem k pólům zmenšují, a má tedy nerovnoměrné roz-

3.

4.

5.

�

�

�

�

�

�

�

�

�
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ložení detailu po povrchu, geosféra je složená z trojúhelníkových ploch, které jsou rozloženy 
rovnoměrně po povrchu. Pro modelování i rychlost renderování je lepší objekt Geosphere.

Pojmenování a přizpůsobení vzhledu objektů 
pomocí parametrů
Když vytváříte objekty v pracovním výřezu obdobně jako kvádr v předchozím postupu, není 
možné docílit přesných rozměrů. Proto vždy po dokončení tvorby přibližného tvaru přejděte 
na panel Modify, kde se s vybraným objektem objeví dostupné parametry. Pojďme si to ukázat 
na příkladu krabice a válce.
Přizpůsobení parametrů kvádru (krabice) a jeho pojmenování provedete následovně:

S dokončeným objektem kvádru klepněte na panel Modify (viz obrázek 5.3).
Nahoře se objeví pole pro zadání názvu objektu (na obrázku „Můj kvádr“). Tento 
postup považujte za striktně daný. Pokud totiž nebudete objekty pojmenovávat, můžete 

1.

2.

Obrázek 5.3. Modifikační panel je srdcem Maxe pro úpravu 
vzhledu a parametrů objektu. Pokud si nevystačíte jen s objek-
tem vytvořeným od oka

KATEGORIE ZÁKLADNÍCH GEOMETRICKÝCH PRIMITIV

Obrázek 5.2. Základní geometrická primitiva (Standard Primitives) pohromadě

Box

Sphere

Cylinder

Torus
Teapot

Cone
Geosphere Tube Pyramid

Plane
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se v desítkách takových kvádrů (například okna, dveře a podobně) rychle ztratit. 
Pojmenovávejte si všechny objekty! Klepnutím na barevný vzorek napravo od názvu 
můžete přiřadit objektu libovolnou barvu.
Rozbalovací seznam nazvaný Modifier List nabízí velmi dlouhou nabídku tzv. modifiká-
torů. Ty mění vzhled objektů aplikováním funkcí pro ohýbání, kroucení, protahování 
a mnoho dalších. S nimi se seznámíme v kapitole o modelování.
Slovo Box představuje typ vytvořeného objektu a nachází se v tzv. zásobníku modifikáto-
rů. Přidáváním modifikátorů nad záznam objektu (Box) ze seznamu Modifier List můžete 
měnit tvar objektu. Pořadí modifikátorů je důležité, jak uvidíme u modelovacích tech-
nik! Řada ikon pod zásobníkem se týká především práce s modifikátory.
Konečně rozevírací seznam parametrů pojmenovaný Parameters představuje místo, kde 
měníte vzhled objektu. U kvádru jsou to parametry délka (length), šířka (width) a výška 
(height). Pokud jste nastavili měrné jednotky, uvidíte je v těchto polích. 
Klíčovým předpokladem efektivního modelování je správný odhad detailů modelu. Ty 
určíte zadáním hodnot do polí Segments. Přidávejte nejmenší možný počet segmentů, 
který vystihuje všechny základní rysy finálního modelu. Nikdy to se segmenty nepřehá-
nějte, protože čím více segmentů, tím hůře se vám bude model ovládat a přizpůsobovat 
do výsledné podoby pomocí modelovacích technik. Segmenty (někde zkráceně Segs) 
najdete u většiny základních primitiv.

3.

4.

5.

6.

Obrázek 5.4. Detaily modelu ovládáte parametrem Segments

Segments
Length/Width/Heigh = 10/10/10

Segments
Length/Width/Heigh = 2/2/2
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Přizpůsobení parametrů válce (cylinder):
Vytvořte válec klepnutím na tlačítko Cylinder na příkazovém panelu. Alternativou tvor-
by válce je opět hlavní nabídka Create → Standard Primitives → Cylinder.
Přejděte na panel Modify. Najdete zde základní parametr Radius (poloměr podstavy) 
a Height (výška). Opět zde vidíte parametr Segments, a to v podobě Height Segments 
(segmenty válce do výšky) a Cap Segments (segmenty válce na horní a dolní podstavě).
Parametr Sides určuje počet stran podstavy. Zní to divně, ale z válce můžete vytvořit 
i kvádr (válec se čtyřmi stranami), obecně hranol s libovolným počtem hran (Sides).

Hromadné přejmenování objektů můžete provést příkazem z hlavní nabídky Tools → Rename 

Objects.

Základní objekty můžete vytvářet také metodou vstupu z klávesnice. Například na místo 

vytvoření kvádru vizuálně v pracovním prostředí nejprve zadáte jeho rozměry, vše nadefinujete 

a poté stisknete tlačítko Create v rozevíracím seznamu Keyboard Entry. Tento seznam se objeví, 

když klepnete na tlačítko příslušného objektu na příkazovém panelu (nebo z hlavní nabídky 

Create a Standard nebo Extended Primitives). Tento princip platí jen před tvorbou objektu. 

Měnit parametry po jeho vytvoření můžete jen na panelu Modify.

Každý objekt má samozřejmě své vlastní parametry. Přesto mají některé z nich společné para-
metry (délka, šířka, poloměr, segmenty, řez a podobně). Například z koule (Sphere) můžete 

1.

2.

3.

Obrázek 5.5. Standardní válec vlevo, s pěti stranami podstavy uprostřed a zapnutým 
řezem (aktivní pole Slice On, pole Slice From = 260 stupňů) vpravo. Možnost řezu (Slice) 
zadaného ve stupních je dostupná u více objektů.

TIP

POZNÁMKA

KATEGORIE ZÁKLADNÍCH GEOMETRICKÝCH PRIMITIV
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vytvořit polokouli zadáním hodnoty 0.5 v poli Hemisphere s vybranou koulí na modifikačním 
panelu.
Vytvořte si v rámci cvičení všechny základní i rozšířené objekty a vyzkoušejte si měnit jejich 
parametry. Jedině tak získáte základní představu o smyslu parametrů. Na tomto místě bych 
považoval za plýtvání místem popisovat všechny parametry všech objektů. Je to totiž ideální 
prostor k samostatnému cvičení.

Využití rozšířených tvarů
Základní tvary objektů se nemusí vždy přibližovat tvaru vašeho výsledného zamýšleného 
modelu. Proto bývá dobré podívat se ještě do dalších typů objektů – rozšířených primitiv 
(Extended Primitives). Ty nabízejí 13 objektů, které vám mohou pomoci v nalezení základní 
formy. Na obrázku 5.6 vidíte všechna primitiva, která najdete kromě příkazového panelu také 
v hlavní nabídce Create → Extended Primitives. 

Všestranný objekt Hedra – vytváříme diamanty a ozdoby
Rozšířený objekt Create → Extended Primitives → Hedra dokáže napodobit mnoho tvarů, jak 
vidíte na obrázku 5.7. Zkuste si přepínače Tetra, Cube/Octa, Dodec/Icos, Star1 a Star2 společně 
s parametry P a Q ve skupině parametrů Family Parameters a Axis Scaling. Dosáhnete nespočtu 
různých kombinací.

Zaoblení hran krychle
Chtěli byste vytvořit desku stolu, ale standardní objekt Box má příliš ostré hrany? Použijte Box 
se zkosenými hranami – ChamferBox. Ten má oproti klasickému kvádru dva nové parametry 

Obrázek 5.6. Přehled rozšířených objektů, které můžete využít jako startovací stavební kámen 
vašich složitějších modelů

Hedra

ChamferBox OilTank
Spindle

Gengon

Prism
Torus Knot ChamferCyl Capsule

Hose

RingWave
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– Fillet a Fillet Segs. Jde o hodnoty poloměru zaoblení hrany (Fillet) a počet detailů či segmentů 
v tomto zaoblení (Fillet Segs). Čím vyšší bude parametr Fillet, tím větší zaoblení krychle až do 
tvaru koule.

Prstencové vizuální efekty a otřesové vlny (Ringwave)
Z nabídky Create → Extended Primitives → Ringwave vytvoříte tvar podobný tomu na obrázku 5.8. 
Jde o prstencový objekt, který může být na vnějším i vnitřním okraji různě formovaný. Co je ale 
zajímavější, je fakt, že můžete tyto parametry animovat a vytvářet tak iluzi prstencových efektů 
podobných otřesovým vlnám při velkých explozích. K tomu je ještě potřeba přidat kvalitní 
oboustranný materiál.

Hadice spojující dva objekty
Z nabídky Create → Extended Primitives → Hose vytvoříte flexibilní objekt – konektor – spojující 
dva objekty. Na obrázku 5.9 vidíte využití, kdy je hadice připnutá ke dvěma válcům. Když 
pohnete válcem, hadice následuje. Postup aplikování je následující:

Vytvořte dva objekty, konce, ke kterým hadici připojíte.
Vytvořte objekt Hose.
S vybraným objektem Hose na modifikačním panelu vyberte možnost Bound To Object 
Pivots, čímž vyberete možnost přichycení hadice ke dvěma objektům.
Pak klepněte na tlačítko Pick Top Object a vyberte jeden konec (záchytný objekt). Totéž 
proveďte s tlačítkem Pick Bottom Object a druhým koncem (objektem).

1.

2.

3.

4.

Obrázek 5.7. Objekt Hedra dokáže pouze změnou přepínačů na modifikačním panelu radikálně 
změnit tvar. Může se vám hodit pro vytvoření různých ozdob nebo drahých kamenů.

KATEGORIE ZÁKLADNÍCH GEOMETRICKÝCH PRIMITIV
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Nastavte parametry tvaru hadice (například parametr Cycles zvýší počet otáček hadice, 
popřípadě Tension (pnutí) u obou konců může zvýšit přilnavost spíše k jednomu nebo 
druhému konci.

Parametrické zdi, dveře, schody, okna a stromy
3ds Max nabízí také pokročilejší objekty pro vaši tvorbu. Jedná se o následující objekty:

Dveře (hlavní nabídka Create → AEC Objects → Pivot, Sliding a BiFold Doors)
Zdi (hlavní nabídka Create → AEC Objects → Wall)
Schody (hlavní nabídka Create → AEC Objects → Straight, L-Type, U-Type a Spiral Stair)
Okna (hlavní nabídka Create → AEC Objects → Awning, Casement, Fixed, Pivoted, Sliding 
a Projected Door)
Stromy (hlavní nabídka Create → AEC Objects → Foliage)
Hrazení (hlavní nabídka Create → AEC Objects → Railing)

5.

�

�

�

�

�

�

Obrázek 5.8. Rozšířený objekt Ringwave dokáže napodobit prstencové tlakové a otřesové vlny. 
Kromě toho můžete změnou parametrů samozřejmě vytvářet různé animované efekty.
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Tvorba dveří
Ještě než začnete tvořit vybraný typ dveří, podívejte se na příkazový panel do rozevírací 
nabídky Creation Method. Všechny dveře tvoříte standardně podle metody Width/Depth/Height 
(Šířka/Hloubka/Výška). To si uvědomte při tažení myši v pracovním výřezu a zejména ve 
vytvářených proporcích (prvním tahem vytvoříte šířku, druhým hloubku a třetím výšku). Při 
chybně vytvořených poměrech je pak nesnadné rychle se zorientovat, kde je výška, šířka nebo 
hloubka dveří. Parametrem Open dveře otevíráte, můžete ho i animovat. 

KATEGORIE ZÁKLADNÍCH GEOMETRICKÝCH PRIMITIV

Obrázek 5.9. Objekt Hose (hadice) můžete použít ke spojení mezi dvěma objekty, 
kdy pohybem libovolného konce bude hadice pružně reagovat
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Dvě křídla dveří z jednoho bloku vytvoříte zapnutím pole Double Doors. Pokud chcete prohodit 
směr otevírání dveří, zapněte pole Flip Swing. Panty dveří kouzelně přehodíte na druhou stranu 
pomocí Flip Hinge. Rámy dveří definujete v části Frame rozevírací nabídky Parameters. Další 
rozevírací nabídka Leaf Parameters obsahuje parametry pro změnu tloušťky skla, dolní i horní 
části dveří, tloušťky rámů nebo počet horizontálních a vertikálních skleněných panelů. 
Podobně probíhá tvorba oken.

Obrázek 5.10. Tři typy dveří dostupné v 3ds Max. Parametr 
pro otevření dveří Open je taktéž animovatelný.

Pivot Sliding BiFold

Obrázek 5.11. Šest typů oken, zeď, hrazení a strom. Všechny objekty jsou parametricky definova-
telné. Pokud připojíte jedno z AEC oken ke zdi příkazem Select and Link, vytvoří se ve zdi automa-
ticky otvor. Přemístíte-li okno ve zdi, otvor se přemístí také.

Wall

Foliage

Awning

Projected

Casement

Sliding Plane

Fixed

Pivoted
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Tvorba zdí
Tyto objekty tvořte nejlépe z půdorysného pohledu. Klepáním do pracovního výřezu a tažením 
myši se zapnutým 2D přichytáváním (například k mřížce) jednoduše tvoříte zdi, kdy každá 
následující je automaticky připojena k té předchozí. Po dokončení tvorby zdi klepnutím na 
počáteční bod máte možnost uzavřít zeď (objeví se dialog Weld Point). Klepnutím pravým tla-
čítkem myši ukončíte tvorbu zdi. Pokud chcete zeď upravit (výšku, šířku, polohu), musíte přejít 
do některého módu Vertex, Segment nebo Profile, jak vidíte na obrázku 5.13.
Další objekty si vyzkoušejte sami. Zábavou pro vás bude určitě tvorba stromů, vizuálně boha-
tá na podívání, nicméně náročná na zpracování. Jakmile jich vytvoříte mnoho (stačí desítky 
– počet závisí na výkonnosti počítače), můžete zcela zahltit systém. Pokud potřebujete vytvořit 
stovky stromů, porozhlédněte se po alternativním řešení – plug-in RPC s napodobením 3D 
modelů stromů nebo plug-in Forest Pack.

KATEGORIE ZÁKLADNÍCH GEOMETRICKÝCH PRIMITIV

Obrázek 5.12. Parametrické typy schodů. Jejich přizpůsobení spočívá v přepínání jednotlivých 
možností (počet schodů, celková výška, výška schodu) a výběru otevřeného schodiště (Open), 
uzavřeného (Closed) nebo masivního bloku (Box).

U-TypeStair

SprialStair
+ Open

L-TypeStair
+ Closed

Straight + Box
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Ostatní typy geometrických objektů
Na obrázku 5.14 vidíte všechny podkategorie geometrických objektů včetně těch, které byly 
předmětem předchozí kapitoly. Podkategorii Compound Objects dominují zejména Booleovské 
operace pro vyřezávání objektů (například sčítání a odčítání 3D objektů). Particle Systems budou 
předmětem animace, jelikož pomocí nich můžete vytvořit efekty, jako je sníh, bouře, exploze 
a další. Patch Grids představují pláty či rovinné mřížky (složené ze čtyř- nebo tříhranných plo-
šek), z nichž můžete modelovat libovolné 3D povrchy a modely. Jsou alternativou k modelům 
vytvořeným z polygonové síťoviny (Mesh, Poly). Můžete animovat také jejich podobjekty 
prostřednictvím konverze objektu na Editable Patch (viz dále modelování). NURBS jsou další 
specifické stavební kameny určené pro modelování založené na matematických algoritmech. 
Pomocí nich vytvoříte velmi hladké a detailní modely díky obrysovým křivkám, které definují 
hlavní kontury 3D modelu.

Obrázek 5.13. Mód Vertex u zdi umožní pohybovat rohy zdi. S vybraným segmentem zdi můžete 
měnit výšku (height) i šířku (width). Příkazem Insert rozdělíte zeď na libovolném místě. Zeď 
můžete také vertikálně rozdělit v polovině příkazem Divide.
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Obrázek 5.14. Všechny podkategorie geometrických objektů 
pohromadě. S dalšími kategoriemi kromě 3D objektů se seznámíme 
v modelování (Compound Objects, Patch Grids, mental ray) a animaci 
(Dynamics Objects a Particle Systems)

OSTATNÍ TYPY GEOMETRICKÝCH OBJEKTŮ
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Ovládání pohybu 

a manipulace 

s objekty

V této kapitole uděláme další smělý krok za poznáním 3D 
světa, konkrétně v oblasti manipulace s objekty. Už víte, které 
typy objektů můžete vytvořit, a poznali jste také jejich objek-
tové vlastnosti (pravým tlačítkem myši na objekt → Object 
Properties). Nyní přichází na řadu dovednost transformovat 
objekty. Ve druhé kapitole jsem v části nazvané „Transformace 
objektů (tímto pojmem budeme rozumět výhradně posun, 
otočení a změnu měřítka)“ již pro nedočkavé čtenáře před-
stavil základní principy posunování, otáčení a změny měřítka 
objektů. Půjdeme ale dále a vysvětlíme si všechny nástroje 
související s transformacemi. Rozebereme si také detailněji 
možnost klonování objektů, které jsme se v úvodu knihy 
pouze dotkli.

Výběr objektů různými 
způsoby
Objekty vybíráte tažením myši kolem objektů v pracovním 
výřezu nebo klepnutím na objekt. Se současně stisknutou klá-
vesou Ctrl a klepáním na objekty přidáváte tyto další objekty   
do výběru. Klávesou Alt+klepání na objekty je naopak odebí-
ráte z výběru. Ve druhé kapitole jsem zmínil také „Typy výběru 
objektů“, kdy můžete klepnutím na ikonu Rectangular Selection 
Region na hlavní nástrojové liště volit z dalších typů výběrů. 
Už víte, co znamená příkaz Window nebo Crossing Selection. 
Umíte vybírat podle názvu objektu (Select By Name) a podle 
barvy (Select By Color) z hlavní nabídky Edit. Objekty ležící ve 
stejné vrstvě můžete všechny najednou vybrat z nabídky Edit 
→ Select By Layer.
K omezení výběru na konkrétní kategorie objektů v kom-
plexní scéně vám může pomoci výběrový filtr (Selection 
Filter), který najdete také vlevo na hlavním panelu nástrojů. 
Všechny objekty naráz vyberete stiskem Ctrl+A. Inverzní 

6
K A P I T O L A

Témata kapitoly:

Výběr objektů různými 

způsoby

Transformace objektů 

detailně

Výběr způsobu transformací 

pomocí souřadnicových 

systémů

Definování středu 

otáčení více 

vybraných objektů

Zamezení 

transformace podle 

vybrané osy (uzamčení os)

Automatické zarovnávání 

během tvorby objektu

Vytvoření kopie objektů 

během jeho transformace

Vytvoření kopií objektů 

v čase

Rozmístění objektů podél 

cesty

Příprava na rozmístění 

detailních objektů ve scéně
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výběr (aktivní výběr vybraných objektů se zruší a vyberou se nevybrané objekty) provedete 
pomocí kláves Ctrl+I.
Vybraný objekt (sadu objektů) si můžete uzamknout, abyste omylem nevybrali jiný objekt. 
To provedete stisknutím mezerníku, přičemž se v dolní části rozhraní zažlutí ikona zámku. 
V tento okamžik nemůžete vybrat jiný objekt a ve výběru zůstává aktuální sada.
Ve druhé kapitole jsem hovořil o izolování vybraných objektů pomocí kláves Alt+Q, kdy se 
nevybrané objekty schovají a vy můžete pracovat s daným výběrem samostatně.
V Maxovi narazíte během své práce na mnoho dialogů, které budou vyžadovat, abyste vybrali 
nějaký objekt. To může být například při připojení jednoho objektu k druhému. Místo připoje-
ní objektů tažením myši ve výřezu k druhému objektu stisknete klávesu H pro vyvolání dialogu 
Select By Name. Tady můžete druhý objekt vybrat ze seznamu a potvrzením tlačítka OK objekty 
propojit. S těmito postupy se setkáte zejména při animaci a práci s efekty nebo částicovými sys-
témy. Objekty můžete vybírat z nástroje Schematic View, Správce vrstev (Layer Manager), editoru 
materiálů a dalších dialogů.

Obrázek 6.1. Transformační pivot si můžete přizpůsobit podle své potřeby. Klávesou X jej ve 
výřezu zapínáte a vypínáte. Pokud chcete změnit jeho velikost, přejděte do nabídky Customize → 
Preferences → karta Gizmos. Velikost nastavujete v poli Size. Relativní velikosti gizma pro posun, 
otočení či měřítko vůči původní velikosti nastavujete procentuálně v částech Move Gizmo, Rotate 
Gizmo a Scale Gizmo.
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Transformace objektů detailně
I když už jsme se dotkli tématu transformace objektů a už byste měli být schopni manipulovat 
s objekty, půjdeme dále a seznámíme se s možnostmi použití souřadnicových systémů, které 
jsou pro manipulaci s objektem klíčové. V 3ds Max objekty posunujete, otáčíte a měníte jim 
měřítko uchopením tzv. pivotu objektu (transformačního gizma) a provedením příslušného 
úkonu podle vybrané osy. Osy X, Y a Z, které definují 3D prostor, jsou zvýrazněny červeně (X), 
zeleně (Y) a modře (Z). Pokud máte vybranou některou z os, její barva je žlutá.

Posunování objektů (Move)
Objekty posunujete prostřednictvím nástroje Select and Move na hlavním panelu nástrojů. 
Můžete také aktivovat klávesu W. Objeví se gizmo s osami X, Y a Z, které můžete chytit a posu-
nout objektem podle aktivní osy (tu poznáte tak, že pod kurzorem myši změní barvu na žlu-
tou). Jakmile přemístíte kurzor myši nad jednu z os nebo kombinaci dvou os a stisknete levé 
tlačítko myši, začnete se pohybovat daným směrem nebo v rovině.

V dolní části rozhraní najdete pole pro vstup transformací hodnot právě aktivního transfor-
mačního nástroje (Posun, otočení nebo změna měřítka). Tato pole se nazývají Transform Type-
In. Pokud jste v módu pro posun, zadáte sem souřadnice místa, kam se má objekt posunout. 

TRANSFORMACE OBJEKTŮ DETAILNĚ

Obrázek 6.2. Uchopením pivotu transformujete objekt. Interaktivní osy používáte pro transfor-
maci daným směrem. Stačí, když nad osu umístíte kurzor myši a posunete s objektem, otočíte ho 
nebo mu změníte měřítko.

Transformační Gizmo

Transform Type-In
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Pokud jste v módu pro otočení, zadáváte sem stupně, v případě měřítka jsou to procenta zvět-
šení či zmenšení v dané ose.

Pokud klepnete nalevo od polí pro vstup hodnot transformace na malý terčík (Absolute Mode 
Transform Type-In), změníte typ vkládání hodnot na relativní souřadnice. Znamená to, že pokud 

teď zadáte do pole X s aktivním posunem například hodnotu 10, posunete objektem v ose X 

o 10 jednotek v kladném směru. Nikoli tedy na souřadnici X=10! Dialog Transform Type-In vyvo-

láte klávesou F12 (musíte mít aktivní posun – klávesa W – abyste sem hodnoty mohli zadat).

Otáčení objektů (Rotate)
Podobná logika jako u posunu platí i pro otáčení. Jediným rozdílem je, že pro aktivaci nástroje 
Rotate pouze stisknete klávesu E a pracujete s kruhovým gizmem. Stejně tak můžete kombi-
novat dvě osy, tedy otáčet objektem v rovině. Pro to stačí umístit kurzor myši kamkoli dovnitř 
mezi dva kruhy. V dané ose se otáčíte ve směru po obvodu kružnice. Zadáním hodnot do polí 
X, Y a Z (Transform Type-In) můžete buď absolutně, či relativně otáčet objektem ve stupních.

Obrázek 6.3. Uchopením rotačního pivotu docílíte otočení objektu ve stupních. Umístěním kur-
zoru myši nad vybranou kružnici (červená = osa X, zelená = osa Y, modrá = osa Z) a stiskem levého 
tlačítka myši otáčíte objektem dle vybrané osy.

TIP
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Změna měřítka objektu (Scale)
Stiskem klávesy R s vybraným objektem aktivujete nástroj Select and Uniform Scale. To znamená 
rovnoměrná změna měřítka (zvětšení či zmenšení objektu) ve všech osách stejnou měrou. 
Proporcionální změny měřítka objektu docílíte tak, že umístíte kurzor myši dovnitř transfor-
mačního gizma (do středu či počátku), aby byly všechny tři osy žluté (aktivní). Jakákoli další 
kombinace os vede k deformaci objektu.
Pokud chcete měnit velikost objektu jen v určité ose, musíte na ni klepnout a táhnout nahoru 
nebo dolů (pro zvětšení nebo zmenšení v dané ose). Tento princip ukazuje obrázek 6.4.

Obrázek 6.4. Nástroj pro změnu měřítka umožňuje změnit velikost objektu také jen v určité ose 
nebo rovině (neproporcionálně, nerovnoměrně), což vede k deformaci objektu. Někdy se vám to 
ale může hodit.

Nerovnoměrná změna měřítka
Pokud podržíte levé tlačítko myši nad ikonou Select and Uniform Scale na hlavním panelu 
nástrojů (viz obrázek 6.5), zobrazí se ještě dvě ikony. První z nich je Select Non-Uniform Scale, 
která má na starosti neproporcionální deformaci objektu podle vybrané dimenze. Víceméně 
toho docílíte i v původním „nedeformačním“ módu Select and Uniform Scale, stačí, když si vybe-
rete libovolnou kombinaci nebo samostatnou osu a v ní objekt zmenšíte/zvětšíte.

TRANSFORMACE OBJEKTŮ DETAILNĚ

Scale Z (zmenšení v oze Z)

Scale X (zúžení v ose X)

Zvětšení v rovině XZ
(zúžení v ose Y)
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To, že objekt zmenšujete či zvětšujete v dané ose, poznáte samozřejmě vizuálně. Kromě toho 

se během změny můžete podívat do dolních polí Transform Type-In a pozorovat, které pole (X, 

Y nebo Z) se mění. V této ose měníte velikost objektu. To platí analogicky i pro posun a otočení 

objektu. Další pomůckou je nástrojová lišta Axis Constraints (klepnutím pravým tlačítkem myši 

na hlavní nástrojovou lištu → vyberte Axis Constraints). Při transformaci podle vybrané osy 

(kombinace os) se vám zvýrazní tlačítko osy na této liště.

Stlačení objektu
Stlačení (Squash) objektu je oblíbená technika animátorů, kdy chtějí vyjádřit pohybující se 
hmotu v pohybu. Pokud například dopadne fotbalový míč na zem, stlačí se v ose dopadu, ale 
aby zachoval svůj objem, roztáhne se opačným směrem ve zbylých osách. Přesně toho můžete 
docílit tímto efektem, který je samozřejmě animovatelný. Vyzkoušejte si to na obyčejné kouli. 
Po výběru nástroje Select and Squash (viz třetí ikona vespod na obrázku 6.5) vyberte stlačení 
v ose Z dolů a pozorujte reakci koule v osách X a Y.

Transformace pivotu
Transformační pivot je občas třeba přemístit jinam než tam, kde se nalézá standardně. Může 
to být mimo vlastní objekt nebo v jeho středu a podobně. Musíte se tedy naučit ovládat pozici 
a natočení pivotu. Jak jsem naznačil v úvodu (viz obrázek 2.28 ve druhé kapitole „Přemístění 
transformačního středu objektu mimo objekt“), provádíte to na panelu Hierarchy. Víte také, 
k čemu je Working Pivot, jakožto pracovní verze „pevného“ pivotu, s nímž jste až doteď praco-
vali.

Výběr způsobu transformací pomocí 
souřadnicových systémů
Souřadnicový systém je stejně tak důležitý jako samotné transformace. Pokud totiž vyberete 
chybně souřadnicový systém, můžete sebelépe pohybovat objektem, ale špatným směrem. 
Podívejte se do rozevíracího seznamu s názvem View na obrázku 6.5. 
Jde o systémy, které definují, jakým způsobem můžeme objekty transformovat. Nazývají se refe-
renční souřadnicové systémy (Reference Coordinate Systems). Tady si vybíráte různé pohledy na 

POZNÁMKA

Obrázek 6.5. Nerovnoměrná změna měřítka je dostupná jako 
rozbalovací ikona (uprostřed vyznačeného rámečku) na hlavním 
panelu nástrojů. Pomocí ní deformujete objekt pouze v některé 
ose nebo rovině (kombinaci os). Nástrojový panel Axis Constraints 
umožňuje deformace omezit vybranými osami.
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objekt a odtud různé možnosti transformací. Všechny transformace vybraných objektů se ode-
hrávají v režii jednoho z následujících souřadnicových systémů (vždy podle toho vybraného):

View Coordinate System (pohledový souřadnicový systém): Referenční souřadnicový 
systém založený na pracovních výřezech; osa X směřuje doprava, Y ukazuje nahoru 
a Z ukazuje ven z obrazovky (směrem k vám). Osy jsou tedy stejné ve všech ortografic-
kých pohledech. Pohledy jsou fixní, takže práce s ním je velmi intuitivní.
Screen Coordinate System (obrazovkový souřadnicový systém): Je shodný s pohledovým 
systémem kromě toho, že aktivní výřez určuje osy systému a neaktivní výřezy ukazují 
(akceptují) osy podle jejich definice v aktivním výřezu. Hodí se zejména v případě, že 
i v perspektivě potřebujete posunovat objektem jakoby po povrchu obrazovky, tedy 
v rovině kolmé k vašemu zornému pohledu.
World Coordinate System (světový souřadnicový systém): definuje osu X ukazující vpravo, 
Z nahoru a Y směrem pryč od vás. Osy jsou fixní bez ohledu na použité transformace 
objektu.
Parent Coordinate System (souřadnicový systém rodičovského prvku): aktuálně vybraný 
objekt použije referenční souřadnicový systému rodičovského objektu. Pokud objekt 
nemá rodičovský prvek (připojený k současnému objektu příkazem Select and Link), pak 
se použije světový souřadnicový systém.
Local Coordinate System (lokální souřadnicový systém): nastaví souřadnicový systém 
vlastní vybranému objektu. Střed os je umístěn v místě pivotu objektu. Jeho orientaci 
můžete změnit přesunutím pivotu na panelu Hierarchy.
Gimbal Coordinate System: Tento systém se používá u objektů, které mají aplikovaný ani-
mační ovladač Euler XYZ Rotation (více se dozvíte v kapitole o animaci). Pokud ho objekt 
nemá přiřazený, je systém shodný se světovým souřadnicovým systémem. Výhoda je, že 
otočení objektu kolem jedné osy znamená výhradně změnu hodnoty této osy (ne jako 
v případě lokálního systému, kdy otočení kolem jedné osy může měnit hodnoty více os, 
což je pro úpravy funkčních animačních křivek nežádoucí).
Grid Coordinate System (souřadnicový systém mřížky): Když si vyberete tento systém, 
objekt se bude pohybovat podle souřadnic aktivní mřížky.
Working Coordinate System (pracovní souřadnicový systém): Tento systém umožňuje 
transformovat vybraný objekt kolem pracovního pivotu objektu (Working Pivot).
Pick Coordinate System (souřadnicový systém vybraného objektu): Aktuální objekt se 
bude transformovat podle souřadnicového systému vybraného objektu.

Souřadnicový systém je nastavený podle vybrané transformace, takže nejprve vybírejte posun, 

otočení nebo měřítko a až pak souřadnicový systém. Pokud se vám často stává, že po výběru 

jiné transformace (posunu, otočení nebo měřítka) se také přepne souřadnicový systém, můžete 

nastavit, aby zůstal „ukotvený“. Pokud tedy nechcete, aby se při změně transformace měnil i sou-

řadnicový systém, postupujte takto:

1. Klepněte na hlavní nabídku Customize → Preferences → karta General.

2. Zapněte zde Ref. Coord. System → Constant.

�

�

�

�

�

�

�

�

�

POZNÁMKA

VÝBĚR ZPŮSOBU TRANSFORMACÍ POMOCÍ SOUŘADNICOVÝCH SYSTÉMŮ

K1601.indd   159K1601.indd   159 14.1.2010   13:45:1214.1.2010   13:45:12



160 KAPITOLA 6   �   OVLÁDÁNÍ POHYBU A MANIPULACE S OBJEKTY

Definování středu otáčení více 
vybraných objektů
Ikona napravo od rozevíracího seznamu Reference Coordinate System představuje možnost výbě-
ru středu transformací (Use Center – viz ikony na obrázku 6.7). Zkoušeli jste vybrat více objektů 
najednou a chtěli jste otočit každým objektem individuálně kolem svého vlastního středu? Pak 
to provedete právě zde (podržte levé tlačítko myši na ikoně Use Pivot Point Center).

Chcete-li otáčet všemi objekty najednou kolem jejich společného středu, vyberte ikonu 
Use Selection Center, jak je tomu na obrázku 6.8 n.
Pokud jste se rozhodli otáčet kolem jejich individuálních os (každým objektem zvlášť), 
pak vyberte ikonu Use Pivot Point Center 6.8 o.
Konečně pokud si zvolíte jako střed transformace vybraných objektů střed souřadnico-
vého systému (Coordinate System Center), zvolte třetí možnost Use Transform Coordinate 
Center.

1.

2.

3.

Obrázek 6.6. Ukázka porovnání lokálního n a světového o souřadnicového systému. Jak je patrné, 
i při natočení objektu se světový souřadnicový systém nemění a má stále stejnou orientaci vzhledem 
k mřížce. Lokální systém má relativní vztah k objektu a otáčí se s ním. Je k němu „fixován“.

n o

Obrázek 6.7. Tři středy transformací dostup-
né na hlavním panelu nástrojů. Shora Use 
Pivot Point Center, Use Selection Center a Use 
Transform Coordinate Center.
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Obrázek 6.8. Pokud použijete možnost Use Pivot Point Center, můžete otáčet objekty samostatně 
o. Pokud chcete vybrané objekty transformovat podle jejich společného středu, vyberte si Use 
Selection Center n.

DEFINOVÁNÍ STŘEDU OTÁČENÍ VÍCE VYBRANÝCH OBJEKTŮ
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Zamezení transformace podle 
vybrané osy (uzamčení os)
Řekněme, že máte připravené objekty na modelu stolu, kterými byste neradi pohnuli, aby se 
stále dotýkaly stolu. Nejjednodušším způsobem je zamezit jejich pohybu podle osy Z. Pokud 
takto chcete uzamknout transformace podle libovolných os, postupujte takto:

Vyberte objekt, u něhož chcete provést zákaz transformace (posun, otočení či změna 
měřítka).
Přejděte na panel Hierarchy, klepněte na kartu Link Info.
Zaškrtněte ty osy u transformací, které chcete zakázat.
Ověřte, že ve výřezu zmizely zaškrtnuté osy transformačního gizma, podle nichž nelze 
transformovat.

Automatické zarovnávání 
během tvorby objektu
Už vás nebaví neustálé zarovnávání objektů ihned po jejich vytvoření? Mám pro vás dobrou 
zprávu. Pokud totiž tvoříte základní objekty, můžete využít funkce AutoGrid, která umožní už 
během kreslení automaticky zarovnat jeden objekt na druhý. Postupujte takto:

1.

2.

3.

4.

Obrázek 6.9. Uzamčení transformací vybraných objektů na 
panelu Hierarchy, kartě Link Info. V tomto příkladě je zaká-
zán pohyb objektu po ose Z, otočení kolem osy Y a navíc 
jsem zamezil možnosti změny měřítka objektu (nebudete 
ho moci zvětšovat ani zmenšovat).
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Vytvořte jeden objekt, na který budete chtít ten druhý vytvářený zarovnat (například 
kouli).
Nyní klepněte na tlačítko (na příkazovém panelu) pro tvorbu nového objektu (napří-
klad konvice).
Zapněte pole AutoGrid, jak ukazuje obrázek 6.10, a začněte pohybovat kurzorem myši 
nad povrchem prvního objektu (koule).
Sledujte automatické přizpůsobování kurzoru myši povrchu koule. Nyní můžete objekt 
vytvořit běžným způsobem na požadovaném místě na povrchu prvního objektu.

Další možností, jak orientovat nově vytvářené objekty požadovaným směrem, je použít pomoc-
ný objekt Grid (mřížka), který najdete v nabídce Create → Helpers → Grid. Stačí ji aktivovat 
(klepnout pravým tlačítkem myši na mřížku → Activate Grid) a pak je každý vytvořený objekt 
zarovnán s touto mřížkou, a nikoli domácí (Home Grid).

Vytvoření kopie objektů během 
jejich transformace
Transformovat objekty už dokážete a také jste se dozvěděli o nástroji Array pro tvorbu roz-
sáhlých polí objektů. V tomto oddíle zmíníme možnost, kdy můžete jednoduchým posunem 
objektu vytvořit jeho kopii. 

1.

2.

3.

4.

AUTOMATICKÉ ZAROVNÁVÁNÍ BĚHEM TVORBY OBJEKTU

Obrázek 6.10. Funkce AutoGrid pomáhá už při tvorbě objektu zarovnat pivot objektu na povrch 
dalšího objektu
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Vyberte objekt, který chcete zkopírovat v určitém intervalu (vzdálenosti mezi objekty).
Aktivujte transformaci (např. posun, klávesa W).
Stiskněte klávesu Shift a posuňte objektem podle libovolné osy.
Po přijatelné vzdálenosti pusťte levé tlačítko myši, načež se objeví dialog Clone Options.
Vyberte vhodný typ a počet klonů (nezávislá kopie, závislá instance nebo reference).
Klepnutím na tlačítko OK se vytvoří zadaný počet objektů.

Tento postup je platný také pro otočení a změnu měřítka. Vyzkoušejte si to na libovolných 

objektech, je to důležitá technika! Pokud klepnete na objekt pravým tlačítkem myši, máte 

možnost vybrat také příkaz Clone, který vytvoří klon objektu (kopii, instanci nebo referenci) na 

stejném místě. S tím pak můžete samozřejmě posunout na libovolné místo. 

Vytvoření kopií objektů v čase
Představte si situaci, kdy potřebujete vytvořit kopie animovaného objektu podél jeho cesty 
(například značkovací automobil, který za sebou nechává stopy v podobě silničních dělicích 
pruhů). Manuální postup by byl velmi zdlouhavý. Můžete si vytvořit tyto objekty pomocí 
nástroje Snapshot automaticky na základě animované cesty hlavního objektu. Postup je násle-
dující:

Vytvořte si nejprve animovaný objekt, který sleduje vámi požadovanou cestu. Rychlou 
animaci libovolného objektu provedete takto:

Vyberte objekt a zapněte tlačítko Auto Key, které najdete pod perspektivním výře-
zem. Tlačítko zčervená.
Přesuňte časový posuvník na snímek č. 100. Časový posuvník (Time Slider) najdete 
vlevo dole pod výřezem levého bokorysu s hodnotou 0/100.
Posuňte vaším objektem na libovolné místo a vypněte tlačítko Auto Key. Zanimovali 
jste objekt, proto můžete přistoupit k použití nástroje Snapshot.

Vyberte tento objekt a přejděte do hlavní nabídky Tools → Snapshot.
Objeví se stejnojmenný dialog, kde vyberte přepínač Range (rozsah) pro určení délky 
animace, po kterou se budou vytvářet klony objektu (snímky od do – From a To). 
Samozřejmě zadejte počet klonů (podle délky animační cesty a počtu klonů můžete 
určit rovnoměrné rozestupy mezi klony). V části Clone Method si vyberte typ kopie, 
instance nebo reference podle toho, jaký mají mít klony vztah k originálu.
Klepněte na tlačítko OK a potvrďte vytvoření klonů podél animované cesty.

Rozmístění objektů podél cesty
Dalším způsobem, jak transformovat objekt, je rozmístit ho v kopiích pravidelně po vámi defi-
nované cestě, kterou je 2D křivka. Již jsme tento nástroj zmínili, když jsme procházeli hlavní 
nabídku. Ano, jde o Spacing Tool. Podívejme se nyní na rozpis postupu použití tohoto nástroje, 
jehož možný výsledek vidíte na obrázku 6.12.

1.

2.

3.

4.

5.

6.

1.

a.

b.

c.

2.

3.

4.

TIP
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Vytvořte 2D křivku, podél níž chcete rozmístit (distribuovat) 3D model. Například 
obdélník z hlavní nabídky Create → Shapes → Rectangle.
Vytvořte 3D model, který má být rozmístěn po 2D cestě, a vyberte jej.
Klepněte na hlavní nabídku Tools → Align → Spacing Tool a klepněte na tlačítko Pick Path 
(vybrat cestu). 

Kdybyste chtěli rozmístit klony objektu pouze mezi dvěma body na lineární cestě (nemusíte mít 

2D křivku), vyberte Pick Points. Klepněte na dvě místa, která budou definovat počáteční a kon-

cový bod rozmístění.

V pracovním výřezu klepněte na připravenou 2D cestu. Nastavte počet (Count) kopií, 
vzdálenost (rozestup) mezi objekty pomocí pole Spacing, můžete nastavit počet jedno-
tek, o něž bude posunut první objekt od začátku křivky (Start Offset) nebo konce křivky 
(End Offset). Z rozbalovacího seznamu pod polem End Offset si můžete vybrat z mnoha 
různých variant distribucí podél cesty, které představují zejména kombinace parametrů 
Count, Spacing, Start a End Offset.
V části Context vyberte typ orientace 3D objektu po cestě. Pokud vyberete Center, budou 
se vzdálenosti mezi objekty počítat od jejich středu. Pokud zvolíte Edge, budou se 
vzdálenosti počítat od hrany předchozího k hraně následujícího objektu. Volba Follow 
způsobí, že objekty budou sledovat směr cesty.

1.

2.

3.

4.

5.

POZNÁMKA

ROZMÍSTĚNÍ OBJEKTŮ PODÉL CESTY

Obrázek 6.11. Animovaná šipka podél cesty (tvaru Helix) umožní vytvořit její klony podél této 
cesty. Ruční umisťování modelů (i pomocí nástroje Array) by bylo náročné.
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Vyberte si kopii, instanci nebo referenci a stiskněte tlačítko Apply pro potvrzení. 
Tlačítkem Close opustíte dialog.

Obrázek 6.12. Nástroj Spacing Tool je vhodný zejména pro rozmisťování objektů podle definova-
né 2D cesty. Určitě je to velký pomocník a automatizuje pracné ruční umisťování objektů.

Příprava na rozmístění 
detailních objektů ve scéně
Až budete pracovat v týmu specialistů, kde spojení slov „dělba práce“ není nikomu cizí, budete 
si muset zvyknout na časové prodlevy dodávek 3D modelů od svých kolegů. V tom případě 
nemusíte zahálet, protože Max nabízí nástroj Clone and Align. Pomocí něj si ve scéně můžete 
připravit dočasné objekty (tzv. proxy), které zastupují budoucí detailní 3D modely. Pojďme si 
to vyzkoušet.

Rozmístěte si po scéně zástupné objekty (např. Create → Helpers → Dummy).
Importujte si 3D model (nebo si pro představu vytvořte jednoduché primitivum) a pře-
jděte do hlavní nabídky Tools → Align → Clone and Align.
Objeví se dialog jako na obrázku 6.13. Klepněte na tlačítko Pick List, vyberte v seznamu 
všechny zástupné objekty (v mém případě Dummy) a potvrďte klepnutím na tlačítko 
Pick.
Upravte transformační parametry v rozevírací nabídce Align Parameters, pokud je to 
třeba. Zde můžete například všechny zarovnané objekty hromadně posunout, otočit 
nebo jim změnit velikost.
Tlačítkem Apply potvrďte zarovnání.

6.

1.

2.

3.

4.

5.
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Obrázek 6.13. Clone and Align je vynikající nástroj pro začlenění externích 3D modelů do vaší 
scény na místo jednoduchých zástupných (tzv. proxy) objektů (viz zelené krychle)

Na tomto místě by bylo dobré zopakovat si tvorbu polí objektů. Projděte si znovu nástroj Array, 

který byl představen ve druhé kapitole „Vytváření libovolných polí objektů“. 

Tím jsme dokončili možnosti transformací objektů. Teď byste měli umět vytvářet a transfor-
movat objekty včetně změny pohledů a vlastností pracovních výřezů. Následující kapitola vám 
ukáže směr v organizaci objektů ve scéně. Bude to poslední kapitola před skutečným pronik-
nutím do světa 3D modelování.

TIP

PŘÍPRAVA NA ROZMÍSTĚNÍ DETAILNÍCH OBJEKTŮ VE SCÉNĚ
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Stanovte řád 

a zorganizujte 

si scénu

Smyslem této kratší kapitoly je představit vám nástroje, které 
zjednoduší vaši práci na větších projektech. O některých jsem 
hovořil při příležitosti prozkoumávání hlavní nabídky, nyní 
půjdeme do detailu a s ukázkami jejich využití. Organizace 
objektů ve scéně vám v konečném důsledku umožní rychlejší 
dodávku díla, jehož struktura bude pochopitelná všem dalším 
umělcům pracujícím s vašimi objekty. Klíčovými prostředky 
pro přehlednou organizaci scény jsou:

Skupiny (Groups)
Sady pojmenovaných výběrů (Selection Sets)
Průzkumník scény (Scene Explorer)
Hierarchie objektů (Select and Link) a schematický 
pohled (Schematic View)
Správa souborů (Asset Browser)
Kontejnery (Containers – viz příloha A věnovaná 
novinkám 3ds Max 2010)

Seskupování objektů
Nepochybně produktivním nástrojem je seskupování objektů. 
Základní princip jsme už nastínili v druhé kapitole v části 
„Seskupování objektů do logických celků“. Nyní se podíváme 
na jednotlivé postupy práce se skupinami.

Vytvoření skupiny
Skupinu objektů vytvoříte tak, že vyberete všechny objekty, 
které mají být součástí skupiny, a přejdete do hlavní nabídky 
Group → Group. Vytvoření skupiny si ověříte tak, že klepnete 
na libovolný prvek skupiny v pracovním výřezu a vybere se 
celá skupina – transformujete ji jako jeden celek.
Dalším ověřením existence skupiny je podívat se s vybraným 
objektem (skupinou) do dialogu Select From Scene (klávesa H), 
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kde u něj ve sloupci Type uvidíte popis „Group“. Zjistíte to také v nástroji Schematic View, o němž 
bude řeč později.

Pokud v dialogu Select From Scene neuvidíte sloupce Type a objekty jako součásti skupiny, 

zapněte si v něm nabídku Display → Display Children a pak si přidejte sloupec Type. Sloupce si 

do dialogu přidáte klepnutím na libovolné místo záhlaví sloupců a výběrem Configure Columns. 

Tažením mezi další sloupce si ten svůj přidáte.

Otevření skupiny
Abyste mohli pracovat s objekty ve skupině, musíte ji nejprve otevřít. Pokud se vám tedy stane, 
že nemůžete vybrat konkrétní objekt, může to být také tím, že máte skupinu zavřenou. Skupinu 
otevřete příkazem hlavní nabídky Group → Open. Nyní můžete vybírat jednotlivé objekty skupi-
ny a pracovat s nimi nezávisle. Otevření skupiny ověříte s jedním vybraným objektem skupiny 
taktéž stiskem klávesy H. Uvidíte zde podřízené uzly hlavního prvku, jak ukazuje obrázek 7.1. 
Taktéž v pracovním výřezu vidíte růžový rámeček kolem skupiny, což je nápověda, že ji máte 
otevřenou.

Zrušení jedné (nejvýše vytvořené) skupiny
Pokud jste vytvořili více vnořených skupin (například rámy → okna → patro → všechna 
patra → budova), můžete zrušit naposledy vytvořenou (nejvyšší) skupinu příkazem Group → 
Ungroup. V našem případě byste vybrali celou budovu, provedli tento příkaz a zůstaly by vám 
pouze skupiny pater budovy.

POZNÁMKA

Obrázek 7.1. Otevřená skupina je zobrazena jako nadřízený uzel Group s podřízenými objekty
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Zrušení všech vnořených skupin objektu
Rozložení všech vytvořených (tedy i vnořených) skupin objektu provedete příkazem Group → 
Explode. Tím získáte pouze původní individuální objekty. Z našeho příkladu z předchozího 
odstavce bychom obdrželi pouze rámy oken. 

Připojení/odpojení objektu k/ze skupiny
Zapomněli jste přidat do skupiny nějaký objekt? Nebo jste omylem do skupiny přidali prvek, 
který tam nepatří? Nevadí, nemusíte celou skupinu rušit. Postačí použít příkaz Attach (přidání 
do skupiny) nebo Detach (odpojení prvku od skupiny). Připojení objektu popisuje následující 
postup.

Nejlépe je mít skupinu uzavřenou.
Vyberte objekt, který chcete připojit ke skupině.
Přejděte do hlavní nabídky Group → Attach.
Klepněte na uzavřenou skupinu, tím se objekt ke skupině připojí. Vyzkoušet správnost 
postupu můžete posunutím skupiny. Připojený objekt by měl následovat.

Sady pojmenovaných výběrů
Na rozdíl od skupin mají sady pojmenovaných výběrů (Named Selection Sets) jednu výhodu. 
Nemusíte sadu otevírat, abyste pracovali s individuálními objekty sady. Stačí, když si vyberete 
sadu objektů, zadáte jim název do pole s názvem Create Selection Set na hlavním panelu nástro-
jůa potvrdíte klávesou Enter. Příště se k těmto objektům budete moci vrátit výběrem názvu 
sady v tomto seznamu.

Jak spravovat pojmenované sady výběrů
Na obrázku 2.12 vidíte, jak přistupovat ke správě pojmenovaných výběrů. Tlačítkem se symbo-
lem závorek a třemi písmeny ABC spustíte manažera správy sad. Pokud máte již nějakou sadu 
definovanou, její správu provádíte v dialogovém okně Named Selection Sets.
Objekty můžete v dialogu mezi sadami přeskupovat tažením myši. Odstraňujete je klepnutím 
na objekt pravým tlačítkem myši a výběrem příkazu Remove. Tím ho samozřejmě neodstraníte 
ze scény, ale pouze ze sady výběru. Pokud vám nějaký objekt v sadě chybí, vyberte ho v pracov-
ním výřezu a v dialogu Named Selection Sets klepněte na horním pásu na tlačítko Add Selected 
Objects. Objekt odstraníte ze sady klepnutím na tlačítko Subtract Selected Objects (musíte ho 
mít vybraný ve výřezu a v dialogu také název sady, k níž objekt náleží). Novou sadu vytvoříte 
z tohoto dialogu příkazem Create New Set, což je totožný postup, jako když ve výřezu vyberete 
objekty a zadáte název výběru do pole Create Selection Set.

Jeden objekt může náležet více sadám. Více sad najednou vybíráte takto:
Vyberte ze seznamu Named Selection Sets požadovanou sadu.
Stiskněte klávesu Ctrl a vyberte druhou sadu. Ta se přidá k prvnímu výběru.

Pokud používáte schránku Windows (natolik známé kombinace kláves Ctrl+C a Ctrl+V), pak 
stejné příkazy můžete použít i v tomto případě.

1.

2.

3.

4.

1.

2.

SADY POJMENOVANÝCH VÝBĚRŮ
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Detailnější průzkum scény
Nástroj, pomocí něhož máte přehled, které objekty a v jakém vztahu se ve scéně nacházejí (viz 
obrázek 2.17), se nazývá Scene Explorer. Můžete je odsud vybírat tak, aby se jejich výběr synchro-
nizoval také v pracovním prostředí (proto musíte mít zapnuté tlačítko Sync Selection na horním 
panelu ikon Scene Exploreru). Je to široce univerzální nástroj, jenž vám umožňuje vytvářet nové 
uživatelské filtry, které zobrazují jen dotazované objekty (např. objekty s názvem začínajícím 
na daný řetězec, obsahující určité znaky, nebo čelní plošky, jejichž počet přesahuje určitý počet, 
mají trajektorii a mnoho dalších). Na obrázku 7.3 vidíte dialog Advanced Filter, který je součástí 
Scene Exploreru a pomocí něhož můžete filtry vytvářet. Ukládají se společně se scénou.

Obrázek 7.2. Pojmenované sady výběrů jako nástroj k organizaci digitálních aktiv
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Hierarchie objektů a schematický pohled 
na propojené objekty
Až vás pohltí animace jako primární zájmová oblast, první, s čím se budete muset seznámit, 
jsou hierarchie objektů. Nehodí se pouze k animaci, ale poslouží také jako způsob zjednoduše-
ní manipulace s objekty. Představte si, že ve scéně pohnete dveřmi. Klika, která je na nich, by 
měla následovat. Stejně tomu tak může být u stolu, na němž leží předměty. Následující postup 
ukazuje možnost hierarchického propojení, kdy jeden objekt (nebo více) je potomkem (ten, od 
něhož vedete spoj) a druhý rodičem (ten, k němuž vedete spoj):

Vyberte objekt nebo objekty, které chcete připojit k rodičovskému (ovládacímu) 
prvku.
Klepněte na hlavním panelu nástrojů na ikonu Select and Link a pak se stisknutým levým 
tlačítkem myši táhněte od vybraného objektu (vybraných objektů) k rodičovskému. 
Pusťte levé tlačítko myši.
Vytvořili jste hierarchické propojení objektů od potomka k rodičovi, které si můžete 
zkontrolovat v nástroji Schematic View.

Odpojení objektů byste provedli výběrem připojeného objektu a stiskem ikony Unlink Selection, 

kterou najdete hned napravo od ikony Select and Link na hlavním panelu nástrojů.  

Na obrázcích 7.4 a 7.5 vidíte také nástroj Schematic View. Zobrazuje vztahy mezi objekty pomo-
cí zástupných grafických obdélníkových symbolů – aktivních schémat. Při výběru objektu 
ve schematickém pohledu se automaticky vybere objekt ve výřezu (nabídka schematického 
pohledu → Select → Sync Selection). Můžete odtud upravovat i objektové vlastnosti (pravým 
tlačítkem myši vyvoláte čtyřnásobnou nabídku, odkud vybíráte nejen objektové vlastnosti, ale 
také například skrývání, mrazení, připojení, odpojení, typy zobrazení hierarchií a další). Přímo 
uvnitř tohoto okna můžete objekty propojovat (ikona Connect) anebo rušit jejich hierarchické 
propojení (Unlink Selected). Ikonou Delete Objects odstraníte objekt také z pracovního výřezu.

1.

2.

3.

POZNÁMKA

Obrázek 7.3. Průzkumník scény obsahuje také dílčí nástroj pro definici filtrů 
pro výběr objektů na základě zadaných kritérií

HIERARCHIE OBJEKTŮ A SCHEMATICKÝ POHLED NA PROPOJENÉ OBJEKTY
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Obrázek 7.4. Klasický představitel hierarchického propojení objektů je Biped – kostra člověka, 
kterou využijete pro animaci postav. Můžete ji vytvořit z hlavní nabídky Create → Systems → 
Biped. Schematický pohled zobrazuje propojené objekty (horní obdélníky jsou vždy předkové 
spodních obdélníků zastupujících objekty ve scéně).

Obrázek 7.5. Pomocný objekt dummy je ovládací prvek celého altánu. Všechny jeho součásti jsou 
k objektu dummy připojeny příkazem Select and Link.
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Správa digitálních aktiv v Asset Browseru
Často je dobré vidět náhledy vašich MAX souborů, protože otevírat jeden po druhém a marně 
čekat, než najdete ten správný, bývá frustrující. K tomuto účelu využijete nástroj Asset Browser, 
který otevřete z panelu Utilities. Klepnutím vlevo na stromovou strukturu složek se zobrazují 
soubory v nich obsažené. V nabídce Filter si můžete nastavit, které typy souborů si chcete 
nechat zobrazovat. Podporované souborové formáty jsou AVI, BMP, CIN, CEL, GIF, HDRI, 
IFL, IPP, JPEG, MPEG, PNG, PSD, MOV, RGB, RLA, RPF, VST, TIF, YUV a DDS. Kromě 
obrazových souborů jsou to samozřejmě MAX soubory, všechny importovatelné formáty, 
MAXScript a DWG soubory. 
Prohlížeč souborů Asset Browser můžete zakomponovat do jednoho z výřezů. Stačí klepnout na 
název výřezu pravým tlačítkem myši a vybrat Views → Extended → Asset Browser. 

Prohlížet obrazové soubory můžete přes hlavní nabídku Rendering → View Image File. Ve ver-

zích před 2010 tento příkaz najdete v hlavní nabídce File. 

TIP

Obrázek 7.6. Manažer MAX a obrazových souborů Asset Browser poskytuje minimalizované 
náhledy vašich scén, takže již nemusíte otevírat jeden soubor po druhém, ale můžete vyhledat 
konkrétní a ten pak použít

SPRÁVA DIGITÁLNÍCH AKTIV V ASSET BROWSERU
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Dáváme 

myšlenkám tvar: 

Modelovací 

techniky

Modelování je klíčovou oblastí pro start projektu. Až 
do teď jsme se seznamovali s nástroji, které jsou pouze 
obslužné, pomocné, a nic nevytvářely. Teď přichází na řadu 
skutečná 3D tvorba, digitální sochařství. V této kapitole 
se seznámíte s novými modelovacími nástroji verze 3ds 
Max 2010, podíváme se na techniky polygonového mode-
lování a také použijeme 2D křivky jako základ složitějších 
modelů. Podáme vysvětlení dalších typů modelovacích 
technik, a to zejména modelování z plátů (Patch modeling) 
a modelování s využitím křivek NURBS. Popíšeme si 
postup vytváření vysoce detailních i nízkopolygonálních 
modelů pro hry. 
Současně nás nemine popis pracovního toku mezi 3ds Max 
a aplikací Mudbox, o níž jsme hovořili ve čtvrté kapitole, 
v části Dotažení 3D modelu k dokonalosti – Autodesk 
Mudbox. Pomocí této aplikace vytvoříte modely s vyso-
kým detailem.
Detailně si popíšeme všechny modifikátory a vysvětlíme 
jejich účel v oblasti modelování. Také si ulehčíme práci 
s některými pomocnými nástroji zaměřenými na efektivní 
pracovní tok v modelování.
Po přečtení této kapitoly byste měli být schopni vytvořit 
libovolný objekt, na jaký si vzpomenete. Od pravidelných 
tvarů (základních stavebních kamenů) architektonických 
modelů až po organické tvary, jako jsou květiny nebo 
lidé.

8
K A P I T O L A

Témata kapitoly:

Začínáme s modelováním

Dílčí části editovatelného 

objektu pro modelování

Pomocné objekty 

v modelování

Základní modelovací 

příkazy – tvarujeme hmotu

Kreslíme 

a upravujeme 2D tvary 

– podklady pro 3D modely

Modelujte v 3D efektivně 

s Graphite Modeling Tools

Modelování 

a deformace objektů 

pomocí modifikátorů

Modelovací techniky

Modelujeme z křivek 

Vytváříme nízkopolygonální 

modely

Architektonické modelování

Detailní organické 3D 

modely

Modelování s NURBS 

a Patch objekty

�

�

�

�

�

�

�

�

�

�

�

�

�
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Začínáme s modelováním
Modelování obvykle začíná rozpoznáním základní formy. Váš finální model se totiž v základ-
ních rysech může podobat některému základnímu 3D geometrickému primitivu. Fotbalový míč 
budete určitě tvořit z koule (Geosphere), televizor z krabice (Box) nebo vázu z válce (Cylinder), 
popřípadě jako základ použijete 2D křivky. Na to, abyste základní objekt vhodně rozpoznali, 
neexistuje žádný přesný návod. Potřebujete jednak praxi a také cit. Základní primitiva jsou 
parametrická, tj. můžete jim měnit poloměr, délky hran a podobně. Jakmile máte přibližný 
základní tvar hotový, můžete postoupit dále se dvěma možnostmi:

Konvertovat základní objekt na editovatelný objekt (klepněte pravým tlačítkem myši na 
objekt a vyberte Convert To → Convert To Editable Poly nebo klepnutím pravým tlačítkem 
myši na záznam v zásobníku modifikátorů na panelu Modify a výběrem Convert To → 
Mesh, Patch nebo Poly).
Přidat základnímu primitivu editační modifikátor Edit Poly, Edit Mesh nebo Edit Patch 
podle typu geometrie, se kterou chcete pracovat.

�

�

Obrázek 8.1. Základní primitiva, jejichž parametry byly ztraceny kvůli konverzi na editovatelnou 
polygonovou síť (Editable Poly). Díky ní ale budete moci objekt modelovat a přetvářet až do finál-
ní zamýšlené podoby.
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Začít můžete ale také 2D křivkou. Když vytvoříte základní profil, máte několik dostupných 
technik či modifikátorů, které přemění 2D profil ve skutečný 3D objekt. Princip je stejný, 
vytvořte si základní 2D tvar a aplikujte na něj editační modifikátor nebo ho zkonvertujte na 
editovatelnou křivku. 
Pojďme si shrnout obecný postup, jakým modelujete v 3ds Max libovolný objekt:

Identifikujte ve finálním zamýšleném objektu základní rysy a proporce. Vyberte si 
některé základní primitivum (nebo profilovou křivku), které se mu nejvíce podobá, 
a nastavte mu takový počet segmentů, jenž odpovídá důležitým rysům finálního objek-
tu. Vytvořte takový objekt.
Zkonvertujte objekt na jeho editovatelnou podobu (3D objekt na Editable Poly nebo 
Editable Mesh a 2D tvar na Editable Spline, Patch nebo NURBS). Alternativně přidejte 
objektu příslušný editační modifikátor.
Upravujte model pomocí nástrojů editovatelné sítě nebo modifikátoru až k výslednému 
tvaru.

Jak vyplývá z předchozího, musíte se vždy konverzí nebo modifikátorem dopracovat k editovatel-

né podobě objektu, jehož podobjektové struktury (vrcholy, hrany, polygony – o těch budeme 

hovořit později) vám umožní přetvářet vzhled modelu do požadované podoby. Vždy se vyvarujte 

nadměrnému zvyšování detailů (segmentů), kde to nebude třeba. Začínající uživatelé často 

s nedomyšlenými následky zvyšují počet segmentů na neúnosnou míru, navíc tam, kde to na 

modelu nebude vůbec vidět. Potřebujete takové detaily na modelu, který se nachází někde 

v pozadí? Samozřejmě že ne! Čím méně segmentů a detailů, tím rychlejší zpracování (samozřejmě 

s ohledem na požadovanou kvalitu modelu). Toto mějte během tvorby neustále na paměti. 

Stavební kameny aneb typy editovatelných objektů
Výborně. Už víte, jaký je postup v modelování, a naučili jste se konvertovat základní parame-
trické objekty na editovatelné sítě nebo křivky. Jaké jsou tedy všechny typy těchto objektů? 
Můžete si vybrat z následujících:

Základní primitiva (Standard nebo Extended Primitives) s možností editace základních 
parametrů. Nejde tedy o klasické editovatelné sítě, ale tvoří pro ně základ.
Polygonové a triangulární sítě (Editable Poly a Editable Mesh).
2D tvary, křivky (Shapes, Splines).
Křivky NURBS.
Pláty (Patches).

Konverze primitiv a zahájení praktického modelování 
Na příkladech si nyní ukážeme typický postup zahájení modelování. Řekněme, že budeme chtít 
vytvořit okno nebo obraz. Oba objekty mají jednu věc společnou. Půjde o obdélníkový tvar 
s rozmanitějším profilem. Následující kroky zobecňují tento postup:

1.

2.

3.

�

�

�

�

�

POZNÁMKA

ZAČÍNÁME S MODELOVÁNÍM
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Resetujte scénu Maxe (File → Reset) a nastavte jednotky (Customize → Units Setup). Jak 
jednotky zobrazení (Display Unit Scale), tak systémové jednotky (System Unit Setup) 
nastavte na centimetry.
Z hlavní nabídky Create → Standard Primitives vytvořte objekt Box s parametry podle 
obrázku 8.2.

Klepněte na Box ve výřezu pravým tlačítkem myši a vyberte Convert To → Convert To 
Editable Poly. Box ztratil své přirozené parametry, ale zato má nový, pro modelování 
cennější typ – editovatelnou polygonovou síť. Na modifikačním panelu přejděte do 
módu polygonů (klepněte na červený čtverec pod zásobníkem modifikátorů) a vyberte 
přední stěnu kvádru.
V rozevírací nabídce Edit Polygons vyberte příkaz Inset a podržte ve výřezu na vybraném 
polygonu kvádru levé tlačítko myši a táhněte s kurzorem směrem dolů. Až vytvoříte 
odsazený polygon (tloušťku rámu), pusťte levé tlačítko myši. Vytvoříte nový polygon 
jako na obrázku 8.3.

1.

2.

3.

4.

Obrázek 8.2. Základem mnoha objektů je jednoduchý Box (kvádr). Z něho můžete různý-
mi modelovacími technikami vytvořit i velmi složitý organický model.
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Nyní použijte ve stejné nabídce příkaz Extrude a zasuňte nově vzniklý polygon dovnitř 
(tvoříte směrem do středu okna či obrazu – skleněnou tabuli či plátno obrazu) v hloub-
ce tak 2 až 3 centimetry. Vytvoříte hloubku (obdélníkové vykousnutí) objektu.
Opakujte aplikování příkazů Inset a Extrude s citem (intuitivně) tak, abyste vytvořili 
podobu rámu obrazu nebo okna. Vytvořili jste hrubý model, který byste doladili tex-

5.

6.

ZAČÍNÁME S MODELOVÁNÍM

Obrázek 8.3. Příkaz Inset vytvoří nový odsazený polygon směrem dovnitř. Získáte tak 
základnu pro další manipulace, zejména zapuštění tohoto polygonu dovnitř kvádru.
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turami. Pro to by bylo třeba oddělit fyzicky část rámu a výplně, abyste mohli aplikovat 
různé materiály. 

Takovýto postup lze s obměnami příkazů aplikovat na další modely. Jdeme dále, vše nás ještě 
čeká!

Když importujete 3D modely a nevytváříte je od základu sami, načítají se do Maxe (File → 

Import) jako typ Editable Mesh, editovatelná trojúhelníková síť. Práce s nimi je podobná jako 

u Editable Poly. Doporučuje se ale používat právě editovatelnou polygonovou síť Editable Poly, 

protože má mnohem více nástrojů a pro moderní modelování je vhodnější.

Dílčí části editovatelného objektu 
pro modelování
V předchozí části jste měli možnost seznámit se s typem podobjektu polygon (zapamatujte si 
výraz „podobjekt“, budu se na něj často odkazovat). Pokud ho aktivujete klepnutím na ikonu 
podle obrázku 8.3, můžete s polygonem, tedy plochou se čtyřmi vrcholy tvořící část modelu, 
pohybovat, otáčet nebo měnit jeho velikost. Všechny transformace jsou aplikovatelné na poly-
gon stejně jako ostatní objekty i podobjekty.

Modelování pomocí transformace vrcholů a hran
Všechny modely konvertované na editovatelnou síť (ať už polygonální nebo trojúhelníkovou) 
můžete upravovat posunováním vrcholů, hran i polygonů. Vrcholy (vertex) jsou místem, kde se 
protínají hrany (edge) či dotýkají polygony, které mají tento vrcholy společný. 

POZNÁMKA

Obrázek 8.4. Využijte příkazy Inset a Extrude a máte velmi rychlý výsledek na světě v podobě 
důstojného modelu!
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Jak je patrné z obrázku 8.5, máte k nim přístup jednak výběrem názvu podobjektu v zásobníku 
modifikátorů (klepnutím na malé „+” nalevo od názvu Editable Poly nebo Editable Mesh) nebo 
pod zásobníkem v podobě ikon. Jakmile některý podobjekt vyberete, záznam se v zásobní-
ku podbarví žlutě a nemůžete pracovat s jiným podobjektem až do doby, než si tento další 
podobjekt zvolíte jako aktivní. V tomto módu nemůžete vybírat ani další objekty. Museli 
byste nejdříve podobjektový mód vypnout, a to klepnutím na aktuálně aktivní podobjektový 
mód. S aktivním podobjektovým módem můžete vybírat na modelu jeho vrcholy, hrany nebo 
polygony (více najednou jich vyberete se stisknutou klávesou Ctrl nebo tažením myši obdél-
níkovým výběrem).

Pokud budete mít zapnutý mód Preview Selection (náhled výběru) v rozevírací nabídce 

Selection, můžete vybírat všechny druhy podobjektových módů interaktivně bez nutného výbě-
ru jednoho z nich předem. Tento přepínač vidíte na obrázku 8.5.

K podobjektům můžete přistupovat také klepnutím pravým tlačítkem  myši na objekt a výbě-

rem podobjektu z levého horního kvadrantu čtyřnásobné nabídky. Klávesy 1, 2, 3, 4 a 5 taktéž 

postupně zpřístupní vrcholy, hrany, hranice, polygony a celý element. 

POZNÁMKA

TIP

DÍLČÍ ČÁSTI EDITOVATELNÉHO OBJEKTU PRO MODELOVÁNÍ

Obrázek 8.5. Vrcholy, hrany a polygony jsou základní podobjekty (Sub-objects), které můžete 
transformovat do celkové zamýšlené podoby modelu

podobjekty
(Sub-objects)

vrchol

hrana

polygon
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Pokud importujete libovolný model nebo na svém modelu po určité transformaci odhalíte 

černá místa vymykající se ostatním polygonům a částem 3D modelu, nejspíše máte chybně 

orientované normály. Funkce normály jsou vysvětleny ve druhé kapitole, v části „Zarovnávání 

objektů“. Klíčovým příkazem pro napravení nesprávné orientace polygonu je Flip Normals, který 

najdete v rozevírací nabídce Edit Polygons (u typu Editable Poly) nebo Surface Properties u Edi-

table Mesh.

Ještě než postoupíte k dalšímu bodu, vyzkoušejte si transformovat podobjekty editovatelné 
sítě. Je to základní princip modelování. Výběrem vrcholů můžete také otáčet nebo měnit jejich 
měřítko.

Automatizace výběru podobjektů u komplexních modelů
K usnadnění práce při výběru konkrétních podobjektů slouží hlavně příkazy Ring, Loop, 
Grow, Shrink, Convert To Face, Convert To Vertex a Convert To Edge. Pokud budete vybírat vícero 
podobjektů nebo jen budete chtít změnit aktuálně vybrané hrany na skupinu dotýkajících se 
polygonů a další kombinace, pochválíte si tuto sadu příkazů.

Výběr prstence hran
Řekněme, že máte vybranou jednu hranu jako na obrázku 8.6 n. Pokud budete chtít vybrat 
všechny rovnoběžné hrany, použijte příkaz Ring, který najdete hned v první rozevírací nabídce 
Selection objektového typu Editable Poly. Pak takto vybrané hrany můžete snadno transformovat 
nebo na ně aplikovat další příkazy.

TIP

Obrázek 8.6. n Ukázka příkazů Ring o a Loop p, které můžete použít s vybranou hranou n, 
aby se vám automaticky vybral řetěz rovnoběžných hran (Ring) nebo na sebe navazujících hran 
(Loop) utvářejících uzavřenou smyčku
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Výběr smyčky hran
Na obrázku 8.6 p vidíte výsledek aplikování příkazu Loop. Ten z jedné hrany vybere všechny 
navazující (dotýkající se koncem hrany té první), až se vybere celá smyčka.

V rozevírací nabídce Selection, kde tyto příkazy aktivujete, najdete také pole By Vertex (v jiných 

módech než Vertex stačí klepnout na vrchol objektu, abyste vybrali všechny hrany nebo poly-

gony, které se vrcholu dotýkají). Zapnuté pole Ignore Backfacing pak při výběru podobjektů 

například obdélníkovým výběrem způsobí, že nebudete moci vybrat podobjekty ležící na druhé 

straně modelu (vyberete jen ty podobjekty, které vidíte). Pokud bude pole Ignore Backfacing 

vypnuté, vyberete nejen podobjekty, které vidíte, ale i ty, které nevidíte a leží na druhé straně 

modelu. Proto byste si měli dávat na výběry s touto funkcí pozor. Poslední By Angle definuje, 

jaký musí být minimální úhel mezi normálami povrchu sousedních polygonů, aby byly vybrány 

všechny najednou, i když klepnete pouze na jeden z nich. 

POZNÁMKA

DÍLČÍ ČÁSTI EDITOVATELNÉHO OBJEKTU PRO MODELOVÁNÍ

o

Obrázek 8.6. op Ukázka příkazů Ring o a Loop p, které můžete použít s vybranou hranou 
n, aby se vám automaticky vybral řetěz rovnoběžných hran (Ring) nebo na sebe navazujících 
hran (Loop) utvářejících uzavřenou smyčku

p
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Zvětšení výběru polygonů
Máte-li vybraný například jeden polygon a hodláte výběr zvětšit (nejlépe rovnoměrně do všech 
stran), oceníte příkaz Grow. Ten centrickým způsobem postupně klepáním na tlačítko vybírá 

Obrázek 8.7. Příkaz Grow vám usnadní rovnoměrné zvětšení oblasti vybraných polygonů naba-
lováním na ten původní. Příkaz Shrink naopak oblast vybraných polygonů zmenšuje. Tyto příkazy 
využijte namísto ručního odebírání nebo přidávání polygonů k aktuálnímu výběru.

n

o
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všechny polygony, které se dotýkají toho prvního. Na obrázku 8.7 o vidíte ze dvou původně 
vybraných polygonů výsledek po čtyřech aplikováních příkazu Grow.

Zmenšení výběru polygonů
Když budete chtít vybranou oblast polygonů zmenšit, použijte příkaz Shrink. Díky němu docí-
líte velmi rychle rovnoměrně zmenšeného výběru polygonů. Příkaz Shrink je znázorněn jako 
postup směrem od obrázku 8.7 o k 8.7 n.

Změna aktuálního výběru na čelní plošky
Řekněme, že jste pracně vybrali konkrétní řadu hran a rádi byste vybrali přesně tentýž výběr, 
avšak vrcholů nebo sousedících polygonů, než abyste je museli vybírat ručně znovu. Když už 
jednou máte některé podobjekty různého typu vybrané, můžete mezi nimi přecházet. Tady je 
postup:

Vyberte si na modelu (např. jednoduché kouli konvertované na Editable Poly) libovolnou 
řadu vrcholů (podobjektový mód Vertex), která nemusí být uzavřená.
Klepněte na výběr pravým tlačítkem myši a v levém horním kvadrantu čtyřnásobné 
nabídky vyberte Convert To Edge. Vyberou se všechny hrany, jejichž součástmi jsou 
vybrané vrcholy. Pokud byste vybrali příkaz Convert To Face, výběr by se změnil na ty 
polygony, jejichž některé rohy by vybrané vrcholy utvářely. 
Přepněte se znovu do módu Vertex a s vybranými vrcholy zkuste stisknout a podržet 
klávesy Ctrl+Shift a pak klepněte na ikonu podobjektového módu hran (Edge) pod 
zásobníkem modifikátorů. Vyberou se pouze hrany, které spojují vybrané vrcholy. 

1.

2.

3.

DÍLČÍ ČÁSTI EDITOVATELNÉHO OBJEKTU PRO MODELOVÁNÍ

n

Obrázek 8.8. n Přepínání mezi podobjektovými typy je velmi cenný postup. S vybranými 
vrcholy můžete velmi rychle změnit výběr na jiný typ podobjektů (např. z vrcholů na hrany). 
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Výsledkem bude spojnice vybraných vrcholů. Stisknutím klávesy Ctrl a klepnutím na 
ikonu polygonu vyberete všechny polygony, jejichž součástí jsou vybrané vrcholy.

Mé nastavení uživatelského rozhraní odpovídá původnímu nastavení DesignVIZ.mental ray, 

které najdete v hlavní nabídce Customize → Custom UI and Default Switcher. To jen pro případ 

vaší kontroly, že by některé funkce nefungovaly podobně, jako popisuji v knize. 

Změna aktuálního výběru na hrany z polygonů
Pokud máte vybrané polygony, můžete velmi rychle změnit jejich výběr na hrany. To provedete 
se stisknutou klávesou Ctrl a klepnutím na ikonu hran (podobjektový mód Edges). Vyberou 
se jen obrysy polygonů, tedy hrany. Téhož efektu docílíte přes pravé tlačítko myši na objekt 
a Ctrl+výběr Convert To Edges. Zpětně pro tentýž výběr polygonů byste museli stisknout klávesy 
Ctrl+Shift. 

POZNÁMKA

Obrázek 8.8. oPřepínání mezi podobjektovými typy je velmi cenný postup. S vybranými 
vrcholy můžete velmi rychle změnit výběr na jiný typ podobjektů (např. z vrcholů na hrany). 

o
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Na tomto místě musím vyzkoušet vaši paměť. Jak se jmenuje nástroj, který vybrané skupině 

podobjektů přidělí název a vy si ji můžete prostřednictvím tohoto názvu kdykoli později vybrat? 

Ano, jedná se o pole Create Selection Set na hlavním panelu nástrojů. Tento princip platí pro 

všechny typy podobjektů. Takže abyste nemuseli znovu a znovu vybírat ty samé skupiny vrcho-

lů, hran nebo polygonů, vyžívejte sady pojmenovaných výběrů!

TIP

Obrázek 8.9. nZ vybraných polygonů n můžete vytvořit výběr hran o, a to stiskem klávesy 
Ctrl a klepnutím na ikonu podobjektového módu pro hrany Edge. Pokud byste stiskli současně 
klávesy Ctrl+Shift, vybraly by se středové, nikoli obvodové hrany polygonů.

DÍLČÍ ČÁSTI EDITOVATELNÉHO OBJEKTU PRO MODELOVÁNÍ
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Změna aktuálního výběru z polygonů nebo hran na vrcholy
Pokud máte vybranou určitou skupinu polygonů nebo hran, můžete ji zkonvertovat na výběr 
vrcholů. Princip je stejný jako v předchozích bodech, stačí stisknout klávesu Ctrl a klepnout 
na příslušnou podobjektovou úroveň prostřednictvím ikon, které se nacházejí pod zásobníkem 
modifikátorů.

Měkký výběr podobjektů
Někdy (spíše často) se vám hodí vybírat podobjekty „měkce“ s postupným úbytkem intenzity 
či síly výběru. To znamená, že pokud vyberete například jeden vrchol, vyberou se současně 
okolní vrcholy s definovaným úbytkem intenzity. Posunete-li tímto vrcholem, posunou se i ty 
okolní, avšak se snižující se silou čili méně (může to být i se záporným účinkem). Je to metoda 
organického modelování, aby 3D model neměl příliš ostré výčnělky. Obrázek 8.10 ukazuje 
příkaz Soft Selection v akci.

Obrázek 8.9. oZ vybraných polygonů n můžete vytvořit výběr hran o, a to stiskem klávesy 
Ctrl a klepnutím na ikonu podobjektového módu pro hrany Edge. Pokud byste stiskli současně 
klávesy Ctrl+Shift, vybraly by se středové, nikoli obvodové hrany polygonů.

Ctrl
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Postup využití tohoto nástroje je následující:
Zkonvertujte vybraný objekt na typ Editable Poly nebo Editable Mesh a zapněte některý 
z podobjektových módů Vertex, Edge nebo Polygon.

Přejděte do rozevírací nabídky Soft Selection a zapněte pole Use Soft Selection (použít 
měkký výběr).

Mód Soft Selection funguje také na typech geometrie Patch a Spline, o nichž budeme hovořit 

později.

Vyberte v pracovním výřezu jeden z podobjektů a pozorujte, jak Max barevně zvýraznil 
postupně slábnoucí výběr od centra po okraj. Pokud zapnete tlačítko Shaded Face Toggle, 
vystínují se polygony barvami tak, že červená barva označí hlavní výběr ovládaný při 
transformacích stoprocentně, oranžová barva naznačuje slabší vliv a zelená až modrá 
barva znamená minimální až žádný vliv (stručně řečeno, modré polygony při transfor-
macích ovlivníte minimálně, kdežto červené maximálně).

Parametr Edge Distance znamená, kolik hran od aktuálního výběru bude ovlivněno. Hrany, 
které jsou dále, budou ignorovány. Pokud je tato možnost vypnutá, využije se hodnota pole 
Falloff. Pole Affect Backfacing znamená, že při výběru podobjektů z jedné strany objektu budete 
současně vybírat i podobjekty na druhé (zadní) straně modelu.
Hlavní graf, který vidíte na obrázku 8.10, je určován třemi parametry – Falloff, Pinch a Bubble. 
Parametrem Falloff určujete hlavní kruhový dosah vlivu (síly) výběru, Pinch vytváří z vrcholu 
křivky větší špičku, čili výsledek transformace výběru bude ostrý vrchol, a poslední parametr 
Bubble naopak rozšiřuje vrchol křivky, takže transformace bude mít za následek pozvolný spád 
od středu výběru směrem ven, do stran. Vyzkoušejte si pozměňovat tyto hodnoty a pozorujte 

1.

2.

3.

POZNÁMKA

Obrázek 8.10. Měkký výběr zapínáte v rozevírací nabídce Soft Selection editovatelné síťoviny 
(Editable Poly i Editable Mesh). Je to vynikající způsob pro vytváření organických modelů. V tomto 
případě je vidět Soft Selection u Editable Poly (Editable Mesh má omezenější možnosti).

DÍLČÍ ČÁSTI EDITOVATELNÉHO OBJEKTU PRO MODELOVÁNÍ
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tvar křivky. Současně si vyzkoušejte aplikaci nad konkrétním objektem, postačí jednoduchá 
koule.
Část Paint Soft Selection vám nabídne možnost „malovat výběr“ po modelu (Paint), rozmlžo-
vat (mírnit) ostrost výběru (Blur) nebo kreslením po modelu výběr postupně rušit, anulovat 
(Revert). Malováním tak budete přebarvovat silné barvy vlivu (červené) barvami vyznačujícími 
slabý vliv (modré). Od červené postupně k modré budete tedy snižovat sílu výběru.

Hodnoty Falloff, Pinch a Bubble můžete nastavovat kurzorem myši přímo nad modelem v pra-

covním výřezu. Tato funkcionalita pro editování hodnot měkkého výběru byla uvedena poprvé 

ve verzi 2009 (hlavní nabídka Customize → Customize User Interface, karta Keyboard → Group 

→ Editable Poly → Edit Soft Selection). Pokud si definujete zkratku, můžete přímo z výřezu 

vyvolat možnost nastavení hodnot pro Falloff, Pinch a Bubble.

Pomocné objekty v modelování
Ještě před samotným modelováním byste měli znát objekty, které vám pomohou při modelová-
ní. Najdete je v hlavní nabídce Create → Helpers anebo na příkazovém panelu Create pod ikonou 
kategorie Helpers. Některé z nich mohou měřit vzdálenosti nebo prostě pomáhat při konstrukci 
složitějších prvků. Pojďme se podívat na jejich schopnosti.

TIP

Obrázek 8.11. Nastavení volby Edit Soft Selection pro interaktivní použití v pracovním výřezu
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Měření vzdáleností
Při konstrukčním modelování často potřebujete měřit vzdálenosti a ověřovat si, jak si vedete 
v přesnosti. K tomu poslouží jednak nástroj Measure Distance, který najdete v hlavní nabídce 
Tools. Jeho použití jsem nastínil ve druhé kapitole, části Měření vzdáleností mezi objekty. 
V modelování ale mnohdy potřebujete pevnější mantinely, něco jako pravítko. K tomu vám 
poslouží pomocný objekt Tape Measure, jejž najdete v hlavní nabídce Create → Helpers. Ve 
výsledném obrázku nebude vidět, tj. nelze ho renderovat. Je to zkrátka virtuální pomocník, 
který nijak do scény nezasahuje, pouze nahrazuje pravítko.

Postup využití pásky:
Z hlavní nabídky vyberte Create → Helpers → Tape Measure.
Dobré je zapnout přichytávání (2D nebo 3D Snap na hlavní nástrojové liště).
V pohledu k tomu určeném klepněte na první bod a podržte levé tlačítko myši, odkud 
chcete měřit. 
Se stisknutým levým tlačítkem myši táhněte k druhému bodu a pusťte nad ním levé 
tlačítko myši.
Vytvořili jste pásku, která nyní na modifikačním panelu měří vzdálenost mezi těmito 
dvěma body. 

Měření úhlů
Projektanti by se samozřejmě nesmířili s absencí nástroje na měření úhlů. Tuto funkci zastupu-
je nástroj Protractor, který najdete taktéž v hlavní nabídce Create → Helpers.
Postup měření úhlu mezi objekty: 

Najděte na modelu (nebo mezi modely) dva vrcholy pomyslného trojúhelníku, které 
budou ležet naproti měřenému úhlu.
Pomocí přichytávání (zapněte klávesu S, více viz bod „Nastavení pracovní mřížky, při-
chytávání objektů“ ve druhé kapitole) v těchto vrcholech vytvořte dva pomocné body 
Create → Helpers → Point (viz zelené křížky dole u dvěří). 

1.

2.

3.

4.

5.

1.

2.

Obrázek 8.12. Pomocný objekt Tape Measure umožňuje měřit vzdálenost mezi objekty

POMOCNÉ OBJEKTY V MODELOVÁNÍ
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Vyberte z nabídky úhloměr (Create → Helpers → Protractor) a umístěte ho tam, kde chce-
te měřit úhel. 
Nakonec s vybranou ikonou úhloměru přejděte na modifikační panel, klepněte na tla-
čítko Pick Object 1 a ve výřezu klepněte na první pomocný bod (Point01). Pak klepněte 
na tlačítko Pick Object 2 a ve výřezu vyberte druhý bod (Point02).
V části Angle se zobrazí měřený úhel.

V tomto postupu jsem záměrně využil další pomocný objekt – Point. Nebyl pro tento případ 

nutný, protože se můžeme přichytit přímo k bodům dveří, nicméně je vhodný k demonstraci 

jako další pomocník při modelování.

Využití kompasu
Při analýzách světelného řešení a k určení nejlepší orientace stavby ve vaší scéně se budete 
potřebovat zorientovat ve světových stranách. K tomu je určen nástroj Compass v podobě 
růžice, který vám ukáže správný směr (N – sever, S – jih, W – západ, E – východ). Pouhým 
otáčením kompasu ihned vidíte, kde je jaká světová strana.

3.

4.

5.

POZNÁMKA

Obrázek 8.13. Úhloměr Protractor měří velikost úhlu mezi dvěma body

měřený
úhel

pomocný 
bod 1

pomocný 
bod 2
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Kompas je součástí systému denního osvětlení Daylight. Právě jeho otáčením taktéž natáčíte 

světlo, které má tu vlastnost, že je „prostorově uvědomělé“ a můžete mu přiřadit libovolné místo 

i čas na zemi. Více se dočtete v deváté kapitole o světlech.

Definice bodu v prostoru jako záchytného prvku pro tvor-
bu 2D křivek ve 3D prostoru
Smysl pomocného objektu bod (Point) jsme ukázali u úhloměru. Nyní si ukážeme případ užití 
bodu v souvislosti s tvorbou 2D křivek ve 3D prostoru. Pokud chcete například vytvořit kmen 
stromu, větev, textilní vlákno nebo jen kabel visící ze střechy, měli byste to pro realističnost 
provést ve 3D. 
Postup využití bodů pro tvorbu křivky ve 3D prostoru:

Vytvořte libovolně v prostoru několik pomocných objektů Point (Create → Helpers).
Jejich polohu můžete přemístit posunem a zkontrolovat klávesou F12, kde můžete sou-
řadnice zadat přesně.
Zapněte přichytávání (Snap) klávesou S a nastavte typ Pivot.
Začněte kreslit 2D křivku z nabídky Create → Shapes → Line. V místě prvního bodu 
klepněte na levé tlačítko myši a táhněte s myší k dalšímu bodu. Znovu klepněte. Takto 
opakujte postup, než nakreslíte celou křivku. 
Ukončete tvorbu křivky klepnutím pravým tlačítkem myši. Více se o tvorbě křivek 
dozvíte v kapitole věnované 2D křivkám.

1.

2.

3.

4.

5.

POZNÁMKA

Obrázek 8.14. Body, jejichž přesnou polohu v prostoru zjistíte klávesou F12 se zapnutou trans-
formací „Select and Move“, slouží jako pomocné objekty pro tvorbu křivky ve 3D. K přichytávání 
k bodům musíte mít zapnutou volbu Pivot.

POMOCNÉ OBJEKTY V MODELOVÁNÍ

K1601.indd   195K1601.indd   195 14.1.2010   13:45:2414.1.2010   13:45:24



196 KAPITOLA 8   �   DÁVÁME MYŠLENKÁM TVAR: MODELOVACÍ TECHNIKY

Měření objemu a povrchu 3D tělesa
Měření povrchů a objemů libovolných těles je vhodné pro měření při stavebních úpravách, 
výkopových pracích a podobně. Můžete si například namodelovat terén pomocí vrstevnic 
a nechat si spočítat, kolik bude třeba vyvézt půdy při určitých terénních úpravách. Postup je 
v tomto případě velmi jednoduchý:

Jestliže máte správně nastavené měrné jednotky, vyberte měřený objekt a přejděte na 
panel Utilities.
Klepněte na tlačítko Measure. Ukáže se rozevírací seznam Measure, kde můžete vyčíst 
povrch (Surface Area) i objem tělesa (Volume).

Základní modelovací příkazy 
– tvarujeme hmotu
Určitě jste si už vyzkoušeli posunovat, otáčet nebo měnit velikost některých podobjektů. Jak 
už víme, máme tyto typy podobjektů u editovatelné polygonové sítě (pro důležitost tématu je 
neváhejme zopakovat):

vrcholy (vertex)
hrany (edge)
hranice (border)
polygony (polygon)
celý objektový blok (element)

Dlužím vám vysvětlení jednoho z nich. Border. Jde o hranici (uzavřený sled hran), které chybí 
uvnitř polygon, jak vidíte na obrázku 8.16. Pokud budete v módu hranice a nebudete moci 
vybrat žádnou smyčku hran, nejspíš zde hranice není. Vyzkoušejte si vytvořit jednoduchý 

1.

2.

�

�

�

�

�

Obrázek 8.15. Objem tělesa je 375 kubických metrů a povrch 450 čtverečních metrů. 
Můžete si ověřit: Původní kvádr měl rozměry 10x10x5cm a vyříznutý otvor 5x5x5.
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kvádr, zkonvertujte ho na Editable Poly a v módu Polygon mu odstraňte jednu stranu. Pak pře-
jděte do módu Border a zkuste vybrat hranici, kde jste polygon odstranili.

Přestože najdete v Maxovi typ editovatelné sítě složené z trojúhelníků – Editable Mesh, je to 

spíše z důvodu kompatibility minulých verzí, importů modelů a exportu modelů do některých 

herních enginů. Typ Editable Poly (síť složená z n-úhelníků, kde n>=4) je preferovaný typ, který 

už v mnohém překonal trojúhelníkovou síť. Naučte se s ní pracovat prioritně. Nic vám nebrání 

v konverzích mezi Editable Poly a Editable Mesh a naopak. Technologicky je ale Editable Mesh 

úspornější na paměť počítače, takže pokud výhradně nepotřebujte některou funkcionalitu 

v rámci Editable Poly, můžete Editable Mesh použít.

Na tyto podobjekty můžete používat kromě základních tří transformací také specifické příkazy, 
jako je kosení hran, vytahování nebo vsunování polygonů a další. V následujících pododdílech 
si probereme ty nejpoužívanější. Všechny následující úpravy jsou platné jak na objektech typu 
Editable Poly, tak s využitím modifikátoru Edit Poly, který taktéž zpřístupní možnosti editování 
podobjektů. Další možnost, jak přistupovat k editovatelné síti (trojúhelníkové), je klepnout 
pravým tlačítkem myši na záznam v zásobníku modifikátorů a vybrat Collapse All (sbalí či 
zhroutí celý zásobník se všemi modifikátory a konvertuje objekt na Editable Mesh) nebo Collapse 
To (sbalit zásobník až po vybraný modifikátor, ostatní modifikátory nad tímto místem zůsta-
nou zachovány).
V následujících kapitolách budeme předpokládat, že už nějaký model máte vytvořený (stačí 
Box), a na něm si budeme ukazovat základní modelovací příkazy. Po ukončení této sady 
příkazů přistoupíme k modelovacím technikám, které vám pomohou k uskutečnění vašich 
smělých požadavků na 3D modely. Využijeme tedy tuto základnu k pokročilejšímu polygo-
novému modelování, kde uvedeme i nové modelovací nástroje verze 3ds Max 2010 – Graphite 
Modeling Tools.

POZNÁMKA

Obrázek 8.16. Hranice (Border) je jedním z pěti podobjektů (Sub-Objects) 
editovatelné polygonové sítě

ZÁKLADNÍ MODELOVACÍ PŘÍKAZY – TVARUJEME HMOTU
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Vytvoření polygonu na modelu
Někdy z jakéhokoli důvodu (například importu, špatné modelovací úpravy a podobně) budete 
potřebovat upravit či znovuvytvořit nový polygon v místě, kde se nachází hranice (Border) nebo 
je zde chybný polygon. Postupujte takto:

Odstraňte vadný polygon (vyberte ho a stiskněte klávesu Delete) objektu, aby vznikl typ 
podobjektu Border, jak vidíte na obrázku 8.18.
V podobjektovém módu Polygon stiskněte tlačítko Create v rozevírací nabídce Edit 
Geometry.
Klepejte postupně od libovolného vrcholu na hranici k následujícím (v posloupnosti 
po hranici) a ukončete klepnutím na vrchol, na kterém jste začínali (při pohybu myší 
nad vrcholem změní kurzor tvar a upozorní na to, že můžete začít tvořit polygon nad 
tímto vrcholem. Všimněte si, že pokud umístíte myš nad polygon, změní se znovu tvar 
kurzoru myši). Vytvořili jste polygon.
Klepněte pravým tlačítkem myši pro ukončení příkazu Create.

Vložení vrcholu na libovolném místě modelu
Kdykoli budete potřebovat vytvořit v místě polygonu nový vrchol, pomocí jehož transformace 
byste mohli dále ovládat vzhled síťového modelu, využijete příkaz Insert Vertex. Stačí ho pouze 

1.

2.

3.

4.

Obrázek 8.17. Zhroucením zásobníku modifikátorů získáte přístup k Editable 
Mesh, tedy trojúhelníkové síti, kterou můžete editovat prostřednictvím úpravy 
vrcholů, hran a čelních ploch

zásobník
modifi kátorů

modifi kátor
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vybrat v rozevírací nabídce Edit Polygons a klepnout na požadované místo na modelu. Příkaz 
i výsledek vidíte na obrázku 8.19.

ZÁKLADNÍ MODELOVACÍ PŘÍKAZY – TVARUJEME HMOTU

Obrázek 8.18. Hranice Border je ideální místo pro zaplnění polygonem

chybí polygon

hranice Border

Obrázek 8.19. Příkazem Insert Vertex vložíte vrchol na libovolné místo polygonu
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Zvětšování a zmenšování obvodových hran polygonů
Zvětšit nebo zmenšit vnější hrany vybraných polygonů můžete pomocí příkazu Outline. Najdete 
ho v rozevírací nabídce Edit Polygons. Výsledek je patrný z obrázku 8.20. K aplikování tohoto 
příkazu stačí s aktivním příkazem vybrat polygon modelu a tažením myši ho zvětšit nebo 
zmenšit. 

Malá čtvercová tlačítka napravo od příkazů slouží k číselnému zadání hodnoty. Pokud se nesmí-

říte s pouhým tažením myši ve výřezu a přibližným nastavením hodnoty vybraného příkazu, 

využijte toto tlačítko a standardní měrné jednotky operace.

Vytažení polygonu se změnou jeho velikosti
Asi nejčastěji používané polygonové příkazy jsou Extrude a Bevel určené k vytahování a zasu-
nování polygonů. Příkaz Extrude dokáže vybraný polygon vysunout ven z modelu nebo ho 
zasunout do modelu s tím, že zachovává původní obrys (obvod hran polygonu). Bevel dělá to 
samé, ale navíc na konci operace umožňuje zvětšit nebo zmenšit koncový polygon. Na obrázku 
8.21 vidíte aplikování těchto příkazů postupně po sobě. 

Přemostění polygonů
Významným pomocníkem v připojování více modelů k sobě pomocí hranic je Bridge. Takto 
byste například mohli připojit dlaň k ruce nebo hlavu ke krku, pokud by byly vytvořené zvlášť. 
Nemusíte totiž vždy vytvářet všechny části složitějších modelů sami, protože někdy najdete dosta-
čující modely na Internetu a zásadní bude napojení modelu na vámi modelovanou část. Obrázek 
8.22 ukazuje přemostění mezi dvěma polygony dvou kvádrů připojených příkazem Attach.
Aby bylo napojení korektní, musely by mít obě části modelu stejný počet hran. Jinak by došlo 
k deformaci napojení a v tom případě by se čistota modelu degradovala.

POZNÁMKA

Obrázek 8.20. Příklad zmenšení polygonu pomocí příkazu Outline
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Vložení nového polygonu
Nové struktury vnořené do těch stávajících vyžadují více detailů. K tomu poslouží také příkaz 
Inset, který umožní vložit nový polygon (polygony) do aktuálně vybraných. Obrázek 8.23 vpra-
vo ukazuje vložení polygonů do všech vybraných pro přípravu následných akcí (např. Extrude, 
Bevel). K přesnému zadání hodnoty odsazení nově vloženého polygonu od toho původního 
využijte numerického zadání hodnoty malým čtvercovým tlačítkem napravo od příkazu Inset.

Obrázek 8.21. Ukázka příkazů Extrude a Bevel pro vytažení a zasunutí polygonů

Obrázek 8.22. Přemostění polygonů je vynikající způsob propojení dvou objektů, když se vám 
ruční metoda zdá pomalá. Jde o současné připojení objektů k sobě a vytvoření nových polygonů 
mezi dvěma sadami hran (hranicemi).

ZÁKLADNÍ MODELOVACÍ PŘÍKAZY – TVARUJEME HMOTU

Extrude

Bevel
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Převrácení polygonu
O normálách jsem už hovořil. Ukazují směr orientace polygonu, k němuž náleží. Někdy se po 
importu 3D modelu stává, že polygony mohou být špatně otočené (převrácené) a zdají se být 
v pracovním výřezu i renderu černé ve srovnání s ostatními polygony. V takovém případě použij-
te příkaz Flip a převraťte polygon, aby byl správně orientován (tak, jak ho chceme vidět). 

Otočení polygonu kolem hrany
Obrázek 8.24 ukazuje využití příkazu Hinge From Edge, kdy můžete vybrat hranu, kolem které 
se bude otáčet vybraný polygon. Můžete také zajistit přírůstkové otáčení (v našem případě 6,5 
stupně) – opět přes numerické tlačítko.

Obrázek 8.24. Když budete vědět, že chcete otáčet vybraný polygon 
kolem jedné jeho hrany, využijete příkaz Hinge From Edge

Obrázek 8.23: Příkaz Inset pro vložení nových polygonů do aktuálně vybraných. Můžete tak 
zvýšit detaily a připravit si nové polygony pro další polygonální příkazy.

Hinge From Edge

hrana, kolem které 
se polygon otáčí

K1601.indd   202K1601.indd   202 14.1.2010   13:45:2714.1.2010   13:45:27



203

8
M

o
d

e
lo

v
a

cí
 

te
ch

n
ik

y

Vytažení polygonu podél křivky
Řekněme, že jste si nakreslili křivku lidské paže a rádi byste podél ní nechali automaticky 
vytvořit polygonální „tunel“ tvořící 3D model paže. Zadali byste jen počet segmentů po cestě. 
Použijte příkaz Extrude Along Spline. Bez tohoto příkazu byste tuto proceduru museli provést 
ručně a po každém vytažení polygonu (příkazem extrude) byste museli tyto polygony prosto-
rově usadit a nastavit jim správnou orientaci. A takových segmentů může být několik, což by 
vás jistě zdrželo.

Tento příkaz je dostupný obdobně jako ostatní příkazy na třech místech:
Jednak na panelu Modify, mezi příkazy rozevíracích nabídek Edit Polygons nebo Edit 
Geometry.
Pak také přes čtyřnásobnou nabídkou vyvolanou klepnutím pravým tlačítkem myši na 
objekt.
Nebo na kartě Graphite Modeling Tools pod hlavním nástrojovým panelem.

Pohyb vrcholu po hraně
Častokrát budete chtít posunout vrcholem po hraně, aby pozice hrany zůstala zachována. 
Tedy vrchol bude „bruslit“ po hraně, aniž by narušil její topologii. K tomu použijete omezení 
Constraints → Edge, které je dostupné v rozevírací nabídce Edit Geometry vybraného objektu 
konvertovaného na Editable Poly (a se zapnutým podobjektovým módem Vertex). Když zapnete 
toto omezení, ztrácíte možnost volného pohybu vrcholu ve 3D prostoru, ale jste omezeni pouze 
na jeho pohyb po hranách, které vedou do vybraného vrcholu.

1.

2.

3.

ZÁKLADNÍ MODELOVACÍ PŘÍKAZY – TVARUJEME HMOTU

Obrázek 8.25. Ukázka příkazu Extrude Along Spline, kdy jsou polygony vytaženy podél 2D křivky

křivka jako cesta pro 
vytažení polygonu
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Ve stejné části rozevírací nabídky Edit Geometry najdete také omezení na pohyb vybraného 

podobjektu po čelní ploše (Face) nebo normále (kolmici k polygonu). Pokud chcete zachovat 

volný pohyb podobjektu (vrcholu, hrany nebo polygonu) ve 3D, vyberte možnost None (bez 

omezení).

Tlačítko Repeat Last, které se nachází nad částí s omezeními Constraints, umožní vykonat napo-

sledy provedený příkaz na nově vybraném podobjektu. Pokud jste například naposledy použili 

příkaz Bevel a chcete ho provést na dalším polygonu, stačí si tento polygon vybrat a klepnout 

na tlačítko Repeat Last. Příkaz Bevel se provede se stejnými hodnotami i na něm.

Zjednodušení geometrie zhroucením podobjektu 
do jednoho středu
Když u modelu zjistíte, že má v určitém místě mnoho polygonů, můžete je redukovat pomocí 
příkazu Collapse. Všechny se pak jakoby zhroutí do váženého středu. Tento příkaz můžete 
použít i na hrany a vrcholy. Obrázek 8.27 ukazuje využití příkazu Collapse na tři vrcholy. 

Při modelování se často stává, že dva vrcholy, ze kterých chcete udělat jeden, jsou daleko od 

sebe a nelze je svařit (Weld). I když byste pro svaření mohli zvýšit prahovou hodnotu (tzv. 

Threshold), takže by svaření nakonec prošlo, je dobrá praxe použít na vybrané vrcholy právě 

příkaz Collapse, který vrcholy svaří bez ohledu na jejich vzdálenost.

POZNÁMKA

TIP

TIP

Obrázek 8.26. Pro zachování celkové topologie modelu a pouhé posunování vrcholů pro jejich 
rovnoměrné rozložení na povrchu modelu využijete omezení Constraints → Edge

vrchol se posunuje po přilehlých hranách
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Vzájemné připojení a odpojení objektů
Už jste zkoušeli příkaz Bridge pro přemostění polygonů mezi dvěma objekty? Pokud ano, zjistili 
jste, že objekty musíte nejprve připojit příkazem Attach. Ten je nutný pro spoustu dalších apli-
kací a příkazů (včetně práce se 2D křivkami). Připojení fyzicky znamená, že budete objektem 
pohybovat jako s jednou entitou, a když přejdete do některého podobjektového módu, budete 
moci pracovat s oběma objekty naráz. Půjde o jeden celistvý editovatelný blok – jeden objekt 
typu Editable Poly.
Postup připojení objektů:

Vyberte v pracovním pohledu jeden objekt, který chcete připojit k dalším(u).
Zkonvertujte ho na Editable Poly (nebo mu přiřaďte modifikátor Edit Poly) a přejděte na 
panel Modify.
V rozevírací nabídce Edit Geometry stiskněte tlačítko Attach a ve výřezu klepněte na 
druhý objekt, k němuž chcete ten první připojit. Pokud byste chtěli hromadně připojit 
více objektů, klepněte místo na tlačítko Attach na malé čtvercové tlačítko nacházející 
se napravo od něj. Tady vyberte ze seznamu všechny požadované objekty podle názvu 
a potvrďte klepnutím na Attach.

Postup odpojení (pod)objektů:
V podobjektovém módu vyberte sadu vrcholů, hran nebo polygonů, které chcete od 
modelu odpojit, aby se chovaly nezávisle.
Přejděte na panel Modify a v rozevírací nabídce Edit Geometry stiskněte Detach. Nabídne 
se dialogové okno Detach, kde máte dvě možnosti. Nejčastěji ale nevyužijete žádnou 
z možností, proto nezapínejte ani jednu z nich a potvrďte oddělení klepnutím na tla-
čítko OK. 

1.

2.

3.

1.

2.

ZÁKLADNÍ MODELOVACÍ PŘÍKAZY – TVARUJEME HMOTU

Obrázek 8.27. Příkaz Collapse svaří (sbalí) vrcholy nebo další podobjekty do jednoho bodu, 
který představuje vážený střed vybraných podobjektů. Funguje bez ohledu na vzdálenost mezi 
podobjekty, což není případ příkazu Weld (svaření vrcholů).
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Možnosti Detach To Element odpojí vybrané podobjekty jako samostatný element v rámci 

Editable Poly. Půjde tedy o samostatný blok, ale stále součást jednoho Editable Poly objektu. 

Pokud vyberete Detach as Clone, vytvoříte samostatnou kopii vybraných podobjektů jako nový 

objekt, původní výběr zůstane zachován a nijak se neoddělí.

Krájení a řezání 3D modelu
Když budete chtít vést řez modelem, který neprochází zrovna v místě smyčky hran, protože 
hrany probíhají jinak, použijte příkaz Slice Plane. Postup je následující:

Zkonvertujte objekt na Editable Poly nebo přidejte modifikátor Edit Poly.
V podobjektovém módu Polygon nebo Element vyberte všechny polygony nebo celý 
element, kudy má procházet řez. Klepněte na tlačítko Slice Plane.

Natočte a posuňte řeznou rovinu podle vašich představ, kudy má řez probíhat. Pokud 
byste stisknuli tlačítko Reset Plane, zarovnala by se rovina do původní pozice.
Pokud chcete model fyzicky rozdělit na dvě části, zapněte pole Split a pak klepněte na 
tlačítko Slice pro potvrzení a dokončení řezu. 
Nyní v podobjektovém módu Element ověřte, že jde o dvě části modelu, se kterými 
můžete pohybovat nezávisle.

Příkaz QuickSlice provádí totéž co Slice Plane, ale řeznou rovinu vytvoříte ihned po prvním 

klepnutí do výřezu. Interaktivní manipulací ji nasměrujete a po druhém klepnutí ji skutečně 

vytvoříte. Současně model v místě řezu fyzicky oddělíte.

Modelovací řezy aneb vžijte se do role digitálního chirurga
Velmi důležitým, řekl bych až nepostradatelným nástrojem pro 3D modeláře, je nástroj Cut. 
Pomocí něj můžete přidávat na povrch modelu libovolné detaily. Z kvádru můžete vytvořit 

1.

2.

3.

4.

5.

POZNÁMKA

POZNÁMKA

Obrázek 8.28. Připojení objektů a oddělení podobjektů od původního modelu 
se vám hodí při každém modelování
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například model postavy. Samozřejmě ještě s transformacemi se vzniklými podobjekty. Pojďme 
se podívat na typický postup jeho použití.

Natočte si model na místo, kde povedete řez (ten může být i nepravidelný na rozdíl od 
řezné roviny).
S modelem typu Editable Poly klepněte na panelu Modify na tlačítko Cut, které najdete 
v rozevírací nabídce Edit Geometry (nemusíte být v žádném podobjektovém módu).
Pohybujte kurzorem myši nad modelem a pozorujte změnu kurzoru při pohybu nad 
vrcholem, hranou nebo polygonem. 
Klepněte myší na místo, odkud chcete řez vést, a postupně klepejte na model tam, kde 
chcete mít vrcholy. Takto můžete vytvořit libovolné hrany, kdekoli si přejete. Záleží jen 
na vaší fantazii a připravenosti modelu ve vaší mysli. 

1.

2.

3.

4.

Obrázek 8.30. Nástroj Cut je primárním příkazem pro organické modelování, kdy budete potřebo-
vat řezat libovolně po povrchu modelu a vytvářet tak nové hrany a zdrojové prvky pro modelování

ZÁKLADNÍ MODELOVACÍ PŘÍKAZY – TVARUJEME HMOTU

Obrázek 8.29. Řezná rovina Slice Plane vám dovolí vést řez libovolným místem modelu. Získáte 
tím nové hrany rozdělující objekt na dvě části.

řez pomocí 
Cut
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Všimněte si také změny kurzoru myši, když se pohybujete nad hranami, vrcholy nebo polygony. 

Je to dobré vodítko, abyste věděli, odkud a kam vedete řez.

Zaoblení modelů a zvýšení hustoty modelu 
na podobjektové úrovni
Během modelování můžete chtít zvýšit detail síťového modelu, a to buď zaoblením ostrých 
hran, resp. prostým dílčím dělením plochy na jemnější síťovinu. K tomu dobře poslouží příkazy 
MSmooth, resp. Tessellate. MSmooth je podobný modifikátoru MeshSmooth s tím rozdílem, že 
MSmooth funguje na vybrané podobjekty v rámci Editable Poly, kdežto modifikátor MeshSmooth 
se aplikuje na celý model.

Na obrázku 8.31 vidíte výsledek několikerého aplikování příkazu MSmooth na jednoduchou 
krychli. Pojďme si přiblížit postup tvorby tohoto balonu.

Jednoduchou krychli (Box) konvertujte na typ Editable Poly a aplikujte MSmooth (1x 
klepněte na malé čtvercové tlačítko napravo od názvu MSmooth a pak 2x stiskněte tla-
čítko Apply).

1.

POZNÁMKA

Obrázek 8.31. Balon vznikl velmi jednoduchými technikami. MSmooth, Chamfer a Bevel vytvoří 
velmi pěkný vzhled a švy mu dodají realističnost
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Vyberte hrany, které na obrázku oddělují barevné části balonu. Aplikujte na ně příkaz 
Chamfer s nízkou hodnotou Chamfer Amount. V těchto místech se vytvoří rozestupy, 
které budou tvořit základ pro pěkné švy.
Zkonvertujte tento výběr hran na polygony stiskem klávesy Ctrl a klepnutím na ikonu 
polygonu. Stiskněte tlačítko Shrink pro zúžení výběru pouze na vzniklý úzký pás poly-
gonů.
Příkazem Bevel zapusťte tyto polygony dolů. Součástí tohoto příkazu je také zmenšení 
polygonů, které následuje po zapuštění. 
Teď už stačí pouze nastavit různé barvy pro vzniklé části balonu. O tom budeme hovořit 
v kapitole o materiálech.

Na obrázku 8.32 vidíte, jak můžete přidat dělení plochy jednoduché krychli a zvýšit husto-
tu síťoviny, která měla původně jenom 1 segment. Stačí, když si vyberete libovolný polygon 
a stisknete Tessellate. Pokud třeba na začátku modelování zapomenete přidat krychli dostatečný 
počet segmentů, můžete tak provést příkazem Tessellate na vybrané skupině polygonů.

Zarovnání vrcholů do jedné roviny
Velkým pomocníkem pro případ, kdy budete chtít zarovnat vybrané vrcholy do jedné roviny 
(podmínka tzv. koplanarity), je příkaz Make Planar (planární = rovinný). Najdete ho v rozeví-
rací nabídce Edit Geometry v rámci Editable Poly. Stačí, když vrcholy vyberete a stisknete tlačítko 
Make Planar. Můžete také vybrat, ve kterých osách chcete zarovnání provést (X, Y a Z).

2.

3.

4.

5.

Obrázek 8.32. Tessellate dokáže dělit síťový model a zvýšit hustotu či detail pro další modelování. 
Lokální příkaz v rámci Editable Poly má tu výhodu, že může operovat pouze na vybrané skupině 
polygonů

ZÁKLADNÍ MODELOVACÍ PŘÍKAZY – TVARUJEME HMOTU
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Další příkazy View Align, Grid Align a Relax slouží k následujícím operacím v zarovnávání. View 

Align dokáže zarovnat vybraný podobjekt (i vybrané vrcholy) s pohledem (kamerou), aby nor-

mály těchto podobjektů směřovaly přímo proti aktuálnímu pohledu. Grid Align má stejnou 

funkci jako View Align, avšak s využitím aktivní konstrukční mřížky jako cíle zarovnání. Relax se 

hodí, pokud budete chtít zmírnit pnutí mezi podobjekty (např. vrcholy, které jsou příliš blízko 

u sebe, se od sebe vzdálí) a docílit rovnoměrného rozložení podobjektů utvářejících síťový 

model. 

Usnadnění práce s podobjekty
Až budete pracovat na komplexních polygonových modelech, budete vděční za příkazy pro 
skrývání vybraných podobjektů. Stačí si například vybrat sadu polygonů, na kterých chcete 
zrovna pracovat, a skryjete si zbývající příkazem Hide Unselected. Nebo můžete skrýt vybrané 
a pracovat na ostatních podobjektech (Hide Selected). Tyto příkazy fungují pouze na vrcholech 
a polygonech. 

Příkaz Unhide All, který vyvoláte pravým tlačítkem myši v pracovním výřezu ve čtyřnásobné 
nabídce, neodkryje podobjekty, protože funguje pouze na hlavní objekty. Pokud chcete skrývat 
a odkrývat podobjekty, musíte to provádět výhradně přes příkazy v rozevírací nabídce Edit 
Geometry editovatelné polygonové sítě a navíc se zapnutým podobjektovým módem, kde chcete 
skrytí/odkrytí provést.

POZNÁMKA

Obrázek 8.33. Příkazem Hide Unselected jsem skryl všechny polygony kromě vybraného obli-
čeje postavy a pojmenoval jsem tuto sadu „face“. Kdykoli se k ní přes tuto nabídku dostanete. 
Schované polygony odkryjete příkazem Unhide All.
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Poslední část v rozevírací nabídce Edit Geometry se nazývá Named Selections. Už víte, k čemu 

jsou sady pojmenovaných výběrů určené. V této části můžete příkazem Copy pojmenovanou 

sadu zkopírovat a pak přenést tento výběr na další objekt tlačítkem Paste. Aby to mělo smysl, 

měly by mít oba objekty stejný počet polygonů (např. z obličeje na obličej vycházející ze stejné-

ho základu, odlišné jen díky různé manipulaci s podobjekty).

Zachování ostrých hran u organických modelů 
(se zaoblenými tvary)
Opovědí jsou Smoothing Groups nebo příkaz Chamfer. Pojďme to vzít postupně. Abyste měli 
představu, o co vůbec jde, podívejte se na obrázek 8.34. Vidíte zde model postavy, jejíž rty vlevo 
obsahují jiné skupiny vyhlazení povrchu modelu (jiné Smoothing Groups) než zbytek obličeje, 
kdežto vpravo je celý model jedna skupina Smoothing Group. I když pak použijete techniky pro 
organické zaoblení celého modelu, zůstanou různé části s různými Smoothing Groups vizuálně 
s oddělenými ostrými hranami.
Postup využití Smoothing Groups:

Přejděte do podobjektového módu Polygon a vyberte na modelu ty polygony, které mají 
být ostře ohraničené (s ostrými hranami).
V rozevírací nabídce Polygon: Smoothing Groups vyberte jinou hodnotu, než mají ostatní 
polygony. Všimněte si ostrého ohraničení polygonů této oblasti od ostatních polygonů.

I když teď uděláme skok vpřed do kapitoly o modifikátorech, vyzkoušejte si na váš model s takto 

nastavenými Smoothing Groups aplikovat modifikátor TurboSmooth z hlavní nabídky Modifiers 

→ Subdivision Surfaces. U něj zapněte v části Surface Parameters pole Smoothing Groups. 

Všimněte si oddělení hranic těchto polygonů od ostatních i přes aplikování organického vzhle-

du pomocí TurboSmooth.

1.

2.

POZNÁMKA

TIP

Obrázek 8.34. Model postavy vlevo má v místě rtů jinou hodnotu Smoothing Groups než model 
vpravo, který má celý jednu hodnotu. Rozevírací nabídku Smoothing Groups najdete v rámci 
podobjektového módu Polygon uvnitř Editable Poly

ZÁKLADNÍ MODELOVACÍ PŘÍKAZY – TVARUJEME HMOTU
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Druhou možností uchování ostrých hran s celkově zaobleným modelem je použití příkazu 
Chamfer. Pokud u modelu vytvoříte zkosení hran, vytvoří se dvě hrany z jedné, a proto zůstanou 
při aplikování TurboSmooth zachovány, jak to vidíte na obrázku 8.35. 

Pod čísly označujícími skupiny vyhlazení (Smoothing Groups = SG) polygonů najdete také příkaz 

Select By SG. Pomocí něj vyberete všechny polygony nacházející se ve stejné skupině. Příkaz 

Clear All vymaže všechny přidělené SG polygonům a Auto Smooth přiřadí automaticky čísla SG 

polygonům na základě prahové hodnoty (úhlů mezi čelními plochami) definované napravo od 

tlačítka Auto Smooth.

Práce s dílčím dělením plochy 
– vyhlazování polygonů a větší detaily
Podívejte se na obrázek 8.36. Určitě jste si říkali, jak jednoduše modelovat 3D tvary a současně 
zachovávat rozumné množství uchopitelných podobjektů (detail 3D modelu může být vysoký, 
ale hran, vrcholů a polygonů je tolik, že jen stěží můžete s přijatelným výsledkem modelovat). 
K tomuto slouží rozevírací nabídka Subdivision Surface. Tady máte několik užitečných příkazů, 
které můžete použít k zaoblení hran modelu a přidání většího detailu. Tak například na obráz-
ku 8.36 je výsledek zapnutí pole Use NURMS Subdivision. NURMS znamená Non-Uniform Rational 
Mesh Smooth a umožní ihned vidět zaoblení modelu, a to s rozlišením, co vidíte v pracovním 
pohledu a co bude ve finálním renderu (části Display a Render kontrolují počet iterací Iterations 
= počet aplikování zaoblení), odděleně v pracovním pohledu a v renderu. Parametr Smoothness 
se pohybuje od hodnoty 0 k 1. Hodnota 0 znamená, že nedojde k žádnému zaoblení, i když 
nastavíte parametr Iterations, a hodnota 1 zaoblí všechny polygony bez ohledu na to, jak ostré 
jsou hrany.

Tzv. iterace, čili počet aplikování zaoblení způsobuje rychlé čerpání RAM paměti. Každá iterace 

znamená čtyřnásobný počet polygonů a tím i větší využití paměti. Zvyšujte iterace velmi opatr-

ně, můžete zcela zahltit svůj systém a nevyhnete se restartu počítače!

POZNÁMKA

POZNÁMKA

Obrázek 8.35. Objekt Hedra ve variantě Dodec/Icos n, s aplikovaným modifikátorem 
TurboSmooth o a varianta s nejprve vybranými všemi hranami + příkaz Chamfer 
a posléze aplikovaný TurboSmooth p. Ve třetím případě jsou hrany zachovány 
a model je zaoblený. Míra ostrosti hran záleží na hodnotě zkosení (Chamfer Amount).

o pn
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Pole Smooth Result přiřadí všem polygonům stejnou skupinu vyhlazení (Smoothing Group), 
takže se celý model bude zdát zaoblený bez výrazných ostrých hran a předělů. Pole Isoline 
Display skryje nadbytečné hrany, takže práce s modelem bude přehlednější. Show Cage zobrazí 
obklopující síť (oranžově), pomocí které budete moci na podobjektové úrovni upravovat orga-
nický zaoblený model. 

Deformujeme povrch kreslením po modelu
Mnohdy je jednodušší „malovat“ po modelu myší pro vytvoření požadovaných detailů, než 
manipulovat s jednotlivými podobjekty. Typ geometrie Editable Poly nabízí rozevírací seznam 
Paint Deformation obsahující štětce, kterými můžete kreslit po modelu a deformovat tím jeho 
povrch. Pomocí tlačítka Push/Pull je možné zatlačovat nebo naopak vytahovat části povrchu 
modelu podle nastavení štětce. Při stisknutí tlačítka Push/Pull, Relax nebo Revert a pohybu myší 
nad 3D modelem se kruhový kurzor myši dynamicky přizpůsobuje povrchu. Po stisknutí 
levého tlačítka myši se začne povrch deformovat podle nastavení v polích Push/Pull Value, Brush 
Size a Brush Strength. Ovlivněné plochy pod štětcem se standardně pohybují podle normál, tedy 
kolmo vzhůru (viz volba Original Normals).

Pole Push/Pull Value definuje vzdálenost pohybu vrcholů pod kurzorem myši. Kladné 
hodnoty tlačí vrcholy vzhůru, záporné hodnoty naopak dolů.
Brush Size definuje velikost kurzoru, tedy plochu, která je štětcem ovlivněna.
Brush Strength (síla štětce) je parametr, který určuje sílu efektu. Pokud sem zadáte 
například hodnotu 0.5, pak vzdálenost vytlačení či zatlačení povrchu bude poloviční. 
Se stisknutými klávesami Shift+Alt a tažením levého tlačítka myši ve výřezu určujete 
interaktivně sílu štětce.

�

�

�

Obrázek 8.36. Primitivní objekt Tube vypadá díky možnosti Use NURMS Subdivision jako hlad-
ký a organický model. Použil jsem dvě iterace (Display → Iterations), a pokud budu pracovat na 
podobjektové úrovni se zapnutou volbou Isoline Display a Show Cage, práce bude přehlednější 
a současně uvidíte zaoblený model.

ZÁKLADNÍ MODELOVACÍ PŘÍKAZY – TVARUJEME HMOTU
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Pro deformaci kreslením můžete využít přednastavených velikostí a tvarů štětce, které jsou 

dostupné přes pravé tlačítko myši na hlavní panel nástrojů → Brush Presets. Můžete si přidávat 

svá vlastní nastavení (tlačítko Add New Preset). Samozřejmě platí, že kvalita deformace záleží na 

rozlišení síťoviny modelu. Čím více segmentů, tím lépe budou deformace vypadat. Pro tyto 

účely je vhodnější 64bitový operační systém, kde deformace kreslením fungují mnohem rych-

leji než v případě 32bitových operačních systémů.

Příkaz Relax je určen k odstranění všech extrémů v podobě příliš natěsnaných vrcholů. 
Kreslením po modelu je oddalujete a vytváříte tak uvolněnější terén s rovnoměrně rozloženými 
vrcholy. S příkazem Relax, který má shodnou funkci, jsme se mimochodem setkali už v rozeví-
rací nabídce Edit Geometry (a ještě setkáme u modifikátorů). Příkazem Revert vracíte deformace 
do původní polohy, tedy rušíte výčnělky a prohlubně zpátky na jejich počáteční úroveň. 
Můžete si také vybrat osu, podle které chcete deformovat povrch. Pokud si tedy vyberete 
například osu X, budou vrcholy pod štětcem uhýbat podle osy X. Pokud máte ambice upravit 
si tvar deformačního štětce, můžete to provést tlačítkem Brush Options. V dialogu Painter Options 
tak můžete nastavit vlastnosti štětce, které ovlivní výsledný tvar deformovaného povrchu. Na 
obrázku 8.38 vidíte tvar křivky určující charakter deformace.
Až budete chtít všechny změny, které jste na povrchu modelu provedli, potvrdit, stiskněte 
tlačítko Commit. Pokud tak provedete, nebudete moci vrátit změny zpět příkazem Revert. 
Tlačítkem Cancel zrušíte provedené deformace zpátky ke stavu před malováním štětcem.

Základní příkazy pro práci s vrcholy 3D modelu
Vrcholy jsou stejně jako polygony důležité podobjekty, se kterými můžete posunovat, otáčet je 
a měnit jejich velikost. Tím udáváte svému modelu zamýšlený tvar. Pokud zkonvertujete model 
na typ Editable Poly, vstoupíte do podobjektového módu Vertex a přejdete na panelu Modify do 
rozevírací nabídky Edit Vertices, uvidíte zde všechny příkazy, které můžete s vrcholy provádět, 
jak je patrné z obrázku 8.39.

TIP

Obrázek 8.37. Terén můžete vytvořit pomocí funkcí Paint Deformation velmi snadno. Zápornými 
i kladnými hodnotami Push/Pull Value modelujete prohlubně i výčnělky.
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Podobjektový mód Vertex s vybraným objektem typu Editable Poly můžete otevřít stiskem klá-

vesy „1“. Pro hrany platí „2“, pro polygony „3“, hranice aktivujete stiskem „4“ a celý element pak 

klávesou „5“.

TIP

Obrázek 8.38. V dialogu Painter Options můžete nastavit vlastnosti štětce, kterým deformujete 
povrch. Najdete tady také možnost zrcadlit deformace podle vybrané osy (pole Mirror).

ZÁKLADNÍ MODELOVACÍ PŘÍKAZY – TVARUJEME HMOTU

Obrázek 8.39: Rozevírací nabídka Edit Vertices se objeví, když jste v podobjektovém módu Vertex. 
Máte zde sadu příkazů, které můžete použít výhradně na vrcholy v rámci Editable Poly.
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Odstranění vrcholu z modelu
K odstranění vrcholu z modelu (například kvůli zjednodušení modelu) můžete přistupovat 
dvěma způsoby. 

Buď stisknete klávesu Delete a odstraníte nejen vrchol, ale také polygon, který je na 
vrchol připojen.
Nebo stisknete tlačítko Remove, které odstraní vrchol a ponechá vespod ležící polygon. 
Pro tento příkaz můžete použít také klávesu Zpět (Backspace).

Rozpojení vrcholů
Do vrcholu standardně ústí čtyři hrany. Pokud pohnete vrcholem, následují i tyto hrany. 
V modelování se můžete setkat se situací, kdy budete potřebovat rozpojit vrchol, abyste mohli 
hrany s ním spojené ovládat samostatně. Na obrázku 8.40 vidíte výsledek aplikování příkazu 
Break na vybraný vrchol.

Vytažení vrcholů do podoby hrotů modelu
Všude, kde máte vrcholy, můžete docílit vytažení vrcholů z definované základny, jak to je 
patrné z obrázku 8.41. K tomu je určený příkaz Extrude v rozevírací nabídce Edit Vertices. Pokud 
klepnete na tlačítko pro numerické zadání hodnot napravo od názvu Extrude, objeví se dialog 
Extrude Vertices se dvěma parametry. 

Extrusion Height pro definici výšky vytažení vrcholu.
Extrusion Base Width pro definici poloměru základny, ze které vrchol vychází. 

Postup využití tohoto příkazu lze shrnout do dvou kroků.
Vyberte na podobjektové úrovni libovolné vrcholy, které chcete vytáhnout do výšky 
směrem od modelu nebo naopak zapustit dovnitř modelu.
Stiskněte numerické tlačítko Extrude v rozevírací nabídce Edit Vertices a nastavte parame-
try Extrusion Height a Extrusion Base Width, jak jsme uvedli výše. Stiskněte tlačítko Apply 
pro několikerou aplikaci tohoto efektu za sebou nebo rovnou stiskněte tlačítko OK pro 
potvrzení aktuálního vytažení vrcholů.

1.

2.

1.

2.

1.

2.

Obrázek 8.40. Použitím příkazu Break můžete docílit rozpojení modelu v místě vybraného vrcho-
lu, takže získáte 4 nezávislé vrcholy na místo jednoho
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Svaření vrcholů na 3D modelu
Pokud najdete na modelu chybu v podobě díry, mezery nebo evidentně nesvařených vrcholů, 
použijte příkaz Weld. Stačí oba vybrat a stisknout tlačítko Weld. Následující postup popisuje 
nejběžnější případ použití příkazu:

Zjistíte chybu v modelu jako na obrázku 8.42. Může to být také výsledek příkazu Break 
nebo prostě chybně importovaného modelu.

1.

Obrázek 8.41. Příkaz Extrude Vertices využijete pro 
vytažení vrcholů z polygonové sítě. Můžete tak vytvořit 
objekty s ostrými výčnělky, výrůstky a podobně n. Velmi 
rychle lze s využitím příkazu Chamfer a modifikátoru 
Turbosmooth vytvořit zajímavé pravidelné tvary a vzory o. 

n

o

ZÁKLADNÍ MODELOVACÍ PŘÍKAZY – TVARUJEME HMOTU
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Vyberte vrcholy, které chcete svařit, a klepněte na numerické tlačítko Weld. Pokud se 
vrcholy nesvaří, zvyšujte plynule hodnotu Weld Threshold, která zvyšuje mez (prahovou 
hodnotu), v rámci které se vrcholy svaří.
Až dojde k přichycení všech požadovaných vrcholů, stiskněte tlačítko OK pro opuštění 
dialogu Weld Vertices.

Vyzkoušejte si také příkaz Target Weld. Jde o ruční variantu předchozího příkazu, kdy máte mož-

nost tažením se stisknutou myší od jednoho vrcholu ke druhému oba vrcholy svařit. Ten 

použijete v případě, že víte, „odkud kam“ chcete vrcholy svařit.

Úkos vrcholů aneb jak odříznout hrot
Zdá se vám vytvořený hrot příliš ostrý? Chtěli byste vytvořit nové vrcholy na špičce polygonál-
ního „výrůstku“ a manuální postup vás odrazuje? Použijte příkaz Chamfer! Ušetří vám spoustu 
času a námahy. Obrázek 8.43 ukazuje model před a po aplikování příkazu Chamfer. Postup je 
analogický se všemi ostatními příkazy:

Vyberte vrchol (nebo vrcholy), u kterého chcete vytvořit úkos.
Stiskněte numerické tlačítko napravo od příkazu Chamfer. Definujte hodnotu úkosu v poli 
Chamfer Amount a voilà, imaginární nůž vykonal svou práci! Určitě si vzpomenete na stej-
ný příkaz pro hrany. Už se začínáte orientovat v přístupu k modelování v Maxovi? 

Nemusíte vždy použít numerické tlačítko příkazu. Pokud preferujete interaktivní a „přibližnou“ 

manipulaci s podobjekty přímo v pracovním pohledu, stačí, když stisknete tlačítko příkazu 

a budete s vrcholy nebo jinými podobjekty manipulovat přímo.

Automatizace tvorby hrany spojením vrcholů
Tento příkaz jsem si velice oblíbil. Při komplexním modelování narazíte na problémy, kdy 
budete chtít jednu hranu odstranit (Remove) a vytvořit novou. Místo tvorby hrany prostě vybe-

2.

3.

1.

2.

TIP

POZNÁMKA

Obrázek 8.42. Když zjistíte chybu v modelu v podobě „díry“ či mezery mezi polygony, svaření 
vrcholů příkazem Weld vás uchrání před frustrujícím manuálním svařováním vrcholů
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rete dva vrcholy (nebo více) a stisknete tlačítko Connect, které najdete v rozevírací nabídce Edit 
Vertices. Vytvoří se nová hrana, spojnice vrcholů.

Začistěte si své modely
Během modelování můžete za sebou zanechávat stopy v podobě vrcholů, které nenáleží žád-
nému polygonu. Takové vrcholy jsou zbytečné a můžete je odstranit pomocí příkazu Remove 
Isolated Vertices. Totéž můžete provést s nevyužitými vrcholy, které se sice zobrazují v prostředí 
pro úpravu mapování, ale nelze je k tomuto účelu využít. K jejich odstranění použijte příkaz 
Remove Unused Map Verts.

Větší váhou vrcholů k nerovnoměrnému rozložení efektu NURMS
Když přidáte vybraným vrcholům větší váhu než ostatním, zaoblení modelu se zapnutou vol-
bou NURMS (viz bod Práce s dílčím dělením plochy – vyhlazování polygonů a větší detaily) 

Obrázek 8.43. Příkazem Chamfer provádíte úkos vrcholu, takže ztratíte hrot a získáte v tom místě 
polygonální základnu

Obrázek 8.44. Přidělením rozdílné váhy vrcholům můžete docílit nestejnoměrného rozložení 
efektu zaoblení modelu po použití NURMS. Vrcholy s vyšší váhou mají tendenci přitahovat okolní 
vrcholy, protože fungují jako magnet.

ZÁKLADNÍ MODELOVACÍ PŘÍKAZY – TVARUJEME HMOTU

100× vyšší váha vrcholu
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povede k nerovnoměrnosti, což může být v některých případech přímo žádoucí. Podívejte se 
na dva modely na obrázku 8.44. Vlevo vidíte model se všemi vrcholy se stejnou váhou, kdežto 
model vpravo má uprostřed vrchol s váhou 100x větší než ostatní vrcholy. Také vidíte rozdíl ve 
vzhledu obou vrcholů. 

Základní příkazy pro práci s hranami 3D modelu
V předchozí části jsme si popsali všechny příkazy, s nimiž se setkáte v podobjektovém módu 
Vertex, tedy vrcholů. Stejně tak v případě hran (Edge) se objeví pro ně typická rozevírací nabíd-
ka Edit Edges. Protože jsme už mnoho podobných příkazů probírali u vrcholů, výklad zestruč-
níme a popíšeme si jen ty příkazy, které jsou typické speciálně pro hrany a nenajdete je jinde. 
Na vás bude vyzkoušet si příkazy prakticky.

Popis akce Příkaz

Přidání vrcholu na hranu. Insert Vertex

Odstranění hrany se zachováním polygonu. Remove

Rozdělení modelu (oddělení hran) podél vybraných hran – ve většině případů fun-
guje pouze na dvě a více vybraných hran. Ukázku výsledku tohoto příkazu vidíte na 
obrázku 8.45.

Split

Vytažení hrany (obdoba vytažení vrcholu). Extrude

Svaření hran (obdoba svaření vrcholů). Funguje například po provedení příkazu Split. Weld

Zkosení hran. Z jedné hrany se stanou dvě hrany od sebe vzdálené. Chamfer

Svaří dvě hrany k sobě. Tažením myši se stisknutým levým tlačítkem od jedné ke 
druhé hraně se nad tou druhou objeví malý symbol „+“, takže můžete hrany svařit. 
První hrana se posune ke druhé a dojde ke svaření.

Target Weld

Spojení (přemostění) dvou hran pomocí nově vzniklého polygonu. Můžete přemostit 
pouze ty hrany, které jsou na jedné straně bez polygonu, tedy jde o hranice. Můžete 
vybrat hrany, které chcete spojit, a klepnout na příkaz Bridge. Alternativně můžete 
klepnout na příkaz Bridge a až pak klepnout na první hranu, objeví se tečkovaný 
spoj a poté klepnout na druhou hranu. Příkaz oceníte zejména při spojení dvou částí 
modelu (např. ruka a paže, hlava a krk a podobně). S numerickým tlačítkem Bridge 
máte možnost nastavit také počet segmentů na vzniklém polygonu.

Bridge

Propojí vybrané hrany definovaným počtem nových hran. Velmi vhodné při zvýšení 
detailu objektu pro účely modelování. U numerického nastavení příkazu Connect 
můžete definovat počet hran, které mají aktuálně vybrané hrany spojovat (Segments). 
Také můžete nastavit, jak blízko či daleko od sebe mají vzniklé hrany být (parametr 
Pinch) nebo kde se mají na polygonu umístit (vlevo, uprostřed, vpravo, někde mezi, 
… – to má na starosti příkaz Slide, jak ukazuje obrázek 8.46). 

Connect

Vytvoření 2D tvaru z vybraných hran. Představte si situaci, kdy máte vybrané hrany 
postavy v oblasti pasu. Stačí vytvořit tímto příkazem 2D tvar a máte připravenou 
cestu pro vytvoření 3D opasku. 2D tvary slouží v mnohých případech jako solidní 
základ pro 3D modely. Důležitý příkaz!

Create Shape 
From Selection

Nastaví váhu hrany. Čím větší váha, tím více zřetelné bude hroucení ostatních hran 
k této v případě zapnutí pole NURMS (organické zaoblování díky dílčímu dělení 
ploch). Vytrácí se tím hladký povrch, což ale může být v některých případech žádoucí. 

Weight
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Popis akce Příkaz

Síla efektu podobného záhybům, vzniklým jakoby mačkáním v místě hran. Podobné 
jako v případě puku u kalhot. Čím vyšší hodnota Crease u vybrané hrany, tím výraz-
nější efekt a tím ostřejší záhyby viditelné i při aplikování NURMS. Ukázku si můžete 
prohlédnout na obrázku 8.47.

Crease

Pokud odstraníte hrany příkazem Remove, zůstanou v místě průniků odstraněných a zbylých 

hran vrcholy. To bývá většinou nežádoucí. Proto před stiskem tlačítka Remove stiskněte také 

klávesu Ctrl. Tím se odstraní nejen hrany, ale také související vrcholy.

Tlačítka Edit Tri. a Turn slouží pro převrácení diagonál polygonů. V případě vizuálně odlišného 

polygonu, který nijak nezapadá do vašeho modelu a měl by, můžete zkusit prohodit trojúhelní-

ky tvořící polygon právě jedním z těchto příkazů. 

Kopie podobjektů pro tvorbu nových struktur
Už dokážete kopírovat objekty pomocí stisknuté klávesy Shift+posunutí, otočení nebo změna 
měřítka. Obdobně můžete tvořit kopie podobjektů a vytvářet nové navazující podobjektové 
struktury. Pokud například vytvoříte jednoduchý rovinný objekt Plane s jedním segmen-
tem a zkonvertujete ho na Editable Poly, můžete z něj vytvořit takřka libovolný objekt. Stačí 
v podobjektovém módu hran (Edge) se stisknutou klávesou Shift posunovat jednu hranu 
a vytvářet tak další polygony, jak vidíte na obrázku 8.48.

TIP

POZNÁMKA

Obrázek 8.45. Rozpojení hran pomocí příkazu Split. V místě původní jedné hrany bude otevřený 
prostor.

ZÁKLADNÍ MODELOVACÍ PŘÍKAZY – TVARUJEME HMOTU
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Obrázek 8.46. Příkaz Connect n a Bridge o v akci. Automatizační funkce, které vám usnadní 
propojování hran. Kde Bridge vytvoří mezi hranami nový polygon, Connect spojí hrany pomocí 
nových hran.

n

o

tři spojené hrany
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Kreslíme a upravujeme 2D tvary 
– podklady pro 3D modely
Stejně jako 3D objekty můžete tvořit i 2D tvary. Najdete je v hlavní nabídce Create → Shapes 
a Create → Extended Shapes. Jejich účel je jediný. Vytvářet 2D tvary za účelem přípravy tvorby 
3D modelů. Jelikož jsou 2D tvary standardně nerenderovatelné, spočívá jejich kouzlo v poskyt-
nutí cest, profilů či rotačních os, na které lze aplikovat postupy pro přeměnu 2D tvaru na 3D 

Obrázek 8.47. Hodnotou Crease můžete u hran ovládat ostrost záhybů i v případě aplikování 
NURMS vyhlazení. Hranám pod okem byla zvýšena váha (Weight) i ostrost záhybů (Crease).

Obrázek 8.48. Kombinací klávesy Shift a posunutí hrany můžete z jednoduché roviny vytvořit 
třeba automobil. S touto technikou se často v pracovním výřezu používají 3 rovinné objekty s na-
mapovanými skicami jako předlohami výsledného modelu.

ZÁKLADNÍ MODELOVACÍ PŘÍKAZY – TVARUJEME HMOTU

Crease = 1, Weight = 6
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objekt. O některých postupech se dočtete v kapitole o modifikátorech spadajících zejména do 
skupiny Patch/Spline Editing. 
Pojďme se tedy nejprve podívat na způsob tvorby 2D tvarů, jejich možnosti a použití, abyste 
byli připraveni na širší využití křivek ve složitějších modelovacích technikách.

Základní 2D tvary
Z hlavní nabídky Create → Shapes můžete vytvořit následující tvary:

Ručně kreslená křivka (Line)
Obdélník (Rectangle)
Kružnice (Circle)
Elipsa (Ellipse)
Oblouk (Arc)
Soustředné kružnice (Donut)
N-úhelník (NGon)
Hvězda (Star)
Text
Spirála (Helix)
Řezná rovina (Section)

Všechny tvary kromě Line mají obdobně jako základní 3D primitiva parametry, kterými urču-
jete délku stran, poloměr nebo počet stran n-úhelníka. Abyste mohli upravovat jejich tvar dále 
za tyto parametry, musíte tvary zkonvertovat na editovatelnou křivku, jak ukazuje obrázek 8.50. 
S tímto 2D typem se setkáte také při importu půdorysů a výkresů projektantů z AutoCADu.

�

�

�

�

�

�

�

�

�

�

�

Obrázek 8.49. 2D tvary slouží jako vstupní tvary pro jejich přeměnu na 3D objekty. 3ds Max nabí-
zí mnoho nástrojů a technik, pomocí kterých vytvoříte ze 2D tvaru 3D model.
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Na tomto místě se nebudu věnovat jednotlivým parametrům 2D tvarů. Vyzkoušejte si sami 

vytvořit několik tvarů a měnit jejich parametry. Tak například kružnice má poloměr (Radius), 

obdélník pak šířku a délku (Width a Length) a n-úhelník má poloměr (Radius) a počet stran 

(Sides). Určitě za větší zmínku stojí typ Text, kterému můžete přiřadit i libovolný font dostupný 

ve Windows. Taktéž si vytvořte rozšířené tvary (Extended Shapes), protože se vám mohou hodit 

při tvorbě složitějších tvarů, které byste jinak museli pracně modelovat z těch jednoduchých. Na 

takové tvary pak můžete aplikovat i modifikátory, takže například z textu můžete vytvořit 3D 

model, viz dále.

Převádíme křivky na editovatelnou podobu
Pokud klepnete na libovolný 2D tvar pravým tlačítkem myši a vyberete Convert To → Editable 
Spline, získáte na panelu Modify strukturu jako na obrázku 8.51. Rozvinutím podobjektové 
struktury editovatelné křivky zjistíte, že máte k dispozici vrcholy (Vertex), segmenty (Segment) 
a celou křivku (Spline).

Pokud si vytvoříte, řekněme obdélník, zkonvertujete ho na Editable Spline a přejdete do módu 
Vertex, zpřístupní se na panelu Modify příkazy typické pro práci s vrcholy křivek. Samozřejmě 

POZNÁMKA

Obrázek 8.50. Abyste mohli se 2D tvarem pracovat více než jen prostřednictvím 
jeho základních parametrů dostupných na panelu Modify, musíte ho zkonvertovat 
na editovatelnou křivku (Editable Spline)

KRESLÍME A UPRAVUJEME 2D TVARY – PODKLADY PRO 3D MODELY
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kromě těch obecných, které nejsou závislé na vybraném podobjektu. Najdete tu stejnou logiku 
práce jako v případě geometrických primitiv. Příjemné, že? 

Podívejme se na nabídky, s nimiž se potkáte při práci s editovatelnou křivkou. Pojďme si to 
v dalších kapitolách ukázat na příkladu tvaru obdélníka.

Vytvářené křivky jako součást jednoho tvaru
Když vytvoříte například obdélník z hlavní nabídky Create → Shapes → Rectangle, máte ihned 
poté možnost vytvořit další tvary, které mohou být součástí toho prvního, tedy obdélníka. 
K tomu stačí vypnout pole Start New Shape, které najdete bezprostředně pod názvem rozevírací 
nabídky Object Type na panelu Create. Ze 2D tvaru se tímto automaticky vytvoří editovatelný 
typ Editable Spline. 

Zhmotnění 2D tvarů v pracovním výřezu 
pomocí přidání tloušťky
S vytvořeným tvarem přejděte na panel Modify a otevřete rozevírací nabídku Rendering. Zapněte 
pole Enable in Viewport a dostatečně zvyšte číslo v poli Thickness (u přepínače Radial). Uvidíte, že 
ve výřezu se 2D tvar skutečně „zhmotnil“ a vypadá jako 3D tvar. 2D křivku si můžete nechat 
vykreslit jako 3D objekt nejen ve výřezu, ale také v renderovaném pohledu.

Když zapnete pole Enable in Renderer, uvidíte 2D křivku i na vyrenderovaném obrázku. To by 

jinak nebylo možné. Pole Generate Mapping Coordinates má na starosti generovat mapovací 

souřadnice pro správný vzhled případné textury aplikované na křivku (samozřejmě přetvořenou 

na 3D model).

POZNÁMKA

Obrázek 8.51. Základní podobjekty editovatelné 
křivky jsou Vertex, Segment a Spline
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Profil takového tvaru můžete vybrat přepínačem Radial (kruhový profil) a Rectangular (obdél-
níkový profil). Kruhovému profilu můžete nastavit tloušťku pomocí pole Thickness, počet stran 
kružnice profilu (Sides) a natočení (Angle). Obdélníkovému profilu nastavujete délku (Length), 
šířku (Width), natočení (Angle) a poměr mezi délkou a šířkou (Aspect), což zásadně mění tvar 
objektu (dodává mu výšku či hloubku). Pole Auto Smooth způsobí vyhlazení hran křivky tam, 
kde úhel mezi sousedními polygony je menší než 45 stupňů. Patrné to bude například v rohu 
obdélníka, který má zapnutou volbu Enable in Viewport.

Obrázek 8.52. Když vypnete pole Start New Shape, budou další vytvářené 2D tvary součástí toho 
předchozího a vy s nimi budete moci pohybovat jako s jedním celkem včetně na úrovni práce 
s podobjekty

KRESLÍME A UPRAVUJEME 2D TVARY – PODKLADY PRO 3D MODELY
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Dosažení hladšího průběhu křivky
Vytvořili jste kružnici a zdá se vám příliš „hranatá“. Chybí ji po obvodu hladkost? Pak se podí-
vejte do rozevírací nabídky Interpolation a zapněte pole Adaptive. Dojde k optimalizaci přechodů 
mezi vrcholy křivky a vyhladí se. Vizuálně bude perfektní. 

Pokud hovoříme o vrcholech kružnice, může se vám to zdát podivné. Ale pokud ji zkonvertuje-

te na Editable Spline a vstoupíte do módu Vertex, skutečně zjistíte, že má jen čtyři vrcholy na 

hodinových pozicích 12, 3, 6 a 9. To, že se kružnice jeví jako kružnice jen díky 4 vrcholům, je 

způsobeno typem přechodu mezi vrcholy – tzv. bezierovými ovládacími křivkami, o kterých si 

povíme později. 

Když zadáte počet kroků interpolace (Steps) ručně (tedy s vypnutou volbou Adaptive), můžete 
s hodnotou 0 získat místo kružnice kosočtverec. S postupně se zvyšující hodnotou Steps se bude 
zvyšovat také detail a hladkost průběhu křivky – kružnice.

Ovládáme vrcholy křivek – podobjekt Vertex
Určitě jste zvědaví, jak se pracuje s křivkami v rovině modelování. Tedy jak můžete změnit 
tvar a vzhled křivky pomocí manipulace s podobjekty. Nebudu vás napínat. Práce s vrcholy 
vystihuje následující postup:

Vytvořte základní 2D tvar, který použijete jako výchozí tvar složitější sítě křivek. Z té 
pak můžete konkrétními technikami vytvořit 3D model. Pokud nejde o typ Editable 
Spline, nejprve na něj tvar zkonvertujte (pravým tlačítkem myši na křivku → Convert → 
Convert to Editable Spline).

1.

POZNÁMKA

Obrázek 8.53. Zapnutím volby Enable in Viewport uvidíte 2D křivku jako 3D objekt, jinak řečeno 
křivku s definovanou tloušťkou
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Přejděte do podobjektového módu Vertex (klávesa 1 nebo přes pravé tlačítko myši na 
objekt → levý horní kvadrant čtyřnásobné nabídky → Vertex) a vyberte některý vrchol 
na vašem 2D tvaru.
Vyzkoušejte si s ním posunout nebo otočit. Také na něj klepněte pravým tlačítkem myši 
a vyberte z levého horního kvadrantu čtyřnásobné nabídky možnost Bezier. Objeví se 
ovládací úchyt, jak vidíte na obrázku 8.54. Zkuste vzít za jeden konec a posunovat libo-
volným směrem. Sledujte, jak se křivka dynamicky deformuje podle pohybu úchytem. 

V těchto krocích spočívá úprava křivky na úrovni vrcholů. Dále se seznámíme s konkrétními 
příkazy, které aplikují na vrcholy specifické funkce (zaoblení, zkosení, …).

Přechody mezi typy vrcholů (Bezier, Bezier Corner, Corner a Smooth) jsou kritickým postupem 

efektivní manipulace s celou křivkou. Bezier Corner má na rozdíl od Bezierova oba konce úchytu 

samostatně ovladatelné. Tím můžete docílit poměrně ostrých vrcholů. Pokud vyberete typ 

Corner, získáte automaticky ostrý typ vrcholu. Konečně Smooth je rychlá metoda vyhlazení okolí 

vrcholu do zaoblené (hladké) podoby. Vyzkoušejte si všechny možnosti, budete je ve svých 

projektech určitě potřebovat!

Pojmenování vybrané skupiny vrcholů
Když pracujete s vybranou skupinou vrcholů pořád dokola, vyplatí se vám pojmenovat si je 
a příště se k nim vracet přes jejich název. Vyberte skupinu vrcholů a zadejte jim název v poli 
Create Selection Set. Příště se na výběr vrcholů odkazujte přes tuto nabídku. 

V rozevírací nabídce Selection typu Editable Spline najdete tlačítko Copy a Paste (v části nazvané 

Named Selections). Pokud máte vytvořenou nějakou sadu pojmenovaného výběru (vrcholů, 

hran nebo polygonů), můžete ji zkopírovat a vložit na další sadu vybraných podobjektů, třeba 

i jiný objekt. Vyplatí se, pokud je výběr složitý a chcete sadu zkopírovat na podobný nebo stejný 

objekt.

2.

3.

POZNÁMKA

POZNÁMKA

Obrázek 8.54. Pomocí Bézierových úchytů můžete manipulovat s okolím vrcholu na 
křivce a tím i měnit její vzhled. Samozřejmostí je možnost pohybování, otočení a změ-
ny měřítka vrcholu. Další typy nastavení vrcholů jsou Bezier Corner, Corner a Smooth.

KRESLÍME A UPRAVUJEME 2D TVARY – PODKLADY PRO 3D MODELY

Bézierův úchyt
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